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About this manual

1 About this manual

Observe the general information about the Seapath 130 series in this manual. This
manual applies to the Seapath 130–3, 130–5 and 130–5+ products.

Purpose of manual

The purpose of this installation manual is to provide the descriptions and procedures
required to install and set up the Seapath 130 series of products on a vessel.

Target audience

This installation manual is intended as a reference manual for the personnel installing
the system and it contains the necessary information to install and set up the Seapath
equipment on a vessel.

Maintenance purposes

This manual is also intended as reference material for the maintenance personnel. Keep
this manual for later use.

License information

Export of the MRU 5+, MRU 5, MRU H, miniMRU 50 or miniMRU 60 component
requires an export license.

Registered trademarks

Seapath® is a registered trademark of Kongsberg Discovery AS in Norway and the
People’s Republic of China.
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2 Seapath 130

2.1 Product description
The Seapath 130 is developed specifically for hydrographic surveying where
high precision heading, position, roll, pitch, heave and timing are critical
measurements. The product combines state-of-the-art dual frequency GNSS receivers
(GPS/GLO/GAL/BDS), inertial technology and processing algorithms in a compact and
portable package.
The main component is the sensor unit with the motherboard, GNSS antennas and
receivers. The sensor unit is to be mounted on top of the vessel mast or pole. On top of
the transducer, the inertial sensor of type MRU 3, 5 and 5+ is mounted within a light
weight subsea bottle. The Seapath operator software is installed on a connected PC
for configuration and monitoring. All the components are connected through a spider
cable with MRU (Motion Reference Unit) connection, three configurable serial lines,
DGNSS (Differential GNSS) correction input, 1PPS output, network communication
and power inlet.
The latest Seapath software includes Automatic Online Calibration (AOC) that
significantly improves the roll and pitch accuracy. With the AOC functionality
recalibration of the IMU is now longer required if the vessel is in motion with heading
changes (not stationary vessels).
The Seapath 130 series is delivered in the following and improved product range:
• Seapath 130–3 with MRU 3 to 0.010° roll and pitch accuracy
• Seapath 130–5 with MRU 5 to 0.008° roll and pitch accuracy
• Seapath 130–5+ with MRU 5+ to 0.005° roll and pitch accuracy
Note

The MRU 3 model part of Seapath 130–3 has to be mounted in a fixed direction relative
to the vessel and that is with the connector pointing up or down. Else the performance
of the Seapath 130–3 will be degraded.

The advanced Seapath navigation algorithms integrate the RTK GNSS data with
the inertial sensor data. This gives the Seapath 130 unique advantages compared to
stand alone RTK products. The Seapath product’s accurate roll, pitch and heading
measurements allow the RTK antenna position to be referenced to any point on the
vessel where accurate position and velocity are required. All the data from Seapath have
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the same time stamp and the output is in real-time. Subdecimetre position accuracy can
be achieved through download of satellite orbit and clock data from internet and by
post processing of satellite and IMU (Inertial Measurement Unit) data. The Seapath is
robust against GNSS dropouts by using the inertial sensor for dead reckoning navigation
in order to provide position, velocity and also heading measurements when GNSS is
not available.

With latest Seapath software the typical position drift for MRU 3, and MRU 5/5+ after
GNSS droupout is shown in the plot below:

Figure 1 Typical position drift in meters after GNSS dropout in minutes

The product has three configurable RS-232/422 serial lines and Ethernet for output
of motion data and NMEA messages to the multibeam and survey computer. Input
of DGNSS corrections of various quality and sources are input on a configurable
RS-232/422 serial line or Ethernet.

By utilising standard DGNSS, Fugro SeaSTAR XP2/G2/G4/G4+, VERIPOS
Ultra/Ultra2, C-NavC1, C-NavC2 and RTK corrections, this system is a unique solution
for hydrographic surveying and dredging work which demand the most comprehensive,
most accurate surveying data available.

2.2 System diagram
A system diagram for a Seapath setup.

M340-63/9.0 13
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Main units
1 Sensor unit with 1 meter cable with male connector
2 Mounting bracket
3 Seapath operator software installed on a PC (not part of the delivery)
4 Motion reference unit (MRU) in subsea bottle

Cables
A Cable to the sensor unit, part of the spider cable, 20 meter length with female

connector
B MRU umbilical cable with 8–pin SeaCon connector, 15 meter length
C Ethernet cable to PC and other users, 5 meter length
D Input/output serial line for GNSS corrections with 9–pin Dsub, 5 meter length
E Output serial line for motion data to multibeam or survey computer with 9–pin

Dsub, 5 meter length
F Output serial line for NMEA data with 9–pin Dsub, 5 meter length
G 1PPS output with 9–pin Dsub, 5 meter length
H 24 VDC input, 5 meter length

14 M340-63/9.0
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2.3 System units
The Seapath product comprises the following main components.

2.3.1 Seapath 130 sensor unit description
The sensor unit runs the navigation software. This software combines the GNSS signal 
and the inertial measurements to determine accurate position, heading, attitude and 
heave signal. This software utilises Kongsberg Discovery AS advanced true multi-
reference algorithms for real-time parallel processing of all available correction signals.

The sensor unit includes:
• Two GNSS receivers

and antennas
• Motherboard
• Connector board for termination of the spider cable
• Cable of 1 meter with male connector
• Mounting bracket

2.3.2 MRU description
The MRU (Motion Reference Unit) is designed for motion
measurement in marine applications. The unit incorporates 3-axis
sensors for linear acceleration and angular rate, along with complete
signal processing electronics and power supply. The MRU outputs
absolute roll and pitch as well as dynamic acceleration in the north,
east and down direction, velocity and relative position.

The interior of the MRU is divided into two sub-assemblies
consisting of an electronic part and a sensor part. The sensor unit
shall not be repaired or serviced by anyone else than Kongsberg
Discovery AS.

2.3.3 Light weight MRU subsea bottle description
The MRU is mounted in a light weight subsea bottle. The top and bottom
cover plates of the bottle are made of PVC and the cylinder of aluminum.
The bottle is designed for use down to 10 metres. The MRU is mounted
on a steering plate inside the bottle.

On the outside there are four mounting holes (M6) on both cover plates.
The mounting direction of the MRU within the bottle is indicated on the
bottom cover plate.

The bottle is delivered with two 8-pin Seacon connectors, one for serial
and one for Ethernet communication.

M340-63/9.0 15
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2.3.4 Spider cable description
The product is delivered with a spider
cable for sensor unit connection
through the female connector, MRU
connection through the 8–pin SeaCon
connector, three configurable serial
lines through 9–pin Dsubs, 1PPS
output through 9–pin Dsub, network
communication and power inlet.
Delivered in either 20 meter length or 8 meter length (short).

2.4 Scope of supply

2.4.1 Standard parts provided
Observe the basic items provided with a standard Seapath system delivery.
• 1 ea Seapath 130 sensor unit

Part number M340-03
• 1 ea Seapath 130 mounting bracket

Part number M340-05
• 1 ea light weight MRU subsea bottle

Part number MRU-M-SB12
• 1 ea MRU motion sensor

Models MRU 5+, MRU 5 or MRU 3
• 1 ea Seapath spider cable

Part number M340-20 (20 m length) or
Part number M340-25, short (8 m length)

• 1 ea user documentation

2.5 Product restrictions

2.5.1 Restrictions in export
Export of the MRU 5+, MRU 5 or MRU H sensor unit requires an export license.
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Note

Notice to importer: The MRU product specified in this document is shipped from
Norway in accordance with The Ministry of Foreign Affairs' Official Notification on
Export Control and U.S. Export Administration Regulations (EAR). The MRU may
therefore be subject to restrictions from your national export control authorities if
exported/re-exported from your country. Any valid and approved export license granted
to Kongsberg Discovery AS from the Norwegian Ministry of Foreign Affairs is not
an authorization for you to export/re-export the MRU.

2.5.2 Restrictions in guarantee
Changes or modifications to the product not explicitly approved by Kongsberg Discovery
AS will void the guarantee.

The liability of Kongsberg Discovery AS is limited to repair of this system only under
the given terms and conditions stated in the sales documents. Consequential damages
such as customer's loss of profit or damage to other systems traceable back to this
system's malfunctions, are excluded. The warranty does not cover malfunctions of the
system resulting from the following conditions:
• The Sensor Unit is not shipped in the original transport box.
• The Sensor Unit has been exposed to extreme shock and vibrations.
• The Sensor Unit housing has been opened by the customer in an attempt to carry

out repair work.
• Incorrect power connection.

2.5.3 Restrictions in use
The Seapath function is based on GNSS signals and requires free sight to the sky,
minimum four visible satellites, PDOP value less than 6 and otherwise normal conditions
to operate. It is designed for use on board marine surface operated vehicles with linear
acceleration less than ±40 m/s2 (±4g) and an angular rate range less than ±75°/s.

Specifications are valid without multipath, without shadowing of antenna and with vessel
in motion.

This Seapath product is intended for use in maritime survey and navigation applications.

2.6 Seapath as NTP server
The Seapath can be used as an NTP server for clock synchronization of connected
computer systems. An accuracy better than one millisecond can be achieved in local area
networks under ideal conditions.

M340-63/9.0 17
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To use the Seapath as the NTP server, the NTP clients have to be configured with the
Seapath IP address as the server. How this is done depends on the client software in use.
Nothing in the Seapath has to be configured. The NTP server on the Seapath runs in
standard mode with the PPS as reference.

2.7 Network security
Equipment manufactured by Kongsberg Discovery AS is frequently connected to local
area networks (LAN). Connecting any computer to a network will always expose the
data on that computer to all other computers connected to the same network. Several
threats may immediately occur:
• Remote computers can read the data.
• Remote computers can change the data.
• Remote computers can change the behaviour of the computer, for example by

installing unwanted software.

Usually, two parameters are used to define the threat level:
1 The likelihood that any remote connection will do any of the above.
2 The damage done if a remote connection succeeds doing this.

Because Kongsberg Discovery AS has no information regarding the complete system
installation at a location, we can not estimate the threat level and the need for network
security. For this reason, we can not accept responsibility for network security. Systems
provided by Kongsberg Discovery AS are regarded as stand-alone offline systems, even
though they may be connected to a network for sensor interfaces and/or data distribution.

Note

No network safety applications are installed on any Kongsberg Discovery computers.
The computers are thus not protected against viruses, malware or unintentional access
from external users.

Securing the system itself has no meaning unless there is a policy in place that secures all
computers in the network. This policy must include physical access by trained and trusted
users. The customer/end user of the system will always be in charge of defining and
implementing a security policy, and providing the relevant network security applications.

Note

Kongsberg Discovery AS will not accept any responsibility for errors and/or damages
caused by unauthorized use or access to the product.
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2.8 Support information
• Company name: Kongsberg Discovery AS, Seatex
• Address: Havnegata 9, 7010 Trondheim, Norway
• Duty phone: +47 33 03 24 07 (24 hours)
• Support e-mail address: support.seatex@kd.kongsberg.com
• Website: http://www.kongsberg.com/discovery

KM-Support App

Support is also available from the KM Support App. This app is available for free in App
Store and Google Play.
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3 Installation

This chapter provides information necessary to plan the Seapath installation on a smaller
hydrographic survey vessel. Correct installation is important for the system performance.

3.1 Preparing the installation

3.1.1 Necessary tools and equipment
We assume that you are equipped with a standard set of tools. This tool set must comprise
the normal tools for electronic and electromechanical tasks, such as screwdrivers,
pliers, spanners, a cable stripper etc. Each tool must be provided in various sizes. We
recommend that all tools are demagnetized to protect your equipment.

Unless stated otherwise, all mounting equipment (such as bolts, nuts, washers, screws
etc.) referred to within this document is to be supplied by the customer or the shipyard.

Survey equipment should be made available to determine the MRU mounting angles
in roll, pitch and yaw and the distance vectors from the Origin to the sensor unit, the
MRU and the monitoring points.

PC with Seapath operator software

An external PC (not part of the product delivery) is required for the installation of the
Seapath operator software. The minimum requirements for the PC is Windows 10 or
newer, 2 GHz CPU, 2 GB RAM and 1024 x 768 screen resolution.

Motion reference unit (MRU)

The MRU is shipped in a specially designed transportation container. Keep the MRU
within the container until everything is ready for installation of the unit in the mounting
bracket.

Note

After the installation, please save the transportation container. The MRU must be
shipped in this container for service or repair to maintain the warranty.

20 M340-63/9.0
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3.1.2 Drawings
General arrangement drawings of the vessel should be acquired to simplify determination
of offsets between the sensor unit, the MRU, the Navigation Reference Point (NRP) and
the different monitoring points. Locations for the various parts of the system must be
decided.

3.1.3 Radio frequency authorisation
Ensure that the data link between the reference station and the mobile Seapath system
is assigned to operate on the radio frequencies that will be used in the survey area. An
assigned approval from the Authorities is required before use.

3.1.4 Worker skills
Trained mechanical and electrical workers.

3.1.5 Determining the location of system parts

A Sensor unit mounted on pole
B PC with operator software installed, indoors
C MRU in subsea bottle mounted on transducer head

3.1.5.1 Sensor unit location

For the sensor unit, consider the following:
• The space above the sensor unit has to be free of obstructions of any kind.
• The sensor unit should be protected from direct illumination of radar beams and

other transmitting antennas such as Inmarsat antennas. Seapath is more sensitive to
blocking and reflections (multipath) of GNSS signals than GNSS sensors which only

M340-63/9.0 21
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use pseudo-range data. This is because Seapath also uses carrier phase measurements
for heading determination, and both the internal GNSS antennas need to see at least
four common satellites at the same time.
Caution
The sensor unit has to be mounted in such a way that blocking of the
GNSS signal is avoided.

• In order to reduce problems due to multipath effects, the sensor unit has to be mounted
above the nearest deck at a height which is equal to the width of this deck or higher.

• The sensor unit has to be mounted in such a way that torsion movement relative to the
ship's hull is kept at an absolute minimum.

3.1.5.2 MRU location

If the MRU is mounted in a subsea bottle, the MRU is recommended mounted close to
the user equipment of which it is supposed to measure the motion. This is to avoid
errors in alignment with the user equipment.
Caution

Be aware of vibrations.

Avoid mounting the MRU on a pole that vibrates at high frequencies when
the vessel speed increases. The MRU function may be disturbed if strong
vibrations around 14 kHz are present. There is some sensitivity to vibrations
around sequences of 100 Hz (100, 200, 300 Hz and so on). Such vibrations
should not exceed 0.5 m/s2 in any direction.

3.2 Installation summary
The installation consists of both mechanical and electrical installation.

Mechanical installation
The mechanical installation consists of:
• Installing a holder for the sensor unit and having it fastened in a suitable location

in a mast or pole.
• Installing the sensor unit on a holder in the mast or pole.
• Installing the MRU with the subsea bottle near the user equipment for which attitude

data is wanted, or close to the selected Navigation Reference Point (NRP).

Electrical installation
The electrical installation consists of:
• Connecting the cable from the sensor unit to the spider cable.
• Connecting the umbilical cable to the MRU subsea bottle.

22 M340-63/9.0
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• Connecting the Ethernet cable to the PC with Seapath operator software.
• Connecting cable with DGNSS RTK corrections to the sensor unit cable.
• Connecting sensor unit cable with output data to the survey computer.
• Connecting sensor unit cable with output data to the echo sounder.
• Connecting sensor unit cable with 1PPS output to the echo sounder.
• Supplying 24 V DC power to the sensor unit cable.

3.3 Terminating the cable within the
sensor unit (optional)

The sensor unit cable must be terminated in the unit before mounting it on the mast or
pole. Normally the sensor unit is delivered with the cable terminated.

Procedure
1 Open the connector board cover at the bottom of the sensor unit by unscrewing the

four screws marked with a red circle on the figure.

A Connector board
cover screws

B Sensor unit cable

2 Run the sensor unit cable through the gland and terminate the cable wires on the
connector board according to the cable wiring table.
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3 Fasten the cable gland to the sensor unit chassis.
4 Re–mount the connector board cover.

3.4 Mounting the sensor unit
The sensor unit is designed to be mounted horizontally on top of a mast or pole.

Prerequisites

A mounting arrangement for the sensor unit mounting bracket has been prepared by
the customer.

Procedure
1 Make a holder for the sensor unit mounting bracket and fasten the holder properly to

the mast or pole.
2 Separate the sensor unit from its mounting bracket by unscrewing the three screws

on each side.
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A Mounting bracket
screws

B Mounting bracket
C Plastic insulation

plate

3 Bring the sensor unit, its cable and mounting bracket as close as possible to the
location of the sensor unit holder.
The normal orientation of the sensor unit is along ship with heading reference
point no. 1 aft. It can, however, be mounted in any orientation, provided it is
approximately horizontal.

4 Place the delivered insulation plate between the sensor unit mounting bracket and
the holder, and ensure that the four bushings are placed in the mounting holes before
the screws are entered (to ensure galvanic isolation of the sensor unit from the
mast and to prevent corrosion). The nuts should be secured with washers or by
using self-locking nuts.

A Mounting bracket
B Plastic washer
C Plastic insulation

plate
D Holder

5 Place the mounting bracket in the preferred direction on the holder.

6 Lift the sensor unit on top of the mounting bracket. Insert the three screws on each
side of the mounting bracket again and fasten them to the sensor unit.

7 Connect the cable from the sensor unit to the spider cable.
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Figure 2 The two cable connectors Figure 3 The two cables connected

3.5 Mounting the MRU subsea bottle
The MRU of model 3, H, 5 or 5+ is delivered mounted in a subsea bottle. The subsea
bottle is mounted to the vessel or the transducer head.

Prerequisites

A mounting arrangement for the subsea bottle has been prepared by the customer.

Procedure
1 Find the location on the vessel, pole or transducer head to mount the bottle. If the

orientation of the bottle can be freely selected, choose a subsea bottle orientation
with the x arrow pointing in the bow direction.
The index lid has dowel pins and x and y arrow indication.

Figure 4 Index lid Figure 5 Connector lid

2 When the mounting location on a structure has been identified, prepare fastening
plates for the subsea bottle connector and index lid screws.
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A Subsea bottle
B Fastening plate

(provided by
customer)

C Mounting
structure

3 Provide the necessary number of M6 screws of stainless steel (four for each lead)
for fastening the subsea bottle to the structure.

4 Connect the MRU cable to connector A on the connector lid. Connect the provided
dummy female connector to connector B since this is not used in the Seapath.

5 Fasten the MRU cable with clips to the structure to avoid the cable to vibrate when
the vessel runs through the water.

3.5.1 Subsea bottle connectors and pin configuration
The bottle includes two 8-pin Seacon connectors. The part number for the Seacon
connector is 5506-1508 (male). A Seacon pigtail for the customer's own application can
be delivered as an option (part no MRU-E-PT8).

Connector A: Default pin configuration for Seapath

Pin Signal (Seapath compatible)
1 POWER -
2 POWER +
3 COM1_IN_A-
4 COM1_IN_B+
5 COM1_OUT_ B+
6 COM1_OUT_A-
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Pin Signal (Seapath compatible)
7 CGND (ground ref for XIN)
8 XIN (Seapath 1PPS)

Connector B: Default pin configuration, Ethernet communication

Pin Signal (Ethernet communication)
1 POWER -
2 POWER +
3 RD- (RJ_6)
4 RD+ (RJ_3)
5 TD- (RJ_2)
6 TD+ (RJ_1)
7 GGND
8 ALERT

3.6 Powering the Seapath system
There is no switch to power on/off the Seapath system. The system starts up when
power is connected to it.

Procedure
1 When cables are connected to the sensor unit and the MRU, apply 24 V DC power.

The power connection for the spider cable is according to the table.

Signal Sensor unit (wire colours) MRU (wire colours)
PWR+ (+24 V DC) Brown Green
PWR- (0 V DC) White Yellow

2 The system now gets up and running.

Powering off the Seapath system

Disconnect the power input to shutdown the system. The system can now be dismantled.
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3.7 Installing the Seapath operator
software

This software is used to set the configuration parameters for the sensor unit and to
operate the Seapath system. You must install the operator software on the local PC
(standard Windows procedure).

Procedure
1 Insert the USB flash drive with the software in the USB port on the local PC.
2 Open the Removable Disk drive to which the USB flash drive is connected.
3 Locate and run the installation file SeapathHmiInstaller.exe.
4 Follow the instructions on the screen in order to complete the installation of the

Seapath HMI program.
5 When you reach the last step, clear the Run the application check box if you do not

want to start the operator software immediately after installation.
6 Remove the USB flash drive from the local PC when the installation is finished.

3.8 Uninstalling the Seapath operator
software

When you do not need the Seapath operator software anymore, you can remove it from
your PC.

Procedure
1 Open the Control panel on your PC and select Programs and Features (the dialog box

where you remove programs).
2 Locate the Seapath 130 series program in the list.
3 Click the Uninstall button to remove the program.
4 Follow the instructions on the screen.
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4 Cable layout and
interconnections

4.1 Cable plan
All the components are connected through the spider cable with MRU (Motion Reference
Unit) connection, three configurable serial lines, DGNSS (Differential GNSS) correction
input, 1PPS output, network communication and power inlet.

Cables
A Cable to the sensor unit, part of the spider cable, 20 meter (default) or 8 meter

(short) length with female connector
B MRU umbilical cable with 8–pin SeaCon conenctor, 15 meter length
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C Ethernet cable to PC and other users, 5 meter length
D Input serial line for GNSS corrections with 9–pin Dsub, 5 meter length
E Output serial line to GNSS receiver with 9–pin Dsub, 5 meter length
F Output serial line for motion data to multibeam or survey computer with 9–pin

Dsub, 5 meter length
G Output serial line for NMEA data with 9–pin Dsub, 5 meter length
H 1PPS output with 9–pin Dsub, 5 meter length
I 24 V DC input, 5 meter length

The pin-out for the different connectors is illustrated with a corresponding letter to
the cables listed above.
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The serial lines can be configured in the Seapath operator for either RS-232 or RS-422
communication. The signals between the two are shared as follows:
• RTS shares pin with TX-A
• TX shares pin with TX-B
• CTS shares pin with RX-A
• RX shares pin with RX-B
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4.1.1 Ethernet connections
The system has the possibility to input and output data on individually configurable
network ports. The format and update rate are configured for each port in the NAV
Engine Configuration →Network. The network ports have 10/100 Mbps capacity. For
direct connection to a PC you might need a crossover cable instead of a straight-through
cable. The pin wiring for the different cable configurations is according to the table.

Straight-through Crossover
Signal Pin no. Signal Pin no. Pin no. Signal
TX+ 1 TX+ 1 3 RX+
TX- 2 TX- 2 6 RX-
RX+ 3 RX+ 3 1 TX+
RX- 6 RX- 6 2 TX-

4.1.2 PPS signal output description
A 1 pulse-per-second (1PPS) signal synchronized with GNSS time is available from the
9–pin Dsub marked PPS output on the spider cable. The output has galvanic separation.
This RS-422 1PPS signal originates from the GNSS receiver within the sensor unit.
The 1PPS signal is buffered and fed to the Dsub at 120 Ohm. The 1PPS signal has a
pulse width of 10 ms. The 1PPS is generated exactly once every second with its rising
edge synchronised to GPS time.
Pin no. 8 (RxA) on the 9–pin Dsub has a rising edge and pin no. 2 (RxB) has a falling
edge at the beginning of the pulse.

4.1.3 Communication interfaces in the Seapath system
The table below shows all available input/output ports available in the system. Only the
DGNSS, ECHO, SURVEY and LAN1 are user configurable.

Table 1 Communication interfaces

I/O Properties Type Connected to
GNSS1 Serial, GNSS receiver no.

1
Internal GNSS antenna no.
1

GNSS2 Serial, GNSS receiver no.
2

Internal GNSS antenna no.
2

MRU Bidirectional, RS-422 MRU 3, MRU H, MRU 5
or MRU 5+

DGNSS Bidirectional, RS-232/422 GNSS corrections, user
configurable

ECHO Serial output, RS-232/422 Echo sounder, user
configurable
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Table 1 Communication interfaces (cont'd.)

I/O Properties Type Connected to
SURVEY Serial output, RS-232/422 Survey computer, user

configurable
1PPS Serial output, RS-422 External equipment
LAN1 Ethernet port, 10/100

Mbit/s
User configurable

4.1.4 DGNSS correction from Fugro SeaStar
Connection diagrams for interfacring DGNSS correction signals from Fugro Seastar
receiver are shown below.

Figure 6 Spider cable connection to Fugro Seastar 3610 receiver
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Figure 7 Fugro Seastar 3610 or 3710 receiver connection to Seapath junction box
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5 Survey of sensors on
vessels

In order to achieve the specified accuracy of the system have to be surveyed. The MRU
(Motion Reference Unit) and the sensor unit have to be surveyed.

The reference systems in use are:
• The vessel reference system
• The MRU subsea bottle sensor point and axes system
• The sensor unit position and heading reference points

A survey has to be performed to determine the offsets in angle and position from the
vessel reference system to the MRU and the sensor unit. These offsets are input in the
NAV Engine configuration software and stored in the Seapath.

5.1 Vessel reference system definition
The following definitions are used:
• All vessels have a defined Cartesian coordinate system that all sensors can be

referenced to. In this right hand system, the X-axis is positive forwards, which is
parallel to the centre line of the vessel, the Y-axis, positive towards starboard, and
the Z-axis, which is positive downward.

• The origin in the vessel reference system is typically frame 0 at keel level or the
surveyed origin in a survey report, i.e. where X, Y and Z are all 0.

• The common reference point (CRP) is defined to be in the intersection between stern,
centre line and keel. In case the keel is not parallel with the base line, the reference
for CRP is where the keel crosses the vertical section amidships. The location of CRP
vs the origin is configurable, and is typically set based on the survey report.

• The reference plane in this system must be well defined and described. This can be a
Best Fit Plane on main deck, or a Best Fit Plane through the draught marks on the
hull. This is particularly important on a floating vessel, as it is not possible to project
the horizontal plane from land.
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• The chosen convention must be made clear to all parties involved, both survey
personnel performing the survey and the users of the survey results. Any deviation
from the defined coordinate system, shown in the figure Definition of Origin on vessel
and positive X, Y and Z axes directions on page 37, should be well described in both
text and drawings to avoid common misunderstandings.

Figure 8 Definition of Origin on vessel and positive X, Y and Z axes directions

A Stern
B Keel
C Main deck
D CRP (common reference point)
E Origin

F +Z axis
G +X axis
H +Y axis
I CL (centre line)
J Amidships

5.2 Determining the MRU mounting
orientation

The default mounting position is defined with the MRU (Motion Reference Unit)
connector facing downward, the x-axis pointing forward and the y-axis pointing
starboard. The illustrations show the mounting orientation of the x, y and z indexes at
the top of the MRU according to the axes of the ship as well as the default mounting
position. The directions marked on the MRU housing (x, y, z) should be aligned with the
ship axes in the following way:
• The x-axis (x arrow) points in the bow (forward) direction of the ship.
• The y-axis (y arrow) points horizontally and starboard.
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• The z-axis points in the downward direction.

Figure 9 Top view of MRU with x, y and z direction

A To starboard
B Bow direction

Figure 10 Default MRU mounting position

Positive (+) output signals from the MRU include:
• Positive pitch means bow up, or a clockwise rotation about the y-axis.
• Positive roll means starboard (right) side facing downward, or a clockwise rotation

about the x-axis.
• Positive yaw (heading, azimuth) means a turn to starboard (right), or a clockwise

rotation about the z-axis.
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The MRU is best mounted with the logical axes in the direction described above to
avoid confusion and problems with the definition of the roll, pitch, yaw output angles.
However, the MRU can be mounted in any orientation relative to the above mentioned
logical axes. In this case, the offset angles between the MRU axes (x, y, z) and the
ship axes (R, P, Y) are simply entered in the NAV Engine configuration, under Sensors
→MRU →Geometry.

The MRU Mounting Wizard is available to assist in determining the MRU mounting
angles. This mounting wizard starts with applying the main rotation which means
to change the mounting angles in steps of 90° for each axis. After applying the main
rotation of the MRU, the subsea bottle offset angles are defined as the remaining offset
angles of the MRU axes (x, y, z) relative to the ship axes (R, P, Y). The roll and pitch
bracket offset angles can be interpreted as the bottle’s tilt angles relative to the ship deck
plane (horizontal plane). Be aware that these angles are not exactly the same as the
MRU roll and pitch mounting angles. The MRU mounting angle wizard will convert the
measured offset bottle angles into the corresponding roll, pitch and yaw mounting angles
(Euler angles) that are used in the MRU. The bottle offset angles are defined as:
• Roll offset angle. The angle between the ship Y-axis and the projection of the MRU

z-axis in the ship’s PY-plane.
• Pitch offset angle. The angle between the ship Y-axis and the projection of the MRU

z-axis in the ship’s RY-plane.
• Yaw offset angle. The angle between the ship R-axis and the projection of the MRU

x-axis in the ship’s RP-plane.

Figure 11 MRU subsea bottle misalignment offset angles

The illustration shows the positive roll offset angle if the bottle tilts to starboard. The
positive pitch offset angle if the bottle tilts to stern and the positive yaw offset angle if
bottle is rotated clockwise.
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Note

Mounting of the MRU with the x-axis (x arrow) pointing up (0, 90, 0) or down (0,
-90, 0) should be avoided due to the fact that there is a singularity in the Euler angle
representation for a 90–degree pitch angle. Therefore, the MRU mounting wizard does
not support these orientations.

Note

If the offset angles exceed 45°, another main rotation should be selected.

Related topics
• Using Mounting Wizard to determine MRU mounting angles on page 59

5.3 Surveying the MRU subsea bottle
To determine MRU mounting angles and position the following have to be surveyed:
• Position (X,Y,Z) of sensor point. The axis cross centre on the MRU subsea bottle

index lid. The distance vector from the Origin to the MRU sensor point has to be
measured up.

• Mounting angles in Roll, Pitch and Yaw (heading). The MRU misalignment angles in
Roll, Pitch and Yaw with the vessel axes have to be measured up.

The illustration shows the sensor point and position (0, 0, 0) for the MRU subsea bottle.

A Sensor
point
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Figure 12 Alignment of MRU yaw axis
to vessel longitudinal axis

After the mechanical installation is
completed, the MRU x, y and z axes
must be aligned to the corresponding
vessel axes or the axes of the system to
be compensated. To achieve the MRU's
specified roll and pitch accuracy, any
misalignment of the MRU axes with the
vessel axes must be precisely calculated
and accounted for.

A typical alignment process consists of
aligning the MRU axes to an external
reference. Type of reference must be
determined according to the required
accuracy.

5.4 Determining
the sensor unit
position and orientation

The illustration shows the reference points on the sensor unit. These points are used to
determine the position and orientation of the sensor unit on the vessel it is mounted.

A Heading reference point #2
B Position reference point and centre of the internal GNSS antenna no. 1 and Heading

reference point #1

Figure 13 Location of position reference point in Z direction, 92.8 mm above sensor
unit holder
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The location of the two heading reference points used for determining the mounting
angle (heading offset). Angular offset between the line from heading reference point
#1 to #2 and the vessel centre line (CL) have to be determined and input in the NAV
Engine configuration as the heading offset.

A Heading reference point #2
B Heading reference point #1
C Heading offset

Related topics
• Entering sensor unit location parameters on page 52

5.4.1 Surveying the sensor unit
For the sensor unit the following should be surveyed:
• Position reference point (X, Y, Z). The distance vector from the Origin to the position

reference point has to be measured up.
• Mounting angle in heading. The angular offset between the vessel centre line (CL)

and the line from heading reference point #1 to #2 and have to be determined and
input as heading offset in the NAV Engine configuration.

Related topics
• Entering sensor unit location parameters on page 52
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5.5 Determining the distance vectors
The MRU and the sensor unit both measure the motion for the location where they are
located. These measurements must be transformed to be able to measure the motion in a
common reference point, NRP (Navigation Reference Point). The NRP is the reference
point for all measurements in this system.
The following distance vectors have to be determined and entered into the various dialog
boxes in the NAV Engine Configuration:
• The distance vector from the Origin to the position reference point (GNSS antenna

no. 1) (GNSS Geometry).
• The distance vector from the Origin to the MRU location (MRU Geometry).
• The distance vector from the Origin to the selected NRP location (Vessel Geometry).
• The distance vectors from the Origin to each of the monitoring points (maximum

eight MPs) (Monitoring points Geometry).
All these distance vectors have to be measured or calculated based upon drawings or
previously measured points. These vectors are to be measured within an accuracy
described in on page . Positive vector orientation for these parameters is
• X - positive forwards
• Y - positive towards starboard
• Z - positive downwards with the Origin as the reference point.
The illustration shows distance vectors between the different components.

Related topics
• Entering sensor unit location parameters on page 52
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• Setting vessel dimensions and reference points on page 48
• Setting motion reference unit (MRU) location and mounting angles on page 57
• Setting monitoring points on page 63
• Survey accuracy on page 44

5.6 Survey accuracy
The Seapath product must be surveyed to the following accuracy level. If not, the
performance of the product will be degraded.
• Distance vector from the Origin to the sensor unit position reference point (X, Y, Z):

< 0.01 metre
• Distance vector from the Origin to the user defined monitoring points (X, Y, Z):

< 0.01 metre
• Distance vector from the Origin to the selected Navigation Reference Point (NRP)

location (X, Y, Z): < 0.01 metre
• MRU misalignment angles (Roll, Pitch) with the vessel axes: < 0.1°
• MRU Yaw misalignment angles with the vessel axes: < 0.1°
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6 Setting to work

6.1 Setting to work summary
Once all the hardware units have been installed, and all the cables have been connected,
the Seapath can be powered up for the first time, and set to work.

Prerequisites
• All hardware units have been installed according to the relevant instructions.
• All system cables have been installed.
• All connections have been made.
• All operating power is available.
• All external devices which shall communicate with the Seapath are available and

operational.
• All relevant personnel and tools are available.

Procedure
1 Verify that the Seapath is ready for operational use.

a Verify that all hardware units have been installed correctly.
b Verify that all cables have been connected correctly.
c Verify that the Seapath operator software is installed on an external PC.

2 Power up the Seapath for the first time.
3 Configure the Seapath for operational use.

a Configure the location and heading offset of the sensor unit.
b Configure location and mounting angles for the MRU.
c Configure location of monitoring points.
d Configuration of communication interfaces.

4 Set up interfaces to external devices.
To provide correct information the system needs to communicate with external
devices. All these interfaces must be set up in the system software.

5 Create a backup with the system configuration and software installation.
Once all system configuration and testing have been completed, it is recommended
to make a backup of the configuration data and software installation
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6.2 Verifying that the Seapath is ready for
operational use

The Seapath system is ready for operational use when:
• All cables are properly connected. Verify that the MRU cable is connected to

connector A on the subsea bottle.
• The power is correct. The system operates on 24 V DC power from the vessel’s

mains supply.
• The Seapath application has been installed on an external PC.

6.3 Powering up the Seapath for the first
time

When you have verified that all hardware units and cables have been properly installed,
and that the supply power is correct, you can power up the Seapath system for the first
time. The Seapath starts up automatically when correct power is applied.

6.4 Configuration management
description

6.4.1 Entering the configuration management system
The configuration parameters are available from:
• the System menu→NAVEngine →Standard for system configuration and
• the System menu→Operator SW for display views configuration.
To be able to make changes to the setup you must be in Configuration mode for standard
configuration tasks or Engineering mode for advanced configuration and diagnostic tasks.
Note

Advanced NAVEngine configuration is for service personnel only.

6.4.2 Operator software configuration description
You can adjust the appearance of the display views through the Operator software
configuration dialog box.
The dialog box contains tab pages for various presentation options and each page
contains two confirmation buttons with different properties and a cancel button.
• OK button: selecting the OK button will save the changes and close the Operator

software configuration dialog box.
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• Apply button: selecting the Apply button will save the changes but the Operator
software configuration dialog box will not close.

• Cancel button: selecting the Cancel button will close the dialog box and changes
will not be saved.

Note

The position properties selected in the Operator software configuration dialog box are
only for display purposes.

6.4.3 NAV Engine Configuration
You can configure the system parameters from the NAV Engine Configuration dialog box.
The dialog box consists of a list of configuration options, a parameter settings section,
an exit button and three buttons which each has different properties with regard to
configuration changes.

Apply
Select Apply to apply the configuration changes to the system. This button is disabled
until you have made configuration changes. The button will be disabled when there are
no configuration changes to apply.

Preview
Select the Preview button to see which parameters have changed since the configuration
was loaded. Changed settings are highlighted in bold face. This button is disabled until
you have made any configuration changes. Please note that monitoring point changes are
displayed in the coordinate system in which they are actually stored by the configuration,
i.e. related to the navigation reference point rather than origin.

Revert
Select the Revert button to reject all changes you made since the configuration was
loaded. The button is disabled until changes have been made.

A Configuration options list
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B Apply confirmation changes button
C Preview last configuration settings button
D Revert to previous settings button
E Exit NAV Engine Configuration
F Parameter settings section

6.4.4 Changing the system mode
The system has three modes: Operation, Configuration, Engineering. To be able to make
changes to the setup you must be in Configuration or Engineering mode. You need a
password to enter these modes. The password is STX and it is not case sensitive. The
password is not possible to change.

Via the System menu

Procedure
1 Select the System menu →Change system mode.
2 Select either Configuration or Engineering to open the Change system mode dialog

box.

3 Type the password STX and select OK. The password is not case sensitive.
You are now able to carry out changes and/or set system parameters.

With keyboard commands directly from the display

Procedure
1 In the display, press

• CTRL+E to enter Configuration mode
• CTRL+A to enter Engineering mode
Observe that the Change system mode dialog box appears.

2 Type the password STX and select OK. The password is not case sensitive.
You are now able to carry out changes and/or set system parameters.

6.5 Required sensor unit configuration

6.5.1 Setting vessel dimensions and reference points
Define the vessel which hosts the Seapath system and the origin of the vessel coordinate
system.
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Prerequisites

The navigation reference points you enter in this dialog box must be measured or defined
before you start the configuration process.

Context

This is information you need in order to specify correct location of various sensors,
equipment and monitoring points on a vessel. The information you enter in this dialog
box will help you later in the configuration process. The drawing is correctly scaled
based on the vessel dimensions to ensure correct indication of the various points. The
measurement unit of the entered coordinates is metres.

Show sensors, Show monitoring points

These items are displayed in the vessel illustration when you select the boxes.

Shape type

Defines the shape of the vessel hosting the system. You can select between Ship, Rig,
Jackup (3 leg) and Jackup (4 leg). These are all scaled according to the dimensions given
in the Shape dimension section. The general shape outline can be overridden by an actual
shape defined in a drawing file. Supported file extensions are Vessel models(*.svm), Vessel
vector images (*.svi) and Old vessel images (*.txt). This file can be created or edited in a
text editor. When a valid drawing file has been loaded, the dimensions are defined by the
loaded shape and the Shape dimension parameters are locked.

Shape dimensions

Holds parameters for the overall length of the vessel from stern to bow, the overall
width of the vessel and the overall height, which is the distance from the highest point
of the vessel to the keel.

Origin location in drawing

All point locations in the configuration refer to the origin. The location of the origin is
defined using distance from stern, center line and keel (often referred to as the CRP
(common reference point) in survey reports). The distance from stern is the distance
from the aft point of the ship to origin along the X axis. The distance from CL is the
distance from the vessel’s centre line, positive towards starboard. The distance from keel
is the distance from the keel, positive downwards.

Navigation reference point (NRP)

The Navigation Reference Point location (NRP) is the reference point for all
measurements in the system. The recommended NRP is near the Centre of Gravity (CG),
but can be chosen freely. It is always defined related to the origin.

The illustration shows different vessel dimensions and location of origin. If a survey
report is available the vessel origin should be located in the common reference point
(CRP) used in the report.
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A Stern
B Keel
C Overall height
D CRP (common reference point)
E Origin

G +X axis
H +Y axis
I CL (centre line)
J Overall length
K Overall width

50 M340-63/9.0



Setting to work

F +Z axis

Procedure
1 Select the System menu, →NAVEngine →Standard to open the NAV Engine

Configuration dialog box.
2 Select Vessel →Geometry.
3 Select the shape of your vessel from the Shape type list or select Use vessel drawing

if you have a specific vessel shape file you want to use. Select Browse to search
for the wanted file.
If you select Use vessel drawing, the Shape dimension parameters will be locked.

4 Type the overall length, width and height dimensions of your vessel.
5 Type the parameters for location of origin (survey origin).
6 Type the navigation reference point location, X, Y, Z.
7 Select Show sensors and/or Show monitoring points if you want to display these

objects in the vessel illustration.
8 Select Apply to store the settings.

Related topics
• Importing vessel shape from file on page 76
• Determining the distance vectors on page 43
• Survey accuracy on page 44

M340-63/9.0 51



Seapath 130 series

6.5.2 Entering sensor unit location parameters
The antenna position, heading offset and height difference parameters have to be input
correctly. If not, the performance of the system will be degraded. The antennas are
included in the sensor unit.

Prerequisites
The sensor unit location parameters have been surveyed or measured:
• For Antenna location: The position reference point (X, Y, Z). The distance vector from

the Origin to the position reference point.
• For Antenna offset: The mounting angle in heading. The angular offset between the

vessel centre line (CL) and the line from heading reference point #1 to #2 called
the heading offset.

Context
The reference points on the sensor unit are used to determine the position and orientation
of the sensor unit on the vessel where it is mounted.

A Heading reference point #2
B Position reference point and centre of the internal GNSS antenna no. 1 and Heading

reference point #1
The location of the two heading reference points is used to determine the mounting angle
(heading offset). The angular offset between the line from heading reference point #1
to #2 and the vessel centre line (CL) have to be determined and entered into the NAV
Engine configuration as the heading offset.

Example 1 Heading offset calculation
If the Reference heading measured by the reference system is found to be
32.1 degrees and the GNSS heading after the calibration is 15.3 degrees, the
Determined heading offset will be (32.1 - 15.3). Observe that the heading
offset is positive counterclockwise, and in the range [0,360] degrees.
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Example 1 Heading offset calculation (cont'd.)

Procedure
1 Click the System menu, →NAVEngine →Standard to open the NAV Engine

Configuration dialog box.
2 Click the Sensors node →GNSS →Geometry.
3 Type the surveyed distance vector to the position reference point (antenna 1) in

metres in the Antenna location (from Origin) table (X, Y and Z coordinates).
4 Type the surveyed Heading offset in degrees.
5 Type the Height difference in metres. For first time installation use the Calibration

Wizard to calculate the correct height difference.
6 Observe that the sensor unit is located as expected in the vessel drawing. If not,

check the signs and the location entered for the Antenna 1. Also, check the vessel
dimensions and origin location in Vessel geometry.

Related topics
• Determining the sensor unit position and orientation on page 41
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• Surveying the sensor unit on page 42
• Determining the distance vectors on page 43

6.5.3 Using Calibration Wizard to determine antenna
parameters
Use the Calibration Wizard to determine the heading offset and the antenna height
difference for the sensor unit.

Prerequisites
Readings of the vessel reference heading data on another PC or by manual readings have
to be available before starting the wizard.

Context
Calibration the direction of the sensor unit against an external reference. Type of
reference must be decided according to the required accuracy. The following calibration
parameters have to be determined:
• Heading offset. The direction of the sensor unit relative to the vessel's longitudinal

axis is measured in degrees.
• Height difference. The height difference between the two internal antennas within the

sensor unit according to the vessel horizontal plane (the height to antenna #1 minus
the height to antenna #2, compensated for vessel roll and pitch) is measured in metres..

It is of crucial importance to calibrate the heading offset correctly. During this
calibration, several accurate reference measurements of the vessel heading must be
read/logged simultaneously with the heading output from the Seapath. The data logging
should continue for at least two hours under calm conditions alongside a quay. The best
results are achieved if continuous logging of both the reference system and the Seapath
measurements can be performed during the calibration period. If simultaneous logging
of the two systems is not possible, one reading from both systems should be done at least
every 30 seconds for a minimum of two full hours.

The long calibration time is necessary in order to eliminate errors in the Seapath
measurements caused by multipath effects, which may be particularly pronounced in the
static conditions of a harbour area.

Note

Before entering the Calibration wizard, ensure that all configuration changes, including
the correct MRU mounting angles, are applied by pressing the Apply button in the menu
bar. Also, verify that roll, pitch and heading measurements are indicated as valid (green)
before starting the wizard.

Procedure
1 Click the Calibration wizard button to start the calibration. The system will indicate

when calibration measurements are ready.
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2 In the antenna Calibration Wizard Step 1 Accuracy, modify the baseline length
and height difference accuracy values if needed. Clicking Apply will restart the
calibration measurements.

3 If calibration measurements are unavailable, click Cancel and check that the
prerequisites listed in the note above are all met. Then restart the Calibration Wizard.

4 The Next button will be enabled as soon as measurements are ready.
5 Click Next to continue to Calibration Wizard Step 2 Period.
6 Modify calibration period and message interval if needed. The default values are

recommended.

7 Before clicking Next to start the calibration logging, it is recommended to start
recording data of the vessel reference heading on another PC or by manual readings.
When logging of the reference heading has started, click Next in order to proceed to
page 3 Processing.

8 The progress of the logging is indicated on the screen with a graphical presentation
of the measured data.
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9 Click Next to proceed to Step 4 Validation for inspection of the logged data.

10 Delete possible wild points by selecting the corresponding row in the table, then
click Delete line.

11 When the calibration result has been found acceptable, click Next to proceed to the
last step, Apply result.

12 Enter the mean value for the vessel heading reference, then click Update in order
to calculate the heading offset.
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Click Export log file if the calibration data are wanted for post processing.
13 Click Finish to accept the result and exit the antenna Calibration Wizard.
14 The Baseline length, Heading offset and Height difference fields are automatically

updated upon successful completion of the Calibration Wizard, according to the
calibration result.

15 Click Apply in the menu bar to save the calibration information.

6.5.4 Setting motion reference unit (MRU) location and
mounting angles
The physical location of the MRU relative to the origin and its mounting angles is
required for the Seapath system to be able to calculate position, roll, pitch and heading
correctly.

Prerequisites
For accurate location of the motion reference unit you will need detailed vessel drawings.

Context
The motion reference unit (MRU) measures the roll, pitch and heave motions of the
vessel. In the MRU Geometry dialog box you must define the physical location of the
MRU sensor related to the origin location you created in the Vessel Geometry dialog box.
In the MRU Geometry dialog box you enter the MRU location parameters, the X, Y
and Z coordinates in meters and the MRU mounting angles, the roll, pitch and yaw
parameters in degrees. Look at the vessel drawing to help you enter the correct signs for
the coordinates and to check if the motion reference unit appears on the expected spot.
If something looks out of place, check the signs and X, Y, Z coordinates you typed for
the sensor location and/or return to the Vessel Geometry dialog box and check the vessel
shape dimensions, the origin location and the navigation reference point (NRP) location.
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The MRU mounting angles can either be input manually or determined by use of the
Mounting wizard. The Mounting Wizard is located in the NAV Engine Configuration
→Sensors →MRU →Geometry.

Sensor location (from origin)
The position of the motion reference unit (MRU) in X, Y, Z coordinates in metres from
Origin. The sensor unit location has to be measured or calculated based upon drawings or
previously measured points. The default location of the sensor unit is in the vessel Origin.

Mounting angles
The mounting angles of the sensor unit in degrees for roll, pitch and yaw.

Procedure
1 Click the System menu, →NAVEngine →Standard to open the NAV Engine

Configuration dialog box.
2 Click the Sensors node →MRU →Geometry.
3 Type the X, Y and Z coordinates in metres from Origin to MRU location.
4 Type the mounting angles in degrees for roll, pitch and yaw.

If the mounting angle values are not known to you, use the Mounting Wizard to
calculate these values.

5 Click Apply to store the settings.

Related topics
• Determining the distance vectors on page 43
• Using Mounting Wizard to determine MRU mounting angles on page 59
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6.5.5 Using Mounting Wizard to determine MRU mounting
angles
Use the Mounting Wizard to determine the roll, pitch and yaw mounting angles in
degrees for the MRU sensor.

Prerequisites

The MRU bracket offset angles have to be available from a survey report or through
other methods with similar accuracy.

Context

The mounting bracket offset angles which have to be entered are roll, pitch and yaw.
Roll offset angle

The angle between the ship's Y-axis and the projection of the sensor z-axis in the
ship’s PY-plane. Positive roll offset angle if the bracket tilts to starboard.

Pitch offset angle
The angle between the ship’s Y-axis and the projection of the sensor z-axis in the
ship’s RY-plane. Positive pitch offset angle if the bracket tilts to stern.

Yaw offset angle
The angle between the ship’s R-axis and the projection of the sensor x-axis in the
ship’s RP-plane. Positive yaw offset angle if bracket is rotated clockwise.
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Note

If the mounting bracket offset angles exceed 45 degrees, another main rotation should be
selected.

Procedure
1 Select the System menu, →NAVEngine →Standard to open the NAV Engine

Configuration dialog box.
2 Select the Sensors node →MRU →Geometry.
3 Select theMounting Wizard button and use the wizard to calculate the roll, pitch and

yaw mounting angles.
The red circle indicates Port and the green circle indicates Starboard. The arrow
points in the bow direction.

4 In step 1, Orientation, select the < or > buttons to turn the motion reference unit
around in 90-degree steps, axis by axis. Click until the correct mounting orientation
of the motion reference unit has been found.
Observe that the parameters for roll, pitch and yaw in the Main rotation group
are automatically updated with the actual main rotation of the motion sensor and
gyro compass.
Alternatively, select the Connector direction or +x arrow direction option buttons to
select the motion sensor and gyro compass orientation.
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5 Select Next to continue to step 2, Offset angles.
Observe that the roll, pitch and yaw mounting angles are now indicated in theMain
rotation angles group.

6 Type the surveyed sensor bracket offset angles in degrees for roll, pitch and yaw.
The system calculates the mounting angles automatically and the values appear in
the Computed mounting angles group.

7 Select Finish when you are ready to complete the offset angle setting.
This will exit the wizard and take you back to the initial MGC Geometry dialog box.

8 Select Apply to store the settings.
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Related topics
• Survey accuracy on page 44

6.5.6 Selecting heave filter options
The heave configuration parameters allow you to tune the heave parameters to the vessel
motion characteristics for the actual weather conditions. This is important when using
real-time heave measurements in order to achieve optimum heave performance.

Context
Before a survey and/or during operation check the heave performance and tune the heave
parameters until the best heave performance is achieved. An alternative is to select
Automatic and let the system automatically choose the best settings.

Heave filter options
Hydrographic survey

To be selected when the heave phase and amplitude have to be output correctly
in real time. This mode is typically selected when the heave output signal from
the system is to be used for heave compensation of echo sounders and offshore
crane systems.

Automatic
To be selected when the vessel is operating in various sea states or when the
average heave period is unknown. The Automatic filter mode estimates the average
heave period and automatically sets the filter period in real time during operation.
The Automatic filter mode uses the Hydrographic survey filter structure.

GNSS aided
To be selected when RTK DGNSS corrections are available or the GNSS velocity
measurements are accurate. In this mode the heave and height measurements are
determined by blending vertical acceleration and GNSS height measurements
in a Kalman filter. This combination makes it possible to measure wave slopes
and the tide in real time with high precision ideal for hydrographic work. The
height measurements are provided with centimeter accuracy and independent of
wave frequency. If RTK is not available the algorithm will use the GNSS velocity
measurements for aiding the heave. If GNSS velocities are not available, the
Automatic algorithm is used.

General purpose
Is selected when the heave phase is of no importance. This mode is typically
selected when the system is to be used for measuring the heave height and period
on oceanographic buoys.

Period
An expected average heave period has to be set to the heave filter unless the automatic
mode is chosen. The settling time for the heave measurements from power-on or after a
turn will be about 10 times the selected period, T0.
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Roll/pitch dependent

Use the check box to enable whether the heave mean level should be dependent on the
roll and pitch measurements or not. When enabled, the heave position in the monitoring
points (MP) has now longer zero mean level, instead its value depends on the vessel tilt
at any time. This option is useful especially in applications where the distance between
the MP and the sea level is to be determined, like in echo sounder installations with
depth changes due to changes in vessel trim and list. If not enabled, the heave will
always have zero mean level. It is separate selections for the real time heave and the
delayed heave (PFreeHeave).

Procedure
1 Click the System menu, →NAVEngine →Standard to open the NAV Engine

Configuration dialog box.
2 Click the MRU node →Heave config.
3 Select the heave filter mode you want to use from the Options list.
4 If you select Hydrographic survey or General purpose,

a Type the wanted filter period. Allowed value between 1 and 25 seconds.
5 Select the Roll/Pitch dependent box if you want the heave measurement dependent

on the roll and pitch measurements. It is separate selections for the real time heave
and the delayed heave (PFreeHeave).

6 Click Apply to store the settings.

6.5.7 Setting monitoring points
You must define the locations on the vessel for which you want the system to calculate
the position.

Prerequisites

To get exact coordinates from Origin to each monitoring point, each monitoring point
has to be measured or calculated based upon drawings or previously measured points.
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Context

In this dialog box you can define points (monitoring points) on the vessel where you
want the position measurements to be output. The monitoring points are given relative to
Origin (positive forward, towards starboard and down). The position of a monitoring
point relative to the Origin is indicated in the drawing when the cursor is over the
monitoring point. As soon as a monitoring point has been defined, its location is
indicated in the vessel drawing. If a monitoring point appears incorrect, check the signs
and the coordinates input for each monitoring point and the vessel dimensions and the
entered location of Origin in the Vessel Geometry dialog box.

The system supports up to eight user definable monitoring points.

Show sensors

These items are displayed in the vessel illustration when you select the box.

Procedure
1 Select the System menu, →NAVEngine →Standard to open the NAV Engine

Configuration dialog box.
2 Select Monitoring points →Geometry.

3 Select Add at the top of the page to add a monitoring point.
Observe that the cursor changes to two red lines which will help you to place the
new monitoring point in the drawing.

4 Drag the cursor to the location on the upper vessel drawing where you want to add
the X and Z coordinates for your monitoring point and click the mouse button.
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5 Continue and drag the cursor to the location in the lower vessel drawing where you
want to add the Y coordinate for your monitoring point and click the mouse button.
Observe that coordinates for the new monitoring point appear in the monitoring
points table. These will also help you to get the wanted location for your monitoring
point.

6 Select the Name column in the table and type an identifying name for your
monitoring point. Press Enter to confirm.
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7 Select the X, Y and Z columns and adjust the coordinates by typing the exact
location of the monitoring point, if necessary. Press Enter to confirm.

8 Select Apply to store the settings.

Deleting a monitoring point
You can delete a monitoring point by selecting the wanted point in the table and clicking
Delete .

Related topics
• Determining the distance vectors on page 43
• Survey accuracy on page 44

6.5.8 Communication interfaces description
The communication interfaces are set in the NAV Engine Configuration dialog box under
Communication →Input/Output. The Input/Output list shows all input and output ports
which are available in the system.
When you select an Interface in the Input/Output list, the Configuration details part for
that particular interface will appear in the lower part of the page. These details will
change based on the interface type you have selected, Serial or Ethernet. You must
select either Serial or Ethernet for all available interfaces before you select the specific
parameters for a particular interface.
Select the arrow next to the group headings to show or hide the information.
To be able to get a properly working system you must set up these communication
interfaces:
• Telegram out
• DGNSS link
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Note

You are not able to configure the GnssReceiver interface and the MRU interface.

A Selected interface in Input/Output list
B Type of interface selection: Serial or Ethernet
C Specific configuration details for the selected interface

This procedure sums up the steps you have to go through to set up the communication
interfaces for the system.

Procedure
1 Select the System menu, →NAVEngine →Standard to open the NAV Engine

Configuration dialog box.
2 Select Communication interface →Input/Output.
3 Select the interface you want to set up in the Input/Output list.

Observe that the Configuration details parameters appear at the lower part of the page.
4 Select which type of interface you want to use from the Type list: Serial or Ethernet.
5 Select the wanted I/O parameters. These will vary depending on the type of

interface you selected.
6 Select the specific parameters you want for the interface you selected.
7 Select Apply to store the settings.

6.5.9 Using the Serial interface
The Serial interface allows you to decide how the sensor unit shall communicate and
interface to other equipment.
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Context

If you have decided to use a Serial interface, you must set up the port number, the baud
rate and select RS-232 or RS-422 mode.

Procedure
1 Select the System menu, →NAVEngine →Standard to open the NAV Engine

Configuration dialog box.
2 Select Communication interface →Input/Output.
3 Select the interface you want to set up.

Observe that the Configuration details parameters appear at the lower part of the page.
4 Select Serial in the Type list.
5 Type an informative text about the interface in the Description box. This is optional.
6 Type a short identification text for the cables connected to the sensor unit in the

Cable ID box. This is optional.
7 Select which port to use from the Port list.

The serial port number corresponds with the number on the sensor unit.
8 Select which baud rate you want to use from the Baud rate list. Maximum baud rate

is 115200 bits/second.
9 Depending on which port you selected, select if you want to use RS-232 or RS-422

for the electrical interface.
10 Select the properties for the interface you selected in the Input/Output list.

• DGNSS link: DGNSS link properties
• Telegram out: Telegram out properties and Telegram timing

Result

You are now ready to set the specific parameters for the interface you have selected.
See separate sections for selection details.

Related topics
• Output protocols on page 109

6.5.10 Using the Ethernet interface
The Ethernet interface allows you to decide how the sensor unit shall communicate via
the internet protocol (IP) network.

Context

Broadcast

Broadcasting is a method of transferring a message to all recipients simultaneously.
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Unicast
Unicast transmission is the sending of messages to a single network destination identified
by a unique address.

Multicast
Multicast (one-to-many or many-to-many distribution) is group communication where
information is addressed to a group of destination computers simultaneously.

Procedure
1 Select the System menu, →NAVEngine →Standard to open the NAV Engine

Configuration dialog box.
2 Select Communication interface →Input/Output.
3 Select the interface you want to set up in the Input/Output list.

Observe that the Configuration details parameters appear at the lower part of the page.
4 Select Ethernet in the Type list.
5 Type a short identification text for the cables connected to the sensor unit in the

Cable ID box. This is optional.
6 Select the wanted connection type: Broadcast, Unicast or Multicast.

• Local interface: The LAN port on the sensor unit.
• Local port: When receiving, this is the port on which the unit listens.
• Remote port: When transmitting, this is the port to which the unit sends.
• IP address Unicast: The target IP address, to which the unit is receiving or

sending.
• IP address Multicast: The multicast group address. Recommended range:

239.255.000.000 to 239.255.255.255.
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Note

It is recommended to use the same port number for both Local and Remote ports.

7 Depending on the connection type you have selected, select which local interface
you want to use from the Local interface list.

8 Select the properties for the interface you selected in the Input/Output list.
• DGNSS link: DGNSS link properties
• Telegram out: Telegram out properties and Telegram timing

Result

You are now ready to set the specific parameters for the interface you have selected.
See separate sections for selection details.

Related topics
• Output protocols on page 109

6.5.11 Setting up the Telegram out interface
The Telegram out function allows you to enable and set up data messages transmitted to
external equipment.

Context

Up to 16 serial and/or network interfaces can be configured.

Format

The format of the output telegrams.

Datum

The datum selection is only valid if the datum on the corrections input to the product
are in WGS84 or no corrections are input. If the corrections input are in another datum
than WGS84, you must selectWGS84 (which should actually have been labelled "No
transformation" in this software). The datum of the output will then be on the same
datum as the datum on the corrections input to the product. The other choices can only
be used when the system navigates in WGS84 datum.

Monitoring point

A point on the vessel for which you want the position measurements to be output.

NMEA selection

The NMEA selection option is activated if the Format is selected as NMEA. Select
between a number of NMEA telegrams.
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Options
The contents of some of the available NMEA telegrams can be modified according to
options listed in the Options list. This is for example useful when interfacing to older
equipment.

NMEA talker ID
The talker ID of NMEA messages sent from this output. The default is IN.

Log to file
Logs the measurements to file internally in the system.

Time precision
Number of decimals in the time field in NMEA telegrams which supports Time precision.

Interval
The interval between each sample. Can be selected in the range 0.005 to 3000 seconds.

Event driven
The output of data is driven by receipt of MRU data to the Processing Unit. Event
driven data is valid for the point in time the sensors within the MRU are sampled.
Recommended used when transmission in real time is not required, typically for
telegrams that include time information like Seapath binary 3, 11, 23 and 26.

Timer driven
By timer driven output the data will be output in real time (0 ms delay). Timer driven
output is recommended used when the data is preferred in real-time and for instance
when the system that receives the data time stamp it by receipt. Typically used when the
EM3000 format is output.

Procedure
1 Select the System menu, →NAVEngine →Standard to open the NAV Engine

Configuration dialog box.
2 Select the Communication interface node→Input/Output.
3 Select the TelegramOut interface you want to set up in the Input/Output list.

Observe that the Configuration details parameters appear at the lower part of the page.
4 Select either Ethernet or Serial in the Type list.

Enter the appropriate parameters for the selected interface type.
5 Continue to the Telegram out properties group.
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6 Select the wanted output telegram format from the Format list.
Observe that if you select NMEA as telegram format, the NMEA selection list
becomes active.

7 If NMEA is selected, select the wanted NMEA telegrams to use from the NMEA list.
8 Select the wanted datum format from the Datum list.
9 Select the wanted monitoring point from the Monitoring point list.
10 Type the talker ID of NMEA messages sent from this output in the NMEA talker ID

box.
The default value is IN.

11 Select the Log to file box if you want to log the measurements to file internally
in the system.

12 Select the wanted number of decimals in the time field in NMEA telegrams which
supports Time precision from the Time precision box.

13 In the Telegram timing group, select the wanted output interval for the messages.
• Event driven: Outputs data only when the data are calculated or when a change

occurs. Output data are delayed.
• Timer driven: The interval between each sample, type wanted interval in seconds

in the Interval box. Range 0.01 to 3000 seconds.

14 Select Apply to store the settings.

Related topics
• NMEA TelegramOut options on page 133

6.5.12 Setting up the DGNSS correction link parameters
You can set up the system to receive various types of corrections which will improve the
position accuracy.
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Prerequisites
Check whether the reference station requires to know the position of your system to be
able to send valid corrections back. If this is required, then enable GGA Interval [s]
and set up how often the GGA message shall be sent to the reference station in the
DGNSS link properties.

Context

Interface
Which external equipment you want to interface. Some configuration parameters are
dependent on the interface selection.

Name
The name you want to give the DGNSS correction link.

Timeout
Age limit. If the age of the corrections exceeds this limit, the corrections are invalid.

Format
The format types which are supported by the system.

GGA interval
If selected, sends GGAmessages to the DGNSS receiver at specified intervals in seconds.

Procedure
1 Select the System menu, →NAVEngine →Standard to open the NAV Engine

Configuration dialog box.
2 Select Communication interface →Input/Output.
3 Select the DGNSSlink interface you want to set up in the Input/Output list.

Observe that the Configuration details parameters appear at the lower part of the page.
4 Select either Ethernet or Serial in the Type list.

Enter the appropriate parameters for the selected interface type.
5 Continue to the DGNSS link properties group.

6 Select the wanted interface from the Interface list.
The content of the Format list will depend on this selection.

7 Select the wanted format from the Format list.
8 Select the name of the correction link supplier from the Supplier list.
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This selection depends on the parameter you selected in the Interface list.
9 Type the name of the DGNSS correction link.

This name will be displayed in the DGNSS link status bar at the bottom of View 1.

10 Type the correction Timeout age limit in seconds.
If the age of the correction exceeds this limit, the corrections are invalid.

11 Select the GGA Interval box if you want the system to send GGA messages to the
DGNSS receiver. Type the wanted interval in seconds between the telegrams.

12 Select Apply to store the settings.

Related topics
• Communication interfaces description on page 66

6.5.13 Connecting to a network
Enter the Internet Protocol (IP) addresses for the sensor unit to be able to communicate
on the local area network (LAN).

Context

The Interface settings group allows you to modify the IP address of the physical interface
selected in the Interface list.

The sensor unit communicates with the operator software using multicast UDP/IP. Any
client may join the configured multicast group provided that the network hardware
between the sensor unit and the client supports multicast forwarding.

The default IP address for the sensor unit is: 192.168.1.10.

The default multicast address for the sensor unit is: 239.255.0.3.

The default subnet mask for the sensor unit is: 255.255.255.0.

The PC running Operator SW needs to be on the same subnet. Unless the IP address of
the sensor unit is changed, the valid IP address for the PC would be 192.168.1.0-255
(excluding the address of the sensor unit itself).

Contact the network administrator for advice on IP address assignments.
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Procedure
1 Click the System menu, →NAVEngine →Standard to open the NAV Engine

Configuration dialog box.
2 Click the Network node.
3 Select the interface for which you want to change the IP address.
4 Select the DHCP box if the IP address is given by a DHCP server.
5 Type the new IP address for the interface.
6 Type the subnet mask address for this interface.
7 Type the IP address for the default gateway.
8 Click the Apply button to confirm the changes.
9 Restart the sensor unit for these changes to take effect and for the new settings to be

used by NAV Engine.
• To restart, click the System menu→Restart →Sensor Unit.

If you click the Restore button you will return to the previous interface settings.

6.6 Additional sensor unit configuration

6.6.1 Entering vessel identification parameters
The vessel Description parameters allow you to enter information about the vessel which
are needed for identification purposes.
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Procedure
1 Select the System menu, →NAVEngine →Standard to open the NAV Engine

Configuration dialog box.
2 Select Vessel →Description.
3 Type the name of your vessel. This box cannot be empty. The default value is

VESSEL.
4 Type the name of the vessel owner. This is optional information.
5 Type the country of origin for the vessel. This is optional information.
6 Type the MMSI number assigned to the vessel. Default value is 0.
7 Type the IMO number assigned to the vessel. Default value is 0.
8 Select Apply to store the settings.

6.6.2 Importing vessel shape from file
You can load a vessel model from file in order to get accurate dimensions for your vessel.

Context
The pre-defined scalable vessel shapes represent the actual vessel outline only in rare
cases. In order to configure the accurate location of various sensors, equipment and
monitoring points, it is recommended to load a separate vessel model from file.
The system supports two types of two dimensional outlines: side view (towards
starboard) and top view. Three file types are available: Vessel models(*.svm), Vessel vector
images (*.svi) and Old vessel images (*.txt).
The vessel image file must meet the following requirements:
• The vessel data have to be in an ASCII file generated by Excel, Notepad or similar

tools.
• The file head includes Overall length (LOA), Overall width, Overall height and Stern

to Origin data in metres.
• Profile (side view) data in X and Z coordinates in metres, related to the origin.

Coordinates are specified clockwise from a point aft of the origin, and the last
coordinate has to equal the first coordinate to form a closed polygon.
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• The top view data in X and Y coordinates in metres. The first coordinate has to be aft
of the origin along the centre line. Successive coordinates are specified clockwise,
and the last coordinate has to equal the first to form a closed polygon.

Vessel image files can be created by Kongsberg Discovery AS upon customer request.
GA drawings or similar are required to create vessel image files.

Example 2 Vessel shape from file

The illustration shows an example of a GA drawing of a multi-purpose vessel.

A user text file from Notepad may look like this.
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Example 2 Vessel shape from file (cont'd.)

The vessel shape in the NAV Engine Configuration looks like this.
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Example 2 Vessel shape from file (cont'd.)

In the example, only the port side of the vessel top view is defined in the
file. Symmetry is assumed, so this is sufficient to draw a symmetric vessel
shape. If the vessel is not symmetric, use the section code %Top view
coordinates in (X,Y) [m] Complete and give the coordinates
along the complete shape, defined clockwise.

It is possible to define cutouts within the profile or top view polygons. For
profile cutout, use %Profile cutout n, where n identifies the cutout.

Procedure
1 Select the System menu, →NAVEngine →Standard to open the NAV Engine

Configuration dialog box.
2 Select Vessel →Geometry.
3 Select Use vessel drawing and click Browse to search for the wanted image file.

If you select Use vessel drawing, the Shape dimension parameters will be locked.
4 Type the parameters for location of origin (survey origin).
5 Type the navigation reference point location, X, Y, Z.
6 Select Apply to store the settings.

6.6.3 Selecting SBAS satellites
The SBAS parameters allow you enable tracking of
SBAS satellites and to set up automatic or manual
tracking of these satellites.

Context

Enable

Select this box if you want your system to track SBAS
satellites.

Automatic

The GNSS receiver selects which SBAS satellites to track. (This option is currently
unavailable.)

Manual

The operator must select which SBAS satellites to use. If two SBAS satellites are
selected, the system will automatically use data from the best satellite. If only one
SBAS satellite is selected, only correction data from this satellite will be used in the
computations.
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If no specific SBAS satellite is selected, the system will select and use data from the best
of the available satellites. If the selected SBAS satellite is not available, the system will
not use the SBAS correction data in the computations. Maximum two SBAS satellites
can be tracked by the GNSS receiver.

Enable SBAS test mode
The Enable SBAS test mode option is typically to be used for SBAS systems which have
not reached full operation. An SBAS system in test mode does not provide full integrity.

Procedure
1 Select the System menu, →NAVEngine →Standard to open the NAV Engine

Configuration dialog box.
2 Select Sensors →DGNSS →SBAS.
3 Select the Enable box to enable tracking of SBAS satellites.
4 If you want the system to select SBAS satellites automatically, select Automatic.
5 If you want to select which SBAS satellites to use, instead of automatic selection

by the system, select Manual.
6 Select which SBAS satellites to use. You can select maximum two satellites.
7 Select Apply to store the settings.

6.6.4 Enabling Fugro high precision services
The XP/G2/G4 parameter allows you to use high
precision services to improve the accuracy of the
GNSS signals which results in a more accurate
position.

Prerequisites
A Fugro demodulator has to be connected and
activated.

Context
The use of high precision services must be enabled by the operator as the default setting
is disabled.

Enable
Select this box if you want to enable the use of high precision services in the position
solution.

Use Glonass
Select this box if you want to enable the use of GLONASS corrections in the position
solution.
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Navigation mode
The use of Navigation mode is more reliable during difficult conditions, such as high
ionospheric activity. It is not as accurate as Survey mode.

Survey mode
The Survey mode is used for high accuracy survey.

Procedure
1 Select the System menu, →NAVEngine →Standard to open the NAV Engine

Configuration dialog box.
2 Select Sensors →DGNSS →XP/G2.
3 Select the Enable box to enable the use of high precision services.
4 If you want more reliability during difficult conditions select Navigation mode or if

you want high accuracy select Survey mode.
5 If you want the system to use GLONASS corrections, select Use Glonass.
6 Select Apply to store the settings.

6.6.5 Selecting heading input format from gyro compass
Heading input from a gyrocompass or similar can be input to the system as a backup to
improve reliability.

Telegram in properties

Format
The format of the telegram.

Timeout
Age limit. If the age of the heading message exceeds this limit, the heading message
is invalid [s].

Interval
Expected interval in seconds between incoming telegrams. Can be configured.

Checksum required
Enables or disables NMEA checksum requirement. Default set to Enabled, which is
the recommended setting.

GGA/VTG, interval
If selected, sends GGA and VTG messages to gyro at specified intervals in seconds.

Procedure
1 Select the System menu, →NAVEngine →Standard to open the NAV Engine

Configuration dialog box.
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2 Select Communication interface →Input/Output.
3 Select the Gyro interface you want to set up in the Input/Output list.

Observe that the Configuration details parameters appear at the lower part of the page.
4 Select either Ethernet or Serial in the Type list.

Enter the appropriate parameters for the selected interface type.
5 Continue to the Telegram in properties group.
6 Select the wanted gyro telegram from the Format list.

7 Type the wanted Timeout age limit in seconds.
If the age of the gyro message exceeds this limit, the gyro message is invalid.

8 Type the wanted Interval for seconds between the incoming telegrams.
9 Select the Checksum required box if you want NMEA checksum to be required.

This selection is default selected. This is the recommended setting.
10 Select the GGA/VTG box if you want the system to send GGA and VTG messages

to the gyro at specified intervals.
11 Select Apply to store the settings.

Related topics
• Communication interfaces description on page 66

6.7 Operator software configuration

6.7.1 Selecting the position of views in the display
The View tab page allows you to select the contents of each view when the HMI (Human
Machine Interface) application starts.

Context
The View tab page has the same layout as the views in the display. You can select which
information shall appear in the various views.
Two views cannot have the same contents. When one view is selected as contents in
View 1, other contents will automatically be selected for View 2 or View 3.
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Procedure
1 Select the System menu,→Operator SW to open the Operator software configuration

dialog box.
2 Select the View tab.
3 Select which view you want for View 1, View 2 and View 3 from the drop-down

lists.
4 Select Apply to store the settings.

6.7.2 Selecting the appearance of the Sky View
The Sky View tab page allows you to define the appearance of the Sky View.

Context

Display correction satellites

Display correction satellites allows you to show correction satellites such as Inmarsat and
Spotbeam in the Sky View. The satellite positions are predefined. You must enable the
satellites which you want to appear in the Sky view where they are shown as brown
triangles. Spotbeam satellites are marked with an S while Inmarsat satellites are marked
with an I. When you hover the cursor over a correction satellite in the Sky View, a tooltip
with satellite name, azimuth, elevation and position will appear.

Signal strength

Signal strength allows you to display a signal bar under the satellites in the Sky view. The
signal bar indicates the signal-to-noise ratio for the satellite, and the longer the bar,
the stronger the signal.

Note

Signal strength L2 only available on dual frequency, single receiver systems.
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Shadow sector
Shadow sector allows you to show the shadow sectors in the Sky View. You must add
a shadow sector before you can display it in the Sky View. A shadow sector is just an
indicator and does not influence the position solution in any way. The shadow sector
refers to the vessel centre and will follow the vessel heading. Azimuth start describes
the starting angle of the sector in degrees (0 to 360) related to North. Azimuth sweep
describes the size in degrees. Elevation start describes the starting angle of the sector in
degrees (0 to 90) where 0 degrees is the horizon and 90 degrees is straight above the
antenna.

Satellite track plot length
Satellite track plot length assists in determining if a satellite is rising or falling in
elevation. The Satellite track plot length defines how long the length of the track plot
should be. When you select this option, the track plot starts to increase. Maximum
length of the track plot is 720 minutes.

Display elevation mask
When you select Display elevation mask, the configured elevation mask is indicated
in the lower left corner of the Sky view.

Procedure
1 Select the System menu,→Operator SW to open the Operator software configuration

dialog box.
2 Select the Sky View tab.
3 Select Display correction satellites.

Observe that the Select button appears.
4 Select Select.

Observe that the Select Correction Satellites dialog box appears.
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5 Select the satellites you want to appear in the Sky View and click OK.
6 Select Signal strength if you want to display the signal bar under the satellites in

the Sky view.
7 Add shadow sectors to be able to display them in the Sky View.

a Place the cursor over the sky view area to the right in the Sky View tab page.
b Right-click and select Add sector.

Observe that the sector appears in the sky view area and in the table in the
Shadow Sector group. The table shows your shadow sectors.

c Hover the cursor over the shadow sector.
Observe that the cursor changes to arrow symbols.

d Drag the arrows horizontally and vertically to create your shadow sector.
Observe the Azimuth and Elevation values in degrees.

8 Delete shadow sectors if they are no longer applicable.
a Select a sector in the sky view area to the right in the Sky View tab page.
b Right-click and select Remove sector.

Observe that the shadow sector disappears from the sky view area and from
the table.

9 Select Satellites track plot length if you want to show this in the Sky View.
Observe that the Satellite track plot length list appears.

10 Select the wanted value for the satellite track plot length in minutes.
11 Select Display the elevation mask value if you want to display the elevation mask in

degrees in the Sky View.
12 Select Apply to store the settings.

6.7.3 Adjusting the Integrity view
The Position integrity tab page allows you to adjust the scaling of the Integrity view.
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Procedure
1 Click the System menu,→Operator SW to open the Operator software configuration

dialog box.
2 Click the Position Integrity tab.
3 Enter the Max ellipse EPE in metres.
4 Enter the steps for Ellipse diagram resolution.
5 Click Apply to store the settings.

6.7.4 Adjusting the Compass view
The Compass tab page allows you to adjust the speed scaling of the Compass view.
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Procedure
1 Click the System menu,→Operator SW to open the Operator software configuration

dialog box.
2 Click the Compass tab.
3 Type the maximum vessel speed in knots to be displayed in the Compass View.
4 Type the number of circles to be displayed.

This is the resolution of the graphical presentation of the speed in the compass.
5 Type the lower speed limit in knots for when COG (Course Over Ground) and SOG

(Speed Over Ground) shall be displayed in the Compass View.
6 Click Apply to store the settings.

6.7.5 Adjusting UTM presentation
The UTM tab page allows you to control how UTM positions are treated by the
application. UTM is the Universal Transvers Mercator coordinate system.

Context

UTM options
When selecting False Northing, positions south of the equator will always be presented
as positive in the Position data area in the display. A fixed offset of 10 000 000 m is
added to the northing value to avoid negative coordinates in the southern hemisphere.
When selecting False Easting, a fixed offset of 500 000 m is added to the true easting
value to avoid negative coordinates. The UTM standard uses false northing and false
easting, i.e. the coordinates are never negative. In case negative northing or easting is
wanted, clear the False Northing check box.

Note

It is not possible to clear the False Easting check box.

Zone options
The UTM zone is automatically calculated by default. The Auto extended zone option is
only applicable between 56 degrees to 64 degrees north and 3 degrees to 6 degrees east.
The 32V zone is extended west to 3 degrees east, so when selecting the Auto extended
zone in this area, zone 32V is used. When outside the current area and Auto extended
zone is selected, the used zone is equal to the zone used when selecting Auto zone.
When selecting Auto zone, the system zone is automatically calculated in accordance
with the inserted coordinates.
Selecting Manual zone makes it possible to define which Zone and Zone offset to use.
The Zone offset option allows a fixed offset to be applied to the longitudinal degrees. The
UTM zone can be offset up to ±3 degrees. The zone offset is typically used where the
maps used have an offset. The zone range is from 1 to 60.
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Procedure
1 Select the System menu,→Operator SW to open the Operator software configuration

dialog box.
2 Select the UTM tab.
3 Deselect the False Northing check box if you want positions south of the equator

to be presented as negative values in the Position data when displaying position
as UTM.

4 Select which zone option you want to use.
If you select Manual
a Type the value for the zone you want to use.
b Type the zone offset for this zone, range 1 to 60.

5 Select Apply to store the settings.

6.7.6 Connecting the Seapath HMI software to the sensor
unit
The Data Source tab page allows you to select the available physical network interface.
This defines the data source for the operator software (Seapath HMI).
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Procedure
1 Click the System menu,→Operator SW to open the Operator software configuration

dialog box.
2 Click the Data source tab.
3 Select the interface which represents the connection to the wanted sensor unit from

the Network interface list.
4 Type the internet protocol (IP) address on which you want the operator software to

receive data.
This is normally an address in the Multicast IP range.

5 Type the internet protocol (IP) port on which you want the operator software to
receive data.

Important

The IP Address and IP Port must match the UDP address and UDP port entered in
the NAV Engine Configuration in order to establish communication with the operator
software.

6 Click the List servers button to show Seapath systems available through this physical
interface. Information presented for each available sensor unit is its IP address, the
product type and a description.

7 Click Apply to store the settings.
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Important

Remember that the operator software has to be located on the same IP subnet as the
sensor unit.

6.7.7 Selecting alarm message reception
The Alarm tab page allows you to define how to receive alarm messages.

Context

UDP Broadcast is the default (and recommended) setting. Defining a multicast address
for alarm message distribution requires advanced network configuration skills.

UDP Multicast

If the operator software configuration which is performed, is not in the same network as
the sensor unit, IP multicast is required. To enable multicast, select UDP Multicast and
enter the multicast address to use for receiving alarms.

UDP Broadcast

Select this option if alarm messages are transmitted to all network units.

90 M340-63/9.0



Setting to work

Procedure
1 Select the System menu,→Operator SW to open the Operator software configuration

dialog box.
2 Select the Alarms tab.
3 Select the wanted connection type: UDP Multicast or UDP broadcast.
4 Select Apply to store the settings.

6.8 Creating a backup of the configuration
and software installation

If you have a complex configuration setup in your system, it can be useful to make a
copy of this configuration in case you should need it later.

Context
The Copy Configuration tool will copy the system configuration to a disk based archive
file or to a USB flash drive.
Note

This procedure will only copy the configuration setup and not a full image of the
installed system.

Procedure
1 Insert a USB flash drive into the USB port on the external PC with the Seapath

application.
2 Select the Tools menu→Copy Configuration to open theConfiguration archiver dialog

box.
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3 The configured vessel name is automatically entered into the Vessel name box but
you can change this if you want.

4 Select Start to copy the configuration files to the USB flash drive.
The copied configuration will be stored as a compressed archive (ZIP file) under the
ConfigBackup folder in the root of the USB flash drive.

Note

If a USB flash drive is not inserted, the archive will be stored in a temporary location
on the local disk. In this case, the archive will only be available for restore until the
next reboot.

Result

You can use the USB flash drive with the copied configuration to restore the system
configuration at a later date.

6.9 Restoring the configuration backup
If you need to restore the configuration setup to your system, you can use the USB flash
drive with a copy of your configuration which you created with the Copy Configuration
tool.

Procedure
1 Insert a USB flash drive into the USB port on the external PC with the Seapath

application.
2 Select the System menu→Change system mode to enter Engineering mode to open

the Change system mode dialog box

3 Type the password STX and click OK. The password is not case sensitive.
You are now able to carry out changes and/or set system parameters.
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4 Select the Tools menu →Restore Configuration to open the Select configuration
archive dialog box with a list of available archive files..

5 Select the wanted archive and click OK to continue.
Observe that the Configuration archiver dialog box appears with information about
the selected configuration.
Select at least one option in the Information to restore group. This will enable the
Restore button.

6 Select Restore to restore the wanted configuration.

Note

The Restore Configuration tool will stop NAV Engine before restoring the
configuration. NAV Engine will be restarted automatically.
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7 Drawings

Outline drawing with mechanical dimensions for the Seapath 130 sensor unit, the MRU
subsea bottle and system schematics.
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7.1 Sensor unit dimensions
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7.2 Light weight MRU subsea bottle
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7.3 Assembly drawing for light weight
subsea bottle
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7.4 Spider cable schematics, default
version
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7.5 Spider cable schematics, short version
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8 Technical specifications

8.1 Performance specifications
The performance specifications summarize the main functional and operational
characteristics of the system.

8.1.1 Roll, pitch and heading specifications
Seapath 130–3 Roll and pitch accuracy for
±5° amplitude

0.010° RMS[1]

Seapath 130–5 Roll and pitch accuracy for
±5° amplitude

0.008° RMS[2]

Seapath 130–5+ Roll and pitch accuracy for
±5° amplitude

0.005° RMS[3]

Seapath 130–3 and 130–H heading accuracy 0.10° RMS
Seapath 130–5 and 130–5+ heading accuracy 0.08° RMS

8.1.2 Heave spesifications
Heave accuracy (real-time output) 5 cm or 5 % whichever is highest
Seapath 130–5 and 130–5+ heave motion
periods (real-time output)

0 to 25 seconds

Seapath 130–3 heave motion periods
(real-time output)

0 to 18 seconds

1. With Automatic Online Calibration (AOC).
2. With Automatic Online Calibration (AOC).
3. With Automatic Online Calibration (AOC).
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Heave accuracy (delayed signal,
PFreeHeave®)

2 cm or 2 % whichever is highest

Heave motion periods (delayed signal,
PFreeHeave®)

0 to 50 seconds

8.1.3 Position and velocity specifications
Position accuracy with DGNSS 0.5 m RMS or 1 m 95 % CEP
Position accuracy with SBAS 0.5 m RMS or 1 m 95 % CEP
Position accuracy with Fugro SeaSTAR
XP2/G2/G2+/G4/G4+

0.05 m RMS or 0.1 m 95 % CEP

Position accuracy with VERIPOS
Ultra/Ultra2

0.05 m RMS or 0.1 m 95 % CEP

Position accuracy with C-NavC1, C-NavC2 0.05 m RMS or 0.1 m 95 % CEP
Position accuracy with RTK (x and y) 1 cm + 1 ppm RMS[4]

Position accuracy with RTK (z) 2 cm + 1 ppm RMS(2)

Velocity accuracy 0.03 m/s RMS or 0.07 m/s 95 % CEP

8.1.4 Horizontal position drift specifications
Seapath 130-3 typical position drift 1 minute
after GNSS dropout (RTK)

1.6 m

Seapath 130-5 typical position drift 1 minute
after GNSS dropout (RTK)

0.6 m

Seapath 130-5+ typical position drift 1
minute after GNSS dropout (RTK)

0.3 m

8.2 Interface specifications

8.2.1 Sensor unit
Output serial ports 3 non-dedicated isolated ports, RS-232 or RS-422
Input serial ports 1 non-dedicated isolated ports, RS-232 or RS-422
Baud rate Up to 115 200 bits/sec
LAN 1 Ethernet port

4. The accuracy is dependent on GPS satellite geometry, environment, ionospheric conditions and distance
to the reference station. Excessive multipath, GPS signal obstructions or interference may also reduce
the performance.
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Data output rate Up to 100 Hz
Timing accuracy 1 ms
Data delay All data in real-time (0 ms) plus transmission delay

8.3 Weight and outline dimensions
The weights and outline dimension characteristics summarize the physical properties
of the system.

Note

For more detailed information about the physical dimensions, see Drawings.

8.3.1 Sensor unit
Length 1210 mm
Width 210 mm
Height 94 mm
Weight (including 1 m cable) 7.7 kg

8.3.2 Light weight subsea bottle
Type MRU-M-SB12
Height 209 mm, 240.5 mm incl. connectors
Diameter 120 mm
Dry weight 3.7 kg including MRU
Submerged weight 1.3 kg including MRU
Colour Anodised aluminium
Depth 10 metres
Connectors 2, 8–pin Seacon

8.4 Power specifications
The power specifications summarize the power supply requirements for the system.
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8.4.1 Sensor unit
Voltage 10 to 36 V DC
Recommended voltage 24 V DC
Power consumption Max. 10 W (typical 8 W)

8.4.2 MRU unit
Voltage 10 to 36 V DC
Recommended voltage 24 V DC
Power consumption MRU H,
5 and 5+

Max. 12 W (typical 8 W)

Power consumption MRU 3 Max. 5.5 W

8.5 Environmental specifications
The environmental specifications summarize the temperature and humidity requirements
for the system.

8.5.1 Sensor unit
Enclosure material Aluminium bottom part and polyurethane cover
Operating temperature range -40 °C to +70 °C
Storage temperature range -40 °C to +70 °C
Operating humidity (max) Sealed, no limit
Storage humidity Sealed, no limit
Ingress protection IP 56
Electromagnetic compatibility
(immunity/emission)

IEC 60945/EN 60945

Vibration IEC 60945/EN 60945

8.5.2 MRU Unit
Enclosure material Anodised aluminium
Enclosure protection IP-66
Operating temperature range -5 °C to +55 °C
Operating humidity (max) Sealed, no limit
Storage temperature range -25 °C to +70 °C
Storage humidity Sealed, no limit
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Electromagnetic compatibility
(immunity/emission)

IEC 60945/EN 60945

Vibration IEC 60945/EN 60945
Max shock non-operational
(10 ms peak)

1000 m/s2

MTBF (computed) 50000 h
MTBF (service history based)) 100000 h

8.6 Radio frequency specifications
The radio frequency characteristics summarize the frequency ranges for the system.

8.6.1 GNSS antenna
Type NovAtel GPS-713-GGG-N
Upper band 1584 ± 27 MHz
Lower band 1210 ± 45 MHz
LNA gain 35 dB (typical)

8.7 Data output specifications
The system will interface with peripheral systems and sensors using standard and/or
proprietary datagram formats.

8.7.1 Sensor unit
Output formats Simrad EM3000

Seapath binary format 3, 11, 23, 26
Calibration format
Echo sounder format
Echo sounder format 18, TSS1
RD Instrument ADCP proprietary NMEA format,
“PRDID”
Lehmkuhl gyro repeater format
1PPS time tag, NMEA ZDA message
1PPS time tag, Trimble compatible messages
Atlas Fansweep format
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RTCM v3, raw GNSS output
PFreeHeave format
IMU raw data output
NMEA 0183 v. 3.0, Proprietary

NMEA message types DTM, GBS, GGA, GLL, GNS, GRS, GSA, GST,
GSV, THS, HDT, RMC, ROT, VBW, VTG, ZDA.
NMEA proprietary: PSXN20, PSXN21, PSXN22,
PSXN23, PSXN24, PSXN25, PSXN26, PSXN27.

8.8 Data input specifications

8.8.1 Sensor unit
DGNSS corrections Seastar XP, Seastar G2, Seastar G4/G4+, VERIPOS

Ultra/Ultra2, C-NavC1, C-NavC2, RTCM-SC104 v.
2.2, 2.3, 3.0 and 3.2, Trimble CMR

Gyro compass NMEA 0183 HDT, HDM, HRC, PSXN10, PSXN23,
Robertson LR22 BCD format and EM3000

8.9 Datum specifications

8.9.1 Sensor unit
Datum types. These datum
types can only be selected if
the corrections input to the
product is in WGS84 or no
corrections are input

NAD27, ED50, WGS84, MINNA, ARATU Bahia,
ARATU Campos, ARATU ES, ARATU Santos,
SIRGAS2000 and CAMACUPA.

8.10 Cable specifications
The cable characteristics summarize the cable specifications for the system.

8.10.1 Sensor unit cable
Type Heavy duty screened, 14 x 2 x 0.25 mm2

Length 20 m
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Diameter 13.5 mm
Weight 0.27 kg/m
Flame retardation IEC 60332–1
Insulation PP (conductors) and PUR (outer cover)
Screen Cu-braid
Bend radius 100 mm

8.10.2 MRU umbilical cable
Type Umbilical cable, 4 x 2 x 0.75 mm2

Length 15 or 30 m
Screen Alum/braid
Diameter 12.6 mm
Bend radius static/dynamic 150 mm (minimum)
Weight in Air 241 Kg/Km
Weight in Sea 112 Kg/Km

8.11 Conformity declaration
The product is tested and is compliant with the relevant product standards.

106 M340-63/9.0



Technical specifications

M340-63/9.0 107



Seapath 130 series

9 Equipment handling

9.1 Handling and storage
Observe the following when handling the equipment:
• All units must be handled with care.
• The equipment must not be subjected to shocks, excessive vibration or other rough

handling.
• The equipment must be preserved and stored in such a way that it does not constitute

any danger to health, environment or personal injury.
• For operation and storage, see the respective environmental specifications.
Note

After the installation please save the MRU transportation container. To maintain
warranty validity, the MRU must be shipped in this container for service or repair.

Related topics
• Environmental specifications on page 103

9.2 Disposal
All electrical and electronic components have to be disposed
of separately from the municipal waste stream via designated
collection facilities appointed by the government or local
authorities. The correct disposal and separate collection
of your old appliance will help prevent potential negative
consequences for the environment and human health. It is
a precondition for reuse and recycling of used electrical and
electronic equipment. For more detailed information about
disposal of your old appliance, please contact your local
authorities or waste disposal service.
The equipment may be returned to Kongsberg Discovery AS
if there is no local WEEE (Waste Electrical and Electronic Equipment) collection. The
equipment is marked with this pictogram.
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Appendix A
Output protocols

The following output data protocols are available from Seapath:

Name Format
no.

Description

NMEA 1 NMEA and proprietary messages
Seapath binary fmt3 3 Seapath binary format 3
Simrad EM3000/Hipap 6 Simrad EM3000, 300 and Hipap compatible
Calibration 7 Calibration format for GPS antennas
Echo Sounder fmt9 9 Echo sounder format
RDI ADCP 10 RDI ADCP format, PRDID
Seapath binary fmt11 11 Seapath binary format 11
Lehmkuhl gyro repeater 12 Lehmkuhl gyro repeater format
1PPS NMEA ZDA 13 1PPS time tag, NMEA ZDA message
1PPS Trimble 14 1PPS time tag, Trimble compatible message
Atlas Fansweep 16 Atlas Fansweep format
Echo Sounder fmt18 18 Echo sounder format, TSS1 compatible
Seapath binary fmt 22 22 Seapath output format for VMM 200 (not

documented)
Seapath binary fmt 23 23 Seapath binary format 23
PFreeHeave format 24 Delayed heave format
Seapath binary fmt 25 25 Raw IMU output (not documented)
Seapath binary fmt 26 26 Seapath binary format 26
Seapath binary fmt 27 27 Seapath output format for VMM 200 version

2 (not documented)
KM binary 30 KM echo sounder compatible
RTCM version 3 80 Raw GNSS output
Post-processing 1 81 TerraPOS multiple telegrams in same stream

(not documented)
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A.1 NMEA format
The NMEA format is an ASCII text format using DTM, ZDA, GGA, GLL, VTG, HDT,
RMC, VBW, ROT, VER, GST, GSA and GRS messages, the proprietary PBFG and the
proprietary PSXN 20, 21, 22, 23, 24, 25, 26 and 27 messages conforming to the same
specification.

Format:
$INDTM,dcode,scode,latoff,{N|S},longoff,{E|W},altoff,rcode*csum term
$INZDA,time,day,month,year,,*csum term
$INGGA,time,lat,{N|S},long,{E|W},gga-qual,nsat,hdop,height,M,geoidal,M,age,stn*csum
term
$INGLL,lat,{N|S},long,{E|W},time,gll-qual,mode*csum term
$INVTG,course,T,,M,speed,N,,K,mode*csum term
$INHDT,head,T*csum term
$INHRC,head,rate*csum term
$INRMC,utc,status,lat,{N|S},long,{E|W},speed,course,date,magvar,{E|W},mode*csum
term
$INTHS,head,a*csum term
$INVBW,lwspeed,twspeed,Aw,lgspeed,tgspeed,Ag,stwspeed,At,stgspeed,As*csum term
$INROT,rate,Arate*csum term
$INVER,total-no,sentence-no,dev-type,vendor,,serial-no,model-code,sw-rev,hw-rev,seq-id*csum
term
$INGBS,utc-fix,err-lat,err-long,err-alt,id-failed,missed,bias,sd-bias*csum term
$INGNS,time,lat,{N|S},long,{E|W},gns-mode,nsat,hdop,alt-msl,geo-sep,age,stn*csum
term
$INGSV,tno,no,nsat-view,id,elev,azi,snr,.........,id,elev,azi,snr*csum term
$INGST,time,,semi-maj,semi-min,ell-orient,sd-lat,sd-long,sd-height*csum term
$INGSA,gsa-mode,gsa-status,id,id,id,id,id,id,id,id,id,id,id,id,pdop,hdop,vdop*csum
term
$INGRS,time,1,res,res,res,res,res,res,res,res,res,res,res,res*csum term
$PBFG,vers,time,ro,pi,hd,hv,ro-rate,pi-rate,ya-rate,x-vel,y-vel,z-vel,sts-att,sts-hd,sts-hv,sts-vel*csum
term
$PSXN,20,horiz-qual,hgt-qual,head-qual,rp-qual*csum term
$PSXN,21,event*csum term
$PSXN,22,gyro-calib,gyro-offs*csum term
$PSXN,23,roll,pitch,head,heave*csum term
$PSXN,24,roll-rate,pitch-rate,yaw-rate,vertical-vel*csum term
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$PSXN,25,gnss-rec,ant-forw,ant-stb,ant-down,ant-code,rec-code*csum term

$PSXN,26,mp-no,mp-forw,mp-stb,mp-down,mp-name*csum term

$PSXN,27,mru-forw,mru-stb,mru-down,angle-ro,angle-pi,angle-yaw*csum term

Explanation:

dcode Local datum code (null field) on format ccc.

scode Local datum subdivision code on format a.
latoff Latitude offset in minutes N/S on format x.x.
longoff Longitude offset in minutes E/W on format x.x.
altoff Altitude offset in metres (+/-) on format x.x.
rcode Reference datum code (WGS84 = W84) on format ccc.
time UTC time on format hhmmss.ss where hh is hours (00 - 23), mm is

minutes (00 - 59) and ss.ss is seconds (00.00 - 59.99).
day Day of month (01 - 31).
month Month of year (01 - 12).
year Year on format yyyy.
lat Latitude on format ddmm.mmmmmm where dd is degrees (00 - 90)

and mm.mmmmmm is minutes (00.000000 - 59.999999).
long Longitude on format dddmm.mmmmmm where ddd is degrees (000

- 180) and mm.mmmmmm is minutes (00.000000 - 59.999999).
gga-qual GPS quality indicator: 0 = invalid position, 1 = GPS SPS used, 2 =

DGPS used, 3 = GPS PPS used, 4 = GPS RTK used, 5 = GPS float
RTK used, 6 = dead reckoning.

nsat Number of satellites in use (00 - 99).
hdop HDOP on format x.x.
height Height above ellipsoid in metres on format m.mm.
geoidal Geoidal separation in metres on format m.mm.
age Age of DGPS corrections in seconds on format s.s.
stn DGPS reference station ID (0000 - 1023).
gll-qual Geographic position quality: A = valid, (D)GPS used (normal or

reduced performance), V = dead reckoning or invalid position.
mode Positioning mode: A = GPS used, D = DGPS used, E = dead

reckoning, N = invalid position/velocity.
course Course over ground, degrees true on format d.dd (0.00 - 359.99).
speed Speed over ground, knots on format k.k.
head Heading, degrees true on format d.dd (0.00 - 359.99).
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a Mode indicator: A = Autonomous, V = Data not valid.
utc UTC of position fix on format hhmmss.ss.
status Status: A = Data valid, V = Navigation receiver warning.
date Date: day, month, year on format xxxxxx.
magvar Magnetic variation in degrees on format x.x.
lwspeed Longitudinal water speed in knots on format x.x. Longitudinal

speed: "-" = astern
twspeed Transverse water speed in knots on format x.x. Transverse speed:

"-" = port
Aw Status: Water speed, A = valid data on format A
lgspeed Longitudinal ground speed in knots on format x.x. Longitudinal

speed: "-" = astern
tgspeed Transverse ground speed in knots on format x.x. Transverse speed:

"-" = port
Ag Status: Ground speed, A = valid data on format A.
stwspeed Stern transverse water speed in knots on format x.x. Transverse

speed: "-" = port
At Status: Stern water speed, A = valid data on format A.
stgspeed Stern transverse ground speed in knots on format x.x. Transverse

speed: "-" = port
As Status: Stern ground speed, A = valid data on format A.
rate Rate of turn (degrees/minute on format x.x. “-“ = bow turns to port
Arate Status: A = Data valid, V = Data invalid, on format A
total-no Total number of sentences needed (1-9) on format x.
sentence-no Sentence number (1-9) on format x.
dev-type The manufactured purpose of the device (GNSS).
vendor Vendor name (KSX).
serial-no The unique serial number for the device.
model-code A code describing the type of model.
sw-rev The product’s software revision.
hw-rev The product’s hardware revision.
seq-id Sequence message identifier (0-9) on format x.
utc-fix UTC of the GGA or GNS fix associated with this sentence (hours,

minutes, seconds) on format hhmmss.ss.
err-lat Expected error in latitude on format x.x.
err-long Expected error in longitude on format x.x.
err-alt Expected error in altitude on format x.x.
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id-failed ID number of most likely failed satellite, GPS: 1-32 , WAAS: 33-64,
GLONASS: 65-96 on format xx.

missed Probability of missed detection for most likely failed satellite on
format x.x.

bias Estimate of bias in metres on most likely failed satellite on format
x.x.

sd-bias Standard deviation of bias estimate on format x.x.
gns-mode Mode indicator on format c–c. The first character indicates the use of

GPS/GLONASS satellites. N = No fix, A = Autonomous mode, D =
Differential mode.

alt-msl Antenna altitude, metres, reference: mean-sea-level (geoide) on
format x.x.

geo-sep Geoidal separation, metres: the difference between the earth ellipsoid
and mean-sea-level on format x.x.

tno Total number of messages (1-9) on format x.
no Message number (1-9) on format x.
nsat-view Total number of satellites in view on format x.x.
elev Elevation in degrees, 90º maximum on format xx.
azi Azimuth in degrees (000-359) on format xxx.
snr SNR 00-99 dB-Hz, 0 when not tracked on format xx.
semi-maj Standard deviation of the semi-major axis of the position error ellipse

in metres on format m.mm.
semi-min Standard deviation of the semi-minor axis of the position error

ellipse in metres on format m.mm.
ell-orient Orientation of the semi-major axis of the position error ellipse in

degrees (0 - 180).
sd-lat Standard deviation of latitude error in metres on format m.mm.
sd-long Standard deviation of longitude error in metres on format m.mm.
sd-height Standard deviation of height error in metres on format m.mm.
gsa-mode GPS position mode setting: A = height aiding enabled, M = 3D only.
gsa-status GPS position mode used: 1 = no GPS position, 2 = height aided (3

satellites), 3 = 3D.
id Satellite ID number, GPS (01 – 32), WAAS: 33-64, GLONASS:

65-96.
pdop PDOP on format x.x
vdop VDOP on format x.x.
res GPS range residual in metres on format m.m (no fraction if the value

is greater than 99.9 metres).
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vers Version number (1-9) on format x.
ro Roll in degrees on format d.ddd. Positive with starboard side down.
pi Pitch in degrees on format d.ddd. Positive with bow up.
hd Heading in degrees on format d.ddd.
hv Heave in metres on format d.ddd. Positive down.
ro-rate Roll rate in degrees per second on format d.ddd. Positive with

starboard side down.
pi-rate Pitch rate in degrees per second on format d.ddd. Positive with

bow up.
ya-rate Yaw rate in degrees per second on format d.ddd. Positive clockwise.
x-vel Velocity in North direction on format d.ddd.
y-vel Velocity in East direction on format d.ddd.
z-vel Velocity in Down direction on format d.ddd. Positive down.
sts-att Status on roll and pitch angle and rate: 0 = Invalid, 1 = Reduced, 2

= Normal.
sts-hd Status on heading and yaw rate: 0 = Invalid, 1 = Reduced, 2 =

Normal.
sts-hv Status on heave and velocity in Z-direction: 0 = Invalid, 1 =

Reduced, 2 = Normal.
sts-vel Status on velocity in X- and Y-direction: 0 = Invalid, 1 = Reduced, 2

= Normal..
horiz-qual Horizontal position and velocity quality: 0 = normal, 1 = reduced

performance, 2 = invalid data.
hgt-qual Height and vertical velocity quality: 0 = normal, 1 = reduced

performance, 2 = invalid data.
head-qual Heading quality: 0 = normal, 1 = reduced performance, 2 = invalid

data.
rp-qual Roll and pitch quality: 0 = normal, 1 = reduced performance, 2

= invalid data.
gyro-calib Gyro calibration value since system start-up in degrees on format

d.dd.
gyro-offs Short-term gyro offset in degrees on format d.dd.
roll Roll in degrees on format d.dd. Positive with port side up.
pitch Pitch in degrees on format d.dd. Positive with bow up.
heave Heave in metres on format d.dd. Positive down.
roll-rate Roll rate in degrees per second on format d.dd. Positive when port

side is moving upwards.
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pitch-rate Pitch rate in degrees per second on format d.dd. Positive when bow
is moving upwards.

yaw-rate Yaw rate in degrees per second on format d.dd. Positive when bow is
moving towards starboard.

vertical-vel Vertical velocity in metres per second on format d.dd. Positive when
moving downwards.

gnss-no GNSS receiver number [1..n].
ant-forw Arm from Origin to GNSS antenna in forward direction [m].
ant-stb Arm from Origin to GNSS antenna in starboard direction [m].
ant-down Arm from Origin to GNSS antenna in down direction [m].
ant-code IGS GNSS antenna code (20 characters).
rec-code IGS GNSS receiver code (20 characters).
mp-no Monitoring point number [0..n]. If mp-no= 0, them arm from Origin

to NRP is input.
mp-forw Arm from Origin to MP/NRP in forward direction [m].
mp-stb Arm from Origin to MP/NRP in starboard direction [m].
mp-down Arm from Origin to MP/NRP in down direction [m].
mp-name Monitoring point name. If mp-no=0, thenmp-name=NRP.
mru-forw Arm from Origin to MRU in forward direction [m].
mru-stb Arm from Origin to MRU in starboard direction [m].
mru-down Arm from Origin to MRU in down direction [m].
angle-ro MRU mounting angle roll [-180.000 to 179.999 deg].
angle-pi MRU mounting angle pitch [-89.999 to 89.999 deg].
angle-yaw MRU mounting angle yaw [-180.000 to 179.999 deg].
event Event code: 1 = system restart.
csum Checksum (exclusive or) of all characters between, but not including,

the preceding $ and *, hexadecimal (00 - FF).
term CR-LF (2 bytes, values 13 and 10).

The ZDA, GGA, GLL, VTG, HDT, GST, GSA, GRS, PSXN 20, 21, 22, 23 and 24
messages are output regularly at an adjustable rate. If gyro calibration data are not
being calculated, the PSXN, 22 message is not output. The PSXN, 21 message is output
once when an event occurs.

A sub set of the available NMEA messages can be configured individually for each
serial line.
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A.2 Binary format 3
This binary format consists of a fixed-length message using single-byte unsigned,
4-byte two-complement integer and 4-byte IEEE floating point data elements. For the
multi-byte elements, the most significant byte is transmitted first.

Format:
Element Scaling Format Bytes Value
Header ASCII 1 ASCII "q"
Length Unsigned 1 49

Token Unsigned 1 0 - 255
Time nanoseconds Integer 4 0 - 999999999
Latitude 230 = 90 degrees Integer 4 -230 - 230

Longitude 230 = 90 degrees Integer 4 -231 - 231

Height metres Float 4
Heave metres Float 4
North
velocity

metres/second Float 4

East
velocity

metres/second Float 4

Down
velocity

metres/second Float 4

Roll radians Float 4
Pitch radians Float 4
Heading radians Float 4 0 - 2 pi
Status word radians Bit-fields 4
Checksum Unsigned 1 0 - 255

Length is number of bytes between, but not including, the Length and Checksum fields.
Checksum is calculated modulo 256 of all bytes between, but not including, the Length
and Checksum fields. The contents of the Token field is adjustable. Latitude is positive
north of the Equator. Longitude is positive east of Greenwich. Height is above the
ellipsoid. Heave is positive down. Roll is positive with port side up. Pitch is positive
with bow up.
The status word consists of 32 single bit flags numbered from 0 to 31, where 0 is the
least significant bit.
A 1 value (true) means:
Bit no. Interpretation

0 Reduced horizontal position and velocity performance.
1 Invalid horizontal position and velocity data.

116 M340-63/9.0



Appendix A Output protocols

Bit no. Interpretation
2 Reduced heave and vertical velocity performance.

3 Invalid heave and vertical velocity data.
4 Reduced roll and pitch performance.
5 Invalid roll and pitch data.
6 Reduced heading performance.
7 Invalid heading data.

The remaining bits in the status word are reserved for future expansion.

A.3 Binary format 11
This binary format consists of a fixed-length message using 1, 2 and 4–byte signal and
unsigned integers. The signed integers are represented as two-complement numbers.
For the multi-byte elements, the most significant byte is transmitted first. The total
number of bytes is 42.

Format:
Element Scaling Format Bytes Value
Header ASCII 1 ASCII "q"
Time, seconds seconds Integer 4

Time, fraction
of second

0.01 second Unsigned 1 0 - 99

Latitude 230 = 90 degrees Integer 4 -230 - 230

Longitude 230 = 90 degrees Integer 4 -231 - 231

Height centimetres Integer 4
Heave centimetres Integer 2
North velocity centimetres/second Integer 2
East velocity centimetres/second Integer 2
Down velocity centimetres/second Integer 2
Roll 214 = 90 degrees Integer 2 -215 - 215

Pitch 214 = 90 degrees Integer 2 -215 - 215

Heading 214 = 90 degrees Unsigned 2 -0 - 216

Roll rate 214 = 90
degrees/second

Integer 2 -215 - 215

Pitch rate 214 = 90
degrees/second

Integer 2 -215 - 215

M340-63/9.0 117



Seapath 130 series

Element Scaling Format Bytes Value
Yaw rate 214 = 90

degrees/second
Integer 2 -215 - 215

Status word Bit-fields 2
Checksum Unsigned 2

Checksum is calculated as a 16-bit Block Cyclic Redundancy Check of all bytes between,
but not including the Header and Checksum fields. The CRC algorithm is described in
a separate section. Time is divided in an integer seconds part and a fractional second
part. The integer seconds part of time is counted from 1970-01-01 UTC time, ignoring
leap seconds.

Latitude is positive north of the Equator. Longitude is positive east of Greenwich.
Height is above the ellipsoid. Heave is positive down. Roll is positive with port side
up. Pitch is positive with bow up.

The status word consists of 16 single bit flags numbered from 0 to 15, where 0 is the
least significant bit.

A 1 value (true) means:

Bit no. Interpretation
0 Reduced horizontal position and velocity performance.
1 Invalid horizontal position and velocity data.
2 Reduced heave and vertical velocity performance.

3 Invalid heave and vertical velocity data.
4 Reduced roll and pitch performance.
5 Invalid roll and pitch data.
6 Reduced heading performance.
7 Invalid heading data.

The remaining bits in the status word are reserved for future expansion.

A.4 Seapath Binary 23
This binary format consists of a fixed-length message using 1, 2 and 4–byte signal and
unsigned integers. The signed integers are represented as two-complement numbers.
For the multi-byte elements, the most significant byte is transmitted first. The total
number of bytes is 44.
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Format

Element Scaling Format Bytes Value
Header Unsigned 1 AA Hex
Header Unsigned 1 51 Hex
Time, seconds seconds Integer 4

Time, fraction
of second

0.0001 second Unsigned 2 0 to 9999

Latitude 230 = 90 degrees Integer 4 -230 - 230

Longitude 230 = 90 degrees Integer 4 -231 - 231

Height centimetres Integer 4
Heave centimetres Integer 2
North velocity centimetres/second Integer 2
East velocity centimetres/second Integer 2
Down velocity centimetres/second Integer 2
Roll 214 = 90 degrees Integer 2 -215 - 215

Pitch 214 = 90 degrees Integer 2 -215 - 215

Heading 214 = 90 degrees Unsigned 2 0 - 216

Roll rate 214 = 90
degrees/second

Integer 2 -215 - 215

Pitch rate 214 = 90
degrees/second

Integer 2 -215 - 215

Yaw rate 214 = 90
degrees/second

Integer 2 -215 - 215

Status word Bit-fields 2
Checksum Unsigned 2

Checksum is calculated as a 16-bit Block Cyclic Redundancy Check of all bytes between,
but not including the Header and Checksum fields. The CRC algorithm is described in
a separate section. Time is divided in an integer seconds part and a fractional second
part. The integer seconds part of time is counted from 1970-01-01 UTC time, ignoring
leap seconds.

Latitude is positive north of the Equator. Longitude is positive east of Greenwich.
Height is above the ellipsoid. Heave is positive down. Roll is positive with port side
up. Pitch is positive with bow up.

The status word consists of 16 single bit flags numbered from 0 to 15, where 0 is the
least significant bit.

A 1 value (true) means:
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Bit no. Interpretation
0 Reduced horizontal position and velocity performance.
1 Invalid horizontal position and velocity data.
2 Reduced heave and vertical velocity performance.

3 Invalid heave and vertical velocity data.
4 Reduced roll and pitch performance.
5 Invalid roll and pitch data.
6 Reduced heading performance.
7 Invalid heading data.

The remaining bits in the status word are reserved for future expansion.

A.5 Seapath Binary 26
This binary format consists of a fixed-length message using 1, 2 and 4–byte signal and
unsigned integers. The signed integers are represented as two-complement numbers.
For the multi-byte elements, the most significant byte is transmitted first. The total
number of bytes is 52.

Format

Element Scaling Format Bytes Value
Header Unsigned 1 AA Hex
Header Unsigned 1 53 Hex
Time, seconds seconds Integer 4

Time, fraction
of second

0.0001 second Unsigned 2 0 to 9999

Latitude 230 = 90 degrees Integer 4 -230 - 230

Longitude 230 = 90 degrees Integer 4 -231 - 231

Height centimeters Integer 4
Heave,
real-time

centimeters Integer 2

North velocity centimeters/second Integer 2
East velocity centimeters/second Integer 2
Down velocity centimeters/second Integer 2
Roll 214 = 90 degrees Integer 2 -215 - 215

Pitch 214 = 90 degrees Integer 2 -215 - 215
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Element Scaling Format Bytes Value
Heading 214 = 90 degrees Unsigned 2 0 - 216

Roll rate 214 = 90
degrees/second

Integer 2 -215 - 215

Pitch rate 214 = 90
degrees/second

Integer 2 -215 - 215

Yaw rate 214 = 90
degrees/second

Integer 2 -215 - 215

Delayed heave
time, seconds

seconds Integer 4

Delayed heave
time, fraction
of second

0.0001 second Unsigned 2 0 to 9999

Heave, delayed centimeters Integer 2
Status word Bit-fields 2
Checksum Unsigned 2

Checksum is calculated as a 16-bit Block Cyclic Redundancy Check of all bytes between,
but not including the Header and Checksum fields. The CRC algorithm is described in
a separate section. Time is divided in an integer seconds part and a fractional second
part. The integer seconds part of time is counted from 1970-01-01 UTC time, ignoring
leap seconds.
Latitude is positive north of the Equator. Longitude is positive east of Greenwich.
Height is above the ellipsoid. Heave is positive down. Roll is positive with port side
up. Pitch is positive with bow up.
The status word consists of 16 single bit flags numbered from 0 to 15, where 0 is the
least significant bit.
A 1 value (true) means:

Bit no. Interpretation
0 Reduced horizontal position and velocity performance.
1 Invalid horizontal position and velocity data.
2 Reduced heave and vertical velocity performance.
3 Invalid heave and vertical velocity data.
4 Reduced roll and pitch performance.
5 Invalid roll and pitch data.
6 Reduced heading performance.
7 Invalid heading data.
8 Invalid delayed heave data

The remaining bits in the status word are reserved for future expansion.
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A.6 Simrad EM3000
The Simrad EM3000 format consists of a fixed-length message using single-byte
unsigned, 2-byte unsigned and 2-byte two-complement integer data elements. For the
2-byte elements, the least significant byte is transmitted first.

Format

Element Scaling Format Bytes Value
Status byte Unsigned 1
Header Unsigned 1 90 Hex
Roll 0.01 degrees Integer 2 -17999 to 17999
Pitch 0.01 degrees Integer 2 -17999 to 17999
Heave 1 cm Integer 2 -999 to 999
Heading 0.01 degrees Unsigned 2 0 to 35999

Roll is positive with port side up. Pitch is positive with bow up. Heave is positive up.

The status byte can have the following values:

Value Interpretation
90 Hex Normal
91 Hex Reduced performance
A0 Hex Invalid data

Invalid data are also indicated by values outside the specified ranges. When the status
is A0, the values which are within specified ranges can be assumed to have valid, but
reduced quality.

A.7 KM binary format
The KM binary protocol is a proprietary binary format used when connection to
multibeam echo sounders and other systems. Length 132 bytes.

Format

Format # of bytes
Start id #KMB char 4U
Dgm length uint16 2U
Dgm version (=1) uint16 2U

UTC seconds s uint32 4U
UTC nanoseconds ns uint32 4U
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Format # of bytes
Status uint32 4U

Latitude deg double 8F
Longitude deg double 8F
Ellipsoid height m float 4F

Roll deg float 4F
Pitch deg float 4F
Heading deg float 4F
Heave m float 4F

Roll rate deg/s float 4F
Pitch rate deg/s float 4F
Yaw rate deg/s float 4F

North velocity m/s float 4F
East velocity m/s float 4F
Down velocity m/s float 4F

Latitude error m float 4F
Longitude error m float 4F
Height error m float 4F
Roll error deg float 4F
Pitch error deg float 4F
Heading error deg float 4F
Heave error m float 4F

North acceleration m/s2 float 4F
East acceleration m/s2 float 4F
Down acceleration m/s2 float 4F

Delayed heave:
UTC seconds s uint32 4U
UTC nanoseconds ns uint32 4U
Delayed heave m float 4F
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This format include the necessary information for calculation of the Doppler effect at
the transducer locations (needed in FM chirp mode). The update rate should then be
minimum 100 Hz.

Definitions
Data format

Little endian (the least significant byte is transmitted first). Float is according to
IEEE - 754.

Dgm length
The total number of bytes in the datagram.

Dgm version
The version is incremented if the datagram format is changed.

Timestamp format
Epoch 1970-01-01 UTC time, ignoring leap seconds.

Position and height
At user defined sensor reference point. Position in decimal degrees.
• Latitude: Negative on Southern hemisphere.
• Longitude: Negative on Western hemisphere.
• Height: Positive above ellipsoid.

Positive roll
Port side up.

Positive pitch
Bow up.

Positive heave
Downwards, at user defined sensor reference point.

Heading
True North.

Error fields
Sensor data quality: RMS
-1= not implemented

Status word
One bit per status info, 1= active
Bit #

Invalid data:
0 Horizontal position and velocity
1 Roll and pitch
2 Heading
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Bit #
3 Heave and vertical velocity
4 Acceleration
5 Delayed heave

Reduced performance:
16 Horizontal position and velocity
17 Roll and pitch
18 Heading
19 Heave and vertical velocity
20 Acceleration
21 Delayed heave

A.8 Calibration format 7
The calibration format is a columnar ASCII text format for use when calibrating the
GNSS antenna installation.

Format:

Element Columns Scaling Decimals Value
Time 1 - 7 seconds 1 0.0 - 86399.9
Heading 10 - 15 degrees 2 0.00 - 359.99
Gyro heading 18 - 23 degrees 2 0.00 - 359.99
Baseline 26 - 31 metres 3
Height 34 - 38 metres 2
Term 39 - 40 CR-LF

Each record consists of numbers on ASCII format separated by spaces and terminated
by carriage return and linefeed (values 10 and 13). Leading spaces are used, so the
numbers are separated by two or more spaces, and spaces may occur before the first
number on the record.

Time is counted since last midnight UTC time. Heading is true heading from the GNSS
phase measurement, which is not the same as the heading output on the other formats.
Gyro heading is from an external gyro, 0.00 if no gyro is connected. Baseline is the slant
range between the antenna centres from the GNSS phase measurement. Height is the
height difference between the antennas from the GNSS phase measurement. Height is
positive if antenna 1 is above antenna 2.
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The data are intended for calibration of the antenna installation, so no data are output
unless the GNSS phase measurements are valid.

A.9 Echo sounder format 9
This echo sounder format is a proprietary ASCII text format with fixed-length records
used when connecting Simrad EA500 and other echo sounders.

Format:

Element Columns Scaling Format
Header 1 - 7 :000000
Heave 9 - 13 1 cm sdddd
Warning 14 space or “?”
Roll 15 - 19 0.01 degree sdddd
Pitch 21 – 25 0.01 degree sdddd
Term 26 – 27 CR-LF

Heave is positive up. Roll is positive with port side up. Pitch is positive with bow up.

The zeroes in the header occupy the columns used for acceleration when this format is
output from other systems. Seapath does not output acceleration.

“s” is the sign character, space if positive and “-“ if negative. “dddd” is a decimal number
with leading zeroes where appropriate.

The warning character is space if data are normal, “?” if data are invalid or of reduced
quality.

Columns between elements are filled with spaces.

The definition of the attitude angles in this format is different from the Euler angles
definition used elsewhere. The difference appears in the roll angle, where:

A.10 Echo sounder format 18, TSS1
This echo sounder format is a proprietary ASCII text format with fixed-length records
used when connecting Seapath to Seabeam and other echo sounders.
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Format:

Element Columns Scaling Format
Header 1 - 7 :000000
Heave 9 - 13 1 cm sdddd
Warning 14 "F" or "f"
Roll 15 - 19 0.01 degree sdddd
Pitch 21 – 25 0.01 degree sdddd
Term 26 – 27 CR-LF

Heave is positive up. Roll is positive with port side up. Pitch is positive with bow up.

The zeroes in the header occupy the columns used for acceleration when this format is
output from other systems. Seapath does not output acceleration.

“s” is the sign character, space if positive and “-“ if negative. “dddd” is a decimal number
with leading zeroes where appropriate.

The warning character is “F” if data are normal, “f” if data are invalid or of reduced
quality.

Columns between elements are filled with spaces.

The definition of the attitude angles in this format is different from the Euler angles
definition used elsewhere. The difference appears in the roll angle, where:

A.11 RDI ADCP
The RDI format is a proprietary ASCII text format used when connecting RDI ADCP
equipment.

Format:

$PRDID,pitch,roll,head term

Explanation:

pitch Pitch, degrees on format sddd.dd. s is the sign character, "+" or "-". ddd.dd
is a decimal number with leading zeroes where appropriate. Positive with
bow up.

roll Roll, degrees on format sddd.dd. s is the sign character, "+" or "-". ddd.dd
is a decimal number with leading zeroes where appropriate. Positive with
port side up.
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head Heading, degrees true on format ddd.dd, with leading zeroes where
appropriate.

term CR-LF (2 bytes, values 13 and 10).

A.12 Lehmkuhl gyro repeater format 12
This Lehmkuhl gyro repeater format is used when outputting heading from Seapath
to Lehmkuhl gyro repeaters. The message is similar to the HDT message output in
the standard NMEA format from Seapath. The main differences are lower resolution
and no checksum.

When heading is output to devices that are compliant to the NMEA specification, it is
recommended to use the standard NMEA format and not the Lehmkuhl format.

A.13 1PPS, NMEA ZDA format 13
This 1PPS time tag message is output once per second, approximately 0.5 seconds before
the time pulse. The message format is ASCII text using the ZDA message. The message
contains the UTC time when the message is output. The next time pulse appears at the
first integer second after the time in the message.

Format:

$INZDA,time,day,month,year,,*csum term

Explanation:

time UTC time on format hhmmss.ss where hh is hours (00 - 23), mm is minutes
(00 - 59) and ss.ss is seconds (00.00 - 59.99).

day Day of month (01 - 31).
month Month of year (01 - 12).
year Year on format yyyy.
csum Checksum (exclusive or) of all characters between, but not including, the

preceding $ and *, hexadecimal (00 - FF).
term CR-LF (two bytes, values 13 and 10).

This format is recommended used together with 1PPS signal output on the 1PPS cable
in the sensor unit spider cable. This since the message is output synchronised with
the 1PPS signal and is easier/faster to decode than the standard NMEA output with
a number of NMEA messages included.
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A.14 1PPS, Trimble format 14
This 1PPS time tag message is output once per second, approximately 0.5 seconds before
the time pulse. The message format is fixed length ASCII text. The message contains the
UTC time of the next time pulse.

Format:
Element Columns Format
Header 1 - 3 UTC
Date 5 - 12 yy.mo.da

Time 14 - 21 hh:mm:ss
Fix type 23 digit or '?'
No. of satellites 24 digit or '?'
Term 25 - 26 CR-LF

“yy.mo.da” is year (00 - 99), month of year (01 - 12) and day of month (01 - 31).
“hh:mm:ss” is hours (00 - 23), minutes (00 - 59) and seconds (00 - 59). Fix type is “5”
for 3D fix with accurate time, “?” for no fix (time from receiver clock). No. of satellites
is “1” – “8” for 1 - 8 satellites tracked, “9” for 9 or more satellites tracked, “?” for no
fix (time from receiver clock).
Columns between elements are filled with spaces.

A.15 Atlas fansweep format 16
This Atlas format is a proprietary binary format used for outputting data to Atlas
Fansweep echo sounders. It consists of a fixed-length message using single-byte and
2-byte two-complement integer data elements. For the 2-byte elements, most significant
byte is transmitted first.

Format:
Element Scaling Format Bytes Value
Start byte Integer 1 10 Hex
Roll 214 = 90

degrees
Integer 2

Pitch 214 = 90
degrees

Integer 2

Heave millimetres Integer 2
Status byte Integer 1
Stop byte Integer 1 10 Hex

Roll is positive with port side up. Pitch is positive with bow up. Heave is positive up.
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The definition of the attitude angles in this format is different from the Euler angles
definition used elsewhere. The difference appears in the roll angle, where:

The status byte can have the following values:

Value Interpretation
6 Normal
7 Reduced performance or invalid data

A.16 PFreeHeave
This PFreeHeave® format consists of a fixed-length message using 1-, 2- and 4-byte
signed and unsigned integers. The signed integers are represented as two-complement
numbers. For the multi-byte elements, the most significant byte is transmitted first.
The total number of bytes is 13.

The PFreeHeave output is delayed by a few minutes due to processing. The time fields
contain time of validity for the data.

Format

Element Scaling Format Bytes Value
Header Unsigned 1 AA Hex
Header Unsigned 1 52 Hex

Time, seconds Seconds Integer 4
Time, fraction
of second

0.0001 second 2 0 to 9999

Heave Centimetres Integer 2
Status word Bit-fields 1
Checksum Unsigned 2

Checksum is calculated as a 16-bit Block Cyclic Redundancy Check of all bytes between,
but not including the Header and Checksum fields. The CRC algorithm is described in
a separate section. Time is divided in an integer seconds part and a fractional second
part. The integer seconds part of time is counted from 1970-01-01 UTC time, ignoring
leap seconds.

Heave is positive down. The status field is zero if heave is valid, non-zero if heave
is invalid.
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A.17 Cyclic redundancy check algorithm
The 16-bit Block Cyclic Redundancy Check algorithm used to calculate the checksum in
some formats is described in C and Fortran source code below.

C code

Fortran code
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A.18 RTCM format 80
This protocol is based on the RTCM Standard 10403.2, Differential GNSS services,
version 3 with Amendments 1 and 2. See this standard for a description of the output
properties.

This output protocol is used for outputting raw GNSS data for post processing of the
position. All data are output in the GNSS antenna only and applies for both antennas.
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Appendix B
NMEA TelegramOut options

The contents of some of the available NMEA telegrams may be modified according to
options listed in the configuration. This is for example useful when interfacing to older
equipment.

This table holds a description of the various options.

Telegram out option Description
Output residuals on
Ashtech RRE format
(GRS)

Use this option if you have enabled the GRS sentence
and want the residuals output on the Ashtech RRE format
instead.

Send VHW message after
VTG using ground speed
from VTG

Use this option when a VHW sentence is needed, and
vessel heading and vessel speed relative to the water are
not available. When this option is enabled, an NMEA
VHW sentence is output, using SOG as Speed, and COG
as heading. The VHW sentence is output immediately
after the VTG sentence.

Output empty fields in
NMEA HDT and NMEA
THS messages also for
reduced accuracy

Use this option when you want to set invalid heading
(empty HDT/THS field) when heading status is reduced
(low accuracy).

Use inertial roll, pitch and
heave only

Use this option if you want the output of roll, pitch and
heave to be calculated from IMU measurements only
(no GNSS).

Use time from dataset in
NMEA ZDA message

GNSS systems: Use this option if you want the
timestamp in the NMEA ZDA message to be equal to
timestamp of the GNSS data set and the GGA message.

Disable additional GNS
messages when diffcorr
is used for both GPS and
GLONASS

Use this option if you do not want additional NMEA
messages if differential corrections are used for both
GPS and GLONASS.

Limit correction age to 9.9
sec in GGA

Use this option if your system does not handle correction
ages above 9.9 seconds in the GGA sentence. If this
option is enabled, the correction age will increase and
stop at 9.9 seconds even if the correct correction age is
more than 9.9 seconds.
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Telegram out option Description
Use GNSS solution only For Integrated systems only: Use this option if you want

to output position based on GNSS only (no IMU).
Set GGA quality indicator
to 5 if converged high
precision

Use this option if you want the Quality Indicator in the
NMEA GGA sentence set to 5, when position solution
is converged clock orbit or float filter (XP, G2, Ultra,
Apex etc).

Freeze NMEA position if
invalid

Use this option if you want the position output to use
the last known valid position when the current position
becomes invalid.

Use current GNSS info if
only integrated position is
valid

Integrated systems only: Use this option if you want
to output current HDOP, number of satellites and
corrections age in the GGA message though the GNSS
position is invalid and the integrated position is valid.

Allow more than 12
satellites in GGA message

The NMEA standard limits the number of satellites in
the GGA sentence to 12. Use this option if you want the
GGA sentence to use the actual number of satellites.

Use modified quality
indicator in GGA message

Use this option if you want the quality Indicator in the
NMEA GGA sentence to be replaced by GQI.

Use external attitude for
lever arm compensation

Use this option if you want to use external attitude for
lever arm compensation and velocity decomposition.

Use DQI(0-9) as GGA
quality indicator

DP only: Use this option if you want to use talker DP and
output DQI instead of NMEA Quality Indicator for GGA.

Send each NMEA telegram
in separate UDP datagram

Use this option if TelegramOut is configured to send on
UDP, and you want each NMEA telegram to be sent in
a separate UDP telegram.

Use 2 decimals instead of
1 for velocity in NMEA
VTG and RMC

Use this option if you want the velocity field in NMEA
VTG and NMEA RMC to contain 2 decimals instead
of the default 1.

Stop GGA, GLL, GNS
and RMC output if invalid
position

Use this option if you want the output of the position
telegrams to stop if the position is invalid.
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Appendix C
Installations with junction
box

For more permanent installations the Seapath 130 can be installed by use of junction box
as an alternative to the spider cable. In the below figures is described some alternatives
with part numbers on the necessary cables and junction boxes.

Figure 14 Installation with stand-alone MRU and junction boxes
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Figure 15 Installation with stand-alone MRU with direct cable to Seapath junction box
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Figure 16 Installation by use of junction box and MRU in subsea bottle

The connections within the Seapath 130 junction box is described in the below figures.
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Figure 17 Connections for user side terminals P2 to P9
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Figure 18 Connections for user side terminal P1 of the Sensor Unit cable, M340–21
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Figure 19 Cable wiring schematics for M340–21
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Figure 20 Cable wiring schematics for MRU-E-SP1 used for direct connection of
MRU to junction box M340–22

C.1 MRU–E–JB3 cable wiring to junction
box M340–22
A cable of type M310–62 or similar is used to connect the MRU signal between the
Seapath 130 junction box (M340–22) on P2–MRU and MRU junction box (MRU-E-JB3)
on P2/P3 side.

Table 2 MRU to M340–22 cable wiring

M340–22
P2–MRU
Pin no.

Signal Description MRU
junction box

Pin no.

MRU
connector
Pin no.

1 GND (0 V) Power ground 2(P2 side) B
2 24V_MRU Power + 1 (P2 side) R
3 RX_A Signal sent to MRU 4 (P2 side) T
4 RX_B Signal set to MRU 3 (P2 side) C
5 TX_B Signal sent from MRU 5 (P2 side) S
6 TX_A Signal sent from MRU 6 (P2 side) P
7 LGND Logical ground 24(P2 side) a
8 XIN 1PPS input to MRU 23(P2 side) U
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Appendix D
Portable Hydrographic
System (PHS) installation

Instructions for Seapath 130 installation when included as part of the Portable
Hydrographic System (PHS).

A PHS should be plug and play. This since the system is delivered completely set up.
When turned on all the SW is installed, the Seapath is already configured and everything
should «just work». The system can also be delivered with an over the side pole where
all the offsets are known. All the customer needs to do is to let the system know where
on the vessel (Survey Origin) of the system is located and the vertical axis offset.

This means that the Seapath is delivered already configured for being used as a part of the
PHS system. Dependent on what is stated in the order acknowledgement, the Seapath will
be configured according to part no. M340–SW_2040P-SIS4 or M340–SW_2040P-SIS5.
This includes antenna and MRU offsets as well as serial and Ethernet outputs.

The Portable PU has a proprietary plug for the Seapath and the MRU allowing us to
power the Seapath and the MRU from the processing unit and use the PPU as a central
hub for a single cable interface.
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Figure 21 Seapath 130 as part of the Portable Hydrographic System (PHS)

System components
1 Seapath 130 sensor unit with 1 meter cable with male connector
2 Seapath operator software installed on a PC (not part of the delivery)
3 The EM Portable Processing Unit (PPU)
4 EM2040P transducer head
5 Motion reference unit (MRU) in subsea bottle

Cables
A Cable to the sensor unit, 15 meter length with connector to PPU. Part no. M340–24
B MRU umbilical cable, 6 or 15 meter length with connector to PPU. Part no.

MRU-E-CS10
C Ethernet cable to PC and other users, 5 meter length
D Cable from PPU to the EM2040P transducer head
E Cable for 24 VDC input, 3 meter length
F Cable for DGNSS correction input, 4.5 meter length
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Figure 22 The Portable Processing Unit (PPU) front connections

Cables and connectors
A Transducer cable input
B Seapath 130 Sensor Unit interface cable, part no. M340–24
C Seapath 130 MRU interface cable, part no. MRU-E–CS10
D PU Serial Com ports (COM3 available from Seapath)
E Ground connector
F 18–36 V DC power input socket
G Power on/off button. Correct direct current polarity indicated by green LED
H External data input over Ethernet including attitude velocity
I Hydrographic Work Station input
J Input for DGNSS corrections
K 1PPS input
L Processing Unit display

The Seapath 130 interface cables to the PPU is described in the below figures.
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Figure 23 Wiring schematics for the interface cable (M340–24) between Seapath
and PPU
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Figure 24 Wiring schematics for the interface cable (MRU-E–CS10) between MRU
and PPU
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Figure 25 Wiring schematics for the DGNSS cable (ELD234244–1) between DGNSS
receiver and PPU

Figure 26 Connection diagram for Fugro Seastar 3710 receiver connection to EM
Portable Processing Unit (PPU)
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D.1 Seapath configuration

D.1.1 General
The EM Multibeam system is configured to work in the 157.237.xx.xx IP range. As
everything is connected through the same LAN, and the Seapath HMI needs to reach
the Seapath PU through that same network, the Seapath too needs to be configured to
this range. The below settings should be applied for the Seapath unit to work seamless
with the Portable Processing Unit.

Figure 27 IP configuration

Default gateway configuration (red circle) is important. While irrelevant for the setup,
the Seapath will reset everything upon restart if the Default Gateway is not in the same
IP range.

The DGNSS serial port as well as some generic outputs are always the same regardless
of the version of SIS software package used. The DGNSS serial port is set up to receive
standard RTK over RS232.

Delayed heave set to 100 Hz over UDP port 31102. RTCM v3, IMU raw data and NMEA
P25/P26/P27 are configured to be output, but not logged on file on the Seapath. Enabling
logging in SIS 4 or 5 should be a matter of just pressing the Enable button in SIS.

The DGNSSLink1 supplies the PHS system with RTK corrections. The DGNSS
correction is received on the DGNSS line at baud 9600 and with 1 Hz rate.
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Figure 28 DGNSS input configuration

TelegramOut5 is configured to output raw GNSS data on RTCM format to allow for a lot
of positioning post processing options (PPP and PPK). Generally recommended to log
this output in SIS if you are not using a correctional service to improve your position
and can be logged in SIS.

Figure 29 TelegramOut5 configuration for raw GNSS output

TelegramOut6 is configured to output delayed heave over UDP port 31102 at 100 Hz
rate. The delayed heave can be logged on SIS.

It is important to reference the delayed heave to the sonar head because some post
processing software will struggle to manage the delayed heave in post processing if
this is not done.
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Figure 30 TelegramOut6 configuration for delayed heave

TelegramOut7 is configured to output Seapath installation settings. Logging P2X creates
a new file everytime you change offsets or other installation settings in the Seapath.
Handy for post processing and can be logged in SIS.

Figure 31 TelegramOut7 configuration for output of Seapath installation settings

TelegramOut8 is configured to output raw IMU data. Logging of raw IMU data allows
for post processing of IMU data (smoothing and other) and can be logged in SIS.

150 M340-63/9.0



Appendix D Portable Hydrographic System (PHS) installation

Figure 32 TelegramOut8 configuration for raw IMU data output

D.1.2 Seapath setup for SIS version 4 users
For Seapath 130 deliveres with the configuration option M340–SW_2040P-SIS4, the
Seapath interfaces are configured as shown in the figures below.

Figure 33 Input/Output list

TelegramOut1 supplies the PHS system with attitude velocity corrections. Broadcasted
as Seatex Binary 26 format over Ethernet at 100 Hz.
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Figure 34 TelegramOut1 configuration

TelegramOut3 supplies the PHS system with motion data. Broadcasted as EM 3000
format over the SURVEY serial line at 19200 baud and 100 Hz output rate.

Figure 35 TelegramOut3 configuration

TelegramOut 4 supplies the PHS system with NMEA GGA position input. Broadcasted
as NMEA GGA over Ethernet at 1 Hz rate.
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Figure 36 TelegramOut4 configuration

Remember to set time from positioning system (Active) in SIS4.

D.1.3 Seapath setup for K-Controller (SIS version 5) users
For Seapath 130 deliveries with the configuration option M340–SW_2040P-SIS5, the
Seapath is configured as shown in the figures below. The K-Controller allows reception
of all available data from Seapath over Ethernet and a setup different from that for
SIS4 is therefore required.

Figure 37 Input/Output list

TelegramOut1 supplies the PHS system with motion and attitude velocity data as well as
time and date. Broadcasted as KM Binary format over Ethernet at 100 Hz.
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Figure 38 TelegramOut1 configuration

TelegramOut3 supplies the PHS system with NMEA GGA, HDT, VTG and ZDA data.
Broadcasted over the SURVEY serial line at 9600 baud and with 1 Hz rate.

Figure 39 TelegramOut3 configuration
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Appendix E
Free open source software

Some of the software components in this product are free and open source software
released under the licenses shown below.

Source code for the relevant software components is available from:

Kongsberg Discovery AS

Attn.: Customer support

Pirsenteret

N-7462 Trondheim

Norway

E-mail: support.seatex@kd.kongsberg.com

The application software is proprietary, and no source code is available for it.

E.1 BSD license
Copyright (c) 1983, 1988, 1989, 1990, 1993 The Regents of the University of California.

Copyright (c) 1996, 1997, 1998, 1999, 2003 Theodore Ts'o.

Copyright (c) 1997, 1998, 2001 Kungliga Tekniska Högskolan.

Copyright (c) 1991, 1992 Paul Kranenburg <pk@cs.few.eur.nl>

Copyright (c) 1993 Branko Lankester <branko@hacktic.nl>

Copyright (c) 1993 Ulrich Pegelow <pegelow@moorea.uni-muenster.de>

Copyright (c) 1995, 1996 Michael Elizabeth Chastain <mec@duracef.shout.net>

Copyright (c) 1993, 1994, 1995, 1996 Rick Sladkey <jrs@world.std.com>

Copyright (c) 1998-2001 Wichert Akkerman <wakkerma@deephackmode.org>

Copyright (c) 1995 Nick Simicich (njs@scifi.emi.net)

Copyright (c) 2000-2001 Gunnar Ritter.

Copyright (c) 2004, Jan Kneschke, incremental

Copyright (c) 1997-2010 University of Cambridge
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Copyright (c) 2007-2010, Google Inc.

All Rights Reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the
following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials provided with the distribution.

3. The name of the author may not be used to endorse or promote products derived from this software without
specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER "AS IS" AND ANY EXPRESS OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY,
OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE
GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

E.2 f2c license
Copyright 1990 - 1997 by AT&T, Lucent Technologies and Bellcore.

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is
hereby granted, provided that the above copyright notice appear in all copies and that both that the copyright notice
and this permission notice and warranty disclaimer appear in supporting documentation, and that the names of
AT&T, Bell Laboratories, Lucent or Bellcore or any of their entities not be used in advertising or publicity pertaining
to distribution of the software without specific, written prior permission.

AT&T, Lucent and Bellcore disclaim all warranties with regard to this software, including all implied warranties
of merchantability and fitness. In no event shall AT&T, Lucent or Bellcore be liable for any special, indirect or
consequential damages or any damages whatsoever resulting from loss of use, data or profits, whether in an action of
contract, negligence or other tortious action, arising out of or in connection with the use or performance of this software.

E.3 GCC license
GCC is released under the license shown below in addition to GPL and LGPL.

GCC RUNTIME LIBRARY EXCEPTION

Version 3.1, 31 March 2009

Copyright (C) 2009 Free Software Foundation, Inc. <http://fsf.org/>
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Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.
This GCC Runtime Library Exception ("Exception") is an additional permission under section 7 of the GNU General
Public License, version 3 ("GPLv3"). It applies to a given file (the "Runtime Library") that bears a notice placed
by the copyright holder of the file stating that the file is governed by GPLv3 along with this Exception. When you
use GCC to compile a program, GCC may combine portions of certain GCC header files and runtime libraries with
the compiled program. The purpose of this Exception is to allow compilation of non-GPL (including proprietary)
programs to use, in this way, the header files and runtime libraries covered by this Exception.

0. Definitions.

A file is an "Independent Module" if it either requires the Runtime Library for execution after a Compilation Process,
or makes use of an interface provided by the Runtime Library, but is not otherwise based on the Runtime Library.
"GCC" means a version of the GNU Compiler Collection, with or without modifications, governed by version 3 (or a
specified later version) of the GNU General Public License (GPL) with the option of using any subsequent versions
published by the FSF. "GPL-compatible Software" is software whose conditions of propagation, modification and use
would permit combination with GCC in accord with the license of GCC. "Target Code" refers to output from any
compiler for a real or virtual target processor architecture, in executable form or suitable for input to an assembler,
loader, linker and/or execution phase. Notwithstanding that, Target Code does not include data in any format that is
used as a compiler intermediate representation, or used for producing a compiler intermediate representation. The
"Compilation Process" transforms code entirely represented in non-intermediate languages designed for human-written
code, and/or in Java Virtual Machine byte code, into Target Code. Thus, for example, use of source code generators
and preprocessors need not be considered part of the Compilation Process, since the Compilation Process can be
understood as starting with the output of the generators or preprocessors. A Compilation Process is "Eligible" if it
is done using GCC, alone or with other GPL-compatible software, or if it is done without using any work based on
GCC. For example, using non-GPL-compatible Software to optimize any GCC intermediate representations would not
qualify as an Eligible Compilation Process.

1. Grant of Additional Permission.

You have permission to propagate a work of Target Code formed by combining the Runtime Library with Independent
Modules, even if such propagation would otherwise violate the terms of GPLv3, provided that all Target Code was
generated by Eligible Compilation Processes. You may then convey such a combination under terms of your choice,
consistent with the licensing of the Independent Modules.

2. No Weakening of GCC Copyleft.

The availability of this Exception does not imply any general presumption that third-party software is unaffected
by the copyleft requirements of the license of GCC.

E.4 GNU C library license
The GNU C library is released under the licenses shown below in addition to GPL and LGPL.

This file contains the copying permission notices for various files in the GNU C Library distribution that have
copyright owners other than the Free Software Foundation. These notices all require that a copy of the notice be
included in the accompanying documentation and be distributed with binary distributions of the code, so be sure to
include this file along with any binary distributions derived from the GNU C Library.

All code incorporated from 4.4 BSD is distributed under the following license:
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Copyright (C) 1991 Regents of the University of California. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the
following conditions are met: 1. Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer. 2. Redistributions in binary form must reproduce the above copyright notice,
this list of conditions and the following disclaimer in the documentation and/or other materials provided with the
distribution. 3. [This condition was removed.] 4. Neither the name of the University nor the names of its contributors
may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS ``AS IS'' AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

The DNS resolver code, taken from BIND 4.9.5, is copyrighted both by UC Berkeley and by Digital Equipment
Corporation. The DEC portions are under the following license: Portions Copyright (C) 1993 by Digital Equipment
Corporation. Permission to use, copy, modify, and distribute this software for any purpose with or without fee is
hereby granted, provided that the above copyright notice and this permission notice appear in all copies, and that
the name of Digital Equipment Corporation not be used in advertising or publicity pertaining to distribution of the
document or software without specific, written prior permission.

THE SOFTWARE IS PROVIDED ``AS IS'' AND DIGITAL EQUIPMENT CORP. DISCLAIMS ALLWARRANTIES
WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS. IN NO EVENT SHALL DIGITAL EQUIPMENT CORPORATION BE LIABLE FOR ANY
SPECIAL, DIRECT, INDIRECT, OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER
RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT,
NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTIONWITH THE USE OR
PERFORMANCE OF THIS SOFTWARE.

The Sun RPC support (from rpcsrc-4.0) is covered by the following license: Copyright (C) 1984, Sun Microsystems,
Inc. Sun RPC is a product of Sun Microsystems, Inc. and is provided for unrestricted use provided that this legend is
included on all tape media and as a part of the software program in whole or part. Users may copy or modify Sun
RPC without charge, but are not authorized to license or distribute it to anyone else except as part of a product or
program developed by the user.

SUN RPC IS PROVIDED AS IS WITH NO WARRANTIES OF ANY KIND INCLUDING THE WARRANTIES
OF DESIGN, MERCHANTIBILITY AND FITNESS FOR A PARTICULAR PURPOSE, OR ARISING FROM A
COURSE OF DEALING, USAGE OR TRADE PRACTICE.

Sun RPC is provided with no support and without any obligation on the part of Sun Microsystems, Inc. to assist in its
use, correction, modification or enhancement.

SUN MICROSYSTEMS, INC. SHALL HAVE NO LIABILITY WITH RESPECT TO THE INFRINGEMENT OF
COPYRIGHTS, TRADE SECRETS OR ANY PATENTS BY SUN RPC OR ANY PART THEREOF.
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In no event will Sun Microsystems, Inc. be liable for any lost revenue or profits or other special, indirect and
consequential damages, even if Sun has been advised of the possibility of such damages. The following CMU
license covers some of the support code for Mach, derived from Mach 3.0: Mach Operating System Copyright (C)
1991,1990,1989 Carnegie Mellon University All Rights Reserved. Permission to use, copy, modify and distribute
this software and its documentation is hereby granted, provided that both the copyright notice and this permission
notice appear in all copies of the software, derivative works or modified versions, and any portions thereof, and
that both notices appear in supporting documentation.

CARNEGIE MELLON ALLOWS FREE USE OF THIS SOFTWARE IN ITS ``AS IS'' CONDITION. CARNEGIE
MELLON DISCLAIMS ANY LIABILITY OF ANY KIND FOR ANY DAMAGES WHATSOEVER RESULTING
FROM THE USE OF THIS SOFTWARE.

Carnegie Mellon requests users of this software to return to: Software Distribution Coordinator School of Computer
Science Carnegie Mellon University Pittsburgh PA 15213-3890 or Software. Distribution@CS.CMU.EDU any
improvements or extensions that they make and grant Carnegie Mellon the rights to redistribute these changes.

The file if_ppp.h is under the following CMU license: Redistribution and use in source and binary forms, with or
without modification, are permitted provided that the following conditions are met: 1. Redistributions of source code
must retain the above copyright notice, this list of conditions and the following disclaimer. 2. Redistributions in
binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution. 3. Neither the name of the University nor the
names of its contributors may be used to endorse or promote products derived from this software without specific
prior written permission.

THIS SOFTWARE IS PROVIDED BY CARNEGIE MELLON UNIVERSITY AND CONTRIBUTORS ``AS IS''
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.
IN NO EVENT SHALL THE UNIVERSITY OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE.

The following license covers the files from Intel's "Highly Optimized Mathematical Functions for Itanium" collection:
Intel License Agreement Copyright (c) 2000, Intel Corporation All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the
following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials provided with the distribution.

* The name of Intel Corporation may not be used to endorse or promote products derived from this software without
specific prior written permission.
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THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL INTEL OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT
OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT
OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The files inet/getnameinfo.c and sysdeps/posix/getaddrinfo.c are copyright (C) by Craig Metz and are distributed
under the following license: /* The Inner Net License, Version 2.00 The author(s) grant permission for redistribution
and use in source and binary forms, with or without modification, of the software and documentation provided that
the following conditions are met: 0. If you receive a version of the software that is specifically labelled as not
being for redistribution (check the version message and/or README), you are not permitted to redistribute that
version of the software in any way or form. 1. All terms of the all other applicable copyrights and licenses must be
followed. 2. Redistributions of source code must retain the authors' copyright notice(s), this list of conditions, and the
following disclaimer. 3. Redistributions in binary form must reproduce the authors' copyright notice(s), this list of
conditions, and the following disclaimer in the documentation and/or other materials provided with the distribution.
4. [The copyright holder has authorized the removal of this clause.] 5. Neither the name(s) of the author(s) nor the
names of its contributors may be used to endorse or promote products derived from this software without specific
prior written permission.

THIS SOFTWARE IS PROVIDED BY ITS AUTHORS AND CONTRIBUTORS ``AS IS'' AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE AUTHORS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

If these license terms cause you a real problem, contact the author. */

E.5 GNU general public license, version 2
GNU GENERAL PUBLIC LICENSE

Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc.,

51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

Preamble
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The licenses for most software are designed to take away your freedom to share and change it. By contrast, the GNU
General Public License is intended to guarantee your freedom to share and change free software–to make sure the
software is free for all its users. This General Public License applies to most of the Free Software Foundation's
software and to any other program whose authors commit to using it. (Some other Free Software Foundation software
is covered by the GNU Lesser General Public License instead.) You can apply it to your programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed to
make sure that you have the freedom to distribute copies of free software (and charge for this service if you wish), that
you receive source code or can get it if you want it, that you can change the software or use pieces of it in new free
programs; and that you know you can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask you
to surrender the rights. These restrictions translate to certain responsibilities for you if you distribute copies of
the software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must give the recipients all
the rights that you have. You must make sure that they, too, receive or can get the source code. And you must show
them these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which gives you legal
permission to copy, distribute and/or modify the software.

Also, for each author's protection and ours, we want to make certain that everyone understands that there is no
warranty for this free software. If the software is modified by someone else and passed on, we want its recipients
to know that what they have is not the original, so that any problems introduced by others will not reflect on the
original authors' reputations.

Finally, any free program is threatened constantly by software patents. We wish to avoid the danger that redistributors
of a free program will individually obtain patent licenses, in effect making the program proprietary. To prevent this,
we have made it clear that any patent must be licensed for everyone's free use or not licensed at all.

The precise terms and conditions for copying, distribution and modification follow.

GNU GENERAL PUBLIC LICENSE

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License applies to any program or other work which contains a notice placed by the copyright holder saying it
may be distributed under the terms of this General Public License. The "Program", below, refers to any such program
or work, and a "work based on the Program" means either the Program or any derivative work under copyright law:
that is to say, a work containing the Program or a portion of it, either verbatim or with modifications and/or translated
into another language. (Hereinafter, translation is included without limitation in the term "modification".) Each
licensee is addressed as "you".

Activities other than copying, distribution and modification are not covered by this License; they are outside its scope.
The act of running the Program is not restricted, and the output from the Program is covered only if its contents
constitute a work based on the Program (independent of having been made by running the Program). Whether that is
true depends on what the Program does.

1. You may copy and distribute verbatim copies of the Program's source code as you receive it, in any medium,
provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice and
disclaimer of warranty; keep intact all the notices that refer to this License and to the absence of any warranty; and
give any other recipients of the Program a copy of this License along with the Program.
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You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty protection
in exchange for a fee.

2. You may modify your copy or copies of the Program or any portion of it, thus forming a work based on the
Program, and copy and distribute such modifications or work under the terms of Section 1 above, provided that you
also meet all of these conditions:

You must cause the modified files to carry prominent notices stating that you changed the files and the date of any
change.

You must cause any work that you distribute or publish, that in whole or in part contains or is derived from the
Program or any part thereof, to be licensed as a whole at no charge to all third parties under the terms of this License.

If the modified program normally reads commands interactively when run, you must cause it, when started running
for such interactive use in the most ordinary way, to print or display an announcement including an appropriate
copyright notice and a notice that there is no warranty (or else, saying that you provide a warranty) and that users may
redistribute the program under these conditions, and telling the user how to view a copy of this License. (Exception: if
the Program itself is interactive but does not normally print such an announcement, your work based on the Program
is not required to print an announcement.)

These requirements apply to the modified work as a whole. If identifiable sections of that work are not derived from
the Program, and can be reasonably considered independent and separate works in themselves, then this License,
and its terms, do not apply to those sections when you distribute them as separate works. But when you distribute
the same sections as part of a whole which is a work based on the Program, the distribution of the whole must be
on the terms of this License, whose permissions for other licensees extend to the entire whole, and thus to each and
every part regardless of who wrote it. Thus, it is not the intent of this section to claim rights or contest your rights
to work written entirely by you; rather, the intent is to exercise the right to control the distribution of derivative or
collective works based on the Program. In addition, mere aggregation of another work not based on the Program
with the Program (or with a work based on the Program) on a volume of a storage or distribution medium does not
bring the other work under the scope of this License.

3. You may copy and distribute the Program (or a work based on it, under Section 2) in object code or executable form
under the terms of Sections 1 and 2 above provided that you also do one of the following:

Accompany it with the complete corresponding machine-readable source code, which must be distributed under the
terms of Sections 1 and 2 above on a medium customarily used for software interchange; or,

Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no more than
your cost of physically performing source distribution, a complete machine-readable copy of the corresponding
source code, to be distributed under the terms of Sections 1 and 2 above on a medium customarily used for software
interchange; or, Accompany it with the information you received as to the offer to distribute corresponding source
code. (This alternative is allowed only for noncommercial distribution and only if you received the program in object
code or executable form with such an offer, in accord with Subsection b above.)

The source code for a work means the preferred form of the work for making modifications to it. For an executable
work, complete source code means all the source code for all modules it contains, plus any associated interface
definition files, plus the scripts used to control compilation and installation of the executable. However, as a special
exception, the source code distributed need not include anything that is normally distributed (in either source or binary
form) with the major components (compiler, kernel, and so on) of the operating system on which the executable
runs, unless that component itself accompanies the executable. If distribution of executable or object code is made
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by offering access to copy from a designated place, then offering equivalent access to copy the source code from
the same place counts as distribution of the source code, even though third parties are not compelled to copy the
source along with the object code.

4. You may not copy, modify, sublicense, or distribute the Program except as expressly provided under this License.
Any attempt otherwise to copy, modify, sublicense or distribute the Program is void, and will automatically terminate
your rights under this License. However, parties who have received copies, or rights, from you under this License will
not have their licenses terminated so long as such parties remain in full compliance.

5. You are not required to accept this License, since you have not signed it. However, nothing else grants you
permission to modify or distribute the Program or its derivative works. These actions are prohibited by law if you do
not accept this License. Therefore, by modifying or distributing the Program (or any work based on the Program),
you indicate your acceptance of this License to do so, and all its terms and conditions for copying, distributing or
modifying the Program or works based on it.

6. Each time you redistribute the Program (or any work based on the Program), the recipient automatically receives a
license from the original licensor to copy, distribute or modify the Program subject to these terms and conditions. You
may not impose any further restrictions on the recipients' exercise of the rights granted herein. You are not responsible
for enforcing compliance by third parties to this License.

7. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not limited to
patent issues), conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the
conditions of this License, they do not excuse you from the conditions of this License. If you cannot distribute so as to
satisfy simultaneously your obligations under this License and any other pertinent obligations, then as a consequence
you may not distribute the Program at all. For example, if a patent license would not permit royalty-free redistribution
of the Program by all those who receive copies directly or indirectly through you, then the only way you could satisfy
both it and this License would be to refrain entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance of the
section is intended to apply and the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right claims or to contest
validity of any such claims; this section has the sole purpose of protecting the integrity of the free software distribution
system, which is implemented by public license practices. Many people have made generous contributions to the
wide range of software distributed through that system in reliance on consistent application of that system; it is up
to the author/donor to decide if he or she is willing to distribute software through any other system and a licensee
cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this License.

8. If the distribution and/or use of the Program is restricted in certain countries either by patents or by copyrighted
interfaces, the original copyright holder who places the Program under this License may add an explicit geographical
distribution limitation excluding those countries, so that distribution is permitted only in or among countries not thus
excluded. In such case, this License incorporates the limitation as if written in the body of this License.

9. The Free Software Foundation may publish revised and/or new versions of the General Public License from
time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address
new problems or concerns.
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Each version is given a distinguishing version number. If the Program specifies a version number of this License
which applies to it and "any later version", you have the option of following the terms and conditions either of that
version or of any later version published by the Free Software Foundation. If the Program does not specify a version
number of this License, you may choose any version ever published by the Free Software Foundation.

10. If you wish to incorporate parts of the Program into other free programs whose distribution conditions are different,
write to the author to ask for permission. For software which is copyrighted by the Free Software Foundation, write
to the Free Software Foundation; we sometimes make exceptions for this. Our decision will be guided by the two
goals of preserving the free status of all derivatives of our free software and of promoting the sharing and reuse of
software generally.

NO WARRANTY

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE
PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED
IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS
IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH
YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY
SERVICING, REPAIR OR CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY
COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE
PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL,
SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO
USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED
INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM
TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS

How to Apply These Terms to Your New Programs

If you develop a new program, and you want it to be of the greatest possible use to the public, the best way to achieve
this is to make it free software which everyone can redistribute and change under these terms.

To do so, attach the following notices to the program. It is safest to attach them to the start of each source file
to most effectively convey the exclusion of warranty; and each file should have at least the "copyright" line and a
pointer to where the full notice is found.

<one line to give the program's name and an idea of what it does>

Copyright ©<year> <name of author>

This program is free software; you can redistribute it and/or modify it under the terms of the GNU General Public
License as published by the Free Software Foundation; either version 2 of the License, or (at your option) any
later version.

This program is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even the
implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU General
Public License for more details.
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You should have received a copy of the GNU General Public License along with this program; if not, write to the Free
Software Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA.

Also add information on how to contact you by electronic and paper mail.

If the program is interactive, make it output a short notice like this when it starts in an interactive mode:

Gnomovision version 69, Copyright (C) year name of author

Gnomovision comes with ABSOLUTELY NO WARRANTY; for details type `show w'. This is free software, and you
are welcome to redistribute it under certain conditions; type `show c' for details.

The hypothetical commands `show w' and `show c' should show the appropriate parts of the General Public License.
Of course, the commands you use may be called something other than `show w' and `show c'; they could even be
mouse-clicks or menu items–whatever suits your program.

You should also get your employer (if you work as a programmer) or your school, if any, to sign a "copyright
disclaimer" for the program, if necessary. Here is a sample; alter the names:

Yoyodyne, Inc., hereby disclaims all copyright interest in the program `Gnomovision' (which makes passes at
compilers) written by James Hacker.

<signature orf TyCoon> 1 April 1989 Ty Coon, President of Vice

This General Public License does not permit incorporating your program into proprietary programs. If your program is
a subroutine library, you may consider it more useful to permit linking proprietary applications with the library. If this
is what you want to do, use the GNU Lesser General Public License instead of this License.

E.6 GNU general public license, version 3
GNU GENERAL PUBLIC LICENSE

Version 3, 29 June 2007

Copyright (C) 2007 Free Software Foundation, Inc. <http://fsf.org/>

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

Preamble

The GNU General Public License is a free, copyleft license for software and other kinds of works.

The licenses for most software and other practical works are designed to take away your freedom to share and change
the works. By contrast, the GNU General Public License is intended to guarantee your freedom to share and change
all versions of a program–to make sure it remains free software for all its users. We, the Free Software Foundation,
use the GNU General Public License for most of our software; it applies also to any other work released this way by
its authors. You can apply it to your programs, too. When we speak of free software, we are referring to freedom,
not price. Our General Public Licenses are designed to make sure that you have the freedom to distribute copies of
free software (and charge for them if you wish), that you receive source code or can get it if you want it, that you
can change the software or use pieces of it in new free programs, and that you know you can do these things. To
protect your rights, we need to prevent others from denying you these rights or asking you to surrender the rights.
Therefore, you have certain responsibilities if you distribute copies of the software, or if you modify it: responsibilities
to respect the freedom of others. For example, if you distribute copies of such a program, whether gratis or for a fee,
you must pass on to the recipients the same freedoms that you received. You must make sure that they, too, receive or
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can get the source code. And you must show them these terms so they know their rights. Developers that use the
GNU GPL protect your rights with two steps: (1) assert copyright on the software, and (2) offer you this License
giving you legal permission to copy, distribute and/or modify it. For the developers' and authors' protection, the GPL
clearly explains that there is no warranty for this free software. For both users' and authors' sake, the GPL requires
that modified versions be marked as changed, so that their problems will not be attributed erroneously to authors of
previous versions. Some devices are designed to deny users access to install or run modified versions of the software
inside them, although the manufacturer can do so. This is fundamentally incompatible with the aim of protecting users'
freedom to change the software. The systematic pattern of such abuse occurs in the area of products for individuals to
use, which is precisely where it is most unacceptable. Therefore, we have designed this version of the GPL to prohibit
the practice for those products. If such problems arise substantially in other domains, we stand ready to extend this
provision to those domains in future versions of the GPL, as needed to protect the freedom of users. Finally, every
program is threatened constantly by software patents. States should not allow patents to restrict development and use
of software on general-purpose computers, but in those that do, we wish to avoid the special danger that patents applied
to a free program could make it effectively proprietary. To prevent this, the GPL assures that patents cannot be used to
render the program non-free. The precise terms and conditions for copying, distribution and modification follow.

TERMS AND CONDITIONS

0. Definitions.

"This License" refers to version 3 of the GNU General Public License. "Copyright" also means copyright-like laws
that apply to other kinds of works, such as semiconductor masks. "The Program" refers to any copyrightable work
licensed under this License. Each licensee is addressed as "you". "Licensees" and "recipients" may be individuals or
organizations. To "modify" a work means to copy from or adapt all or part of the work in a fashion requiring copyright
permission, other than the making of an exact copy. The resulting work is called a "modified version" of the earlier
work or a work "based on" the earlier work. A "covered work" means either the unmodified Program or a work based
on the Program. To "propagate" a work means to do anything with it that, without permission, would make you
directly or secondarily liable for infringement under applicable copyright law, except executing it on a computer or
modifying a private copy. Propagation includes copying, distribution (with or without modification), making available
to the public, and in some countries other activities as well. To "convey" a work means any kind of propagation that
enables other parties to make or receive copies. Mere interaction with a user through a computer network, with no
transfer of a copy, is not conveying. An interactive user interface displays "Appropriate Legal Notices" to the extent
that it includes a convenient and prominently visible feature that (1) displays an appropriate copyright notice, and (2)
tells the user that there is no warranty for the work (except to the extent that warranties are provided), that licensees
may convey the work under this License, and how to view a copy of this License. If the interface presents a list of user
commands or options, such as a menu, a prominent item in the list meets this criterion.

1. Source Code.

The "source code" for a work means the preferred form of the work for making modifications to it. "Object code"
means any non-source form of a work. A "Standard Interface" means an interface that either is an official standard
defined by a recognized standards body, or, in the case of interfaces specified for a particular programming language,
one that is widely used among developers working in that language. The "System Libraries" of an executable work
include anything, other than the work as a whole, that (a) is included in the normal form of packaging a Major
Component, but which is not part of that Major Component, and (b) serves only to enable use of the work with that
Major Component, or to implement a Standard Interface for which an implementation is available to the public in
source code form. A "Major Component", in this context, means a major essential component (kernel, window
system, and so on) of the specific operating system (if any) on which the executable work runs, or a compiler used
to produce the work, or an object code interpreter used to run it. The "Corresponding Source" for a work in object
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code form means all the source code needed to generate, install, and (for an executable work) run the object code
and to modify the work, including scripts to control those activities. However, it does not include the work's System
Libraries, or general-purpose tools or generally available free programs which are used unmodified in performing
those activities but which are not part of the work. For example, Corresponding Source includes interface definition
files associated with source files for the work, and the source code for shared libraries and dynamically linked
subprograms that the work is specifically designed to require, such as by intimate data communication or control flow
between those subprograms and other parts of the work. The Corresponding Source need not include anything that
users can regenerate automatically from other parts of the Corresponding Source. The Corresponding Source for a
work in source code form is that same work.

2. Basic Permissions.

All rights granted under this License are granted for the term of copyright on the Program, and are irrevocable provided
the stated conditions are met. This License explicitly affirms your unlimited permission to run the unmodified
Program. The output from running a covered work is covered by this License only if the output, given its content,
constitutes a covered work. This License acknowledges your rights of fair use or other equivalent, as provided by
copyright law. You may make, run and propagate covered works that you do not convey, without conditions so long as
your license otherwise remains in force. You may convey covered works to others for the sole purpose of having them
make modifications exclusively for you, or provide you with facilities for running those works, provided that you
comply with the terms of this License in conveying all material for which you do not control copyright. Those thus
making or running the covered works for you must do so exclusively on your behalf, under your direction and control,
on terms that prohibit them from making any copies of your copyrighted material outside their relationship with you.
Conveying under any other circumstances is permitted solely under the conditions stated below. Sublicensing is not
allowed; section 10 makes it unnecessary.

3. Protecting Users' Legal Rights From Anti-Circumvention Law.

No covered work shall be deemed part of an effective technological measure under any applicable law fulfilling
obligations under article 11 of the WIPO copyright treaty adopted on 20 December 1996, or similar laws prohibiting or
restricting circumvention of such measures. When you convey a covered work, you waive any legal power to forbid
circumvention of technological measures to the extent such circumvention is effected by exercising rights under this
License with respect to the covered work, and you disclaim any intention to limit operation or modification of the
work as a means of enforcing, against the work's users, your or third parties' legal rights to forbid circumvention of
technological measures.

4. Conveying Verbatim Copies.

You may convey verbatim copies of the Program's source code as you receive it, in any medium, provided that you
conspicuously and appropriately publish on each copy an appropriate copyright notice; keep intact all notices stating
that this License and any non-permissive terms added in accord with section 7 apply to the code; keep intact all notices
of the absence of any warranty; and give all recipients a copy of this License along with the Program. You may charge
any price or no price for each copy that you convey, and you may offer support or warranty protection for a fee.

5. Conveying Modified Source Versions.

You may convey a work based on the Program, or the modifications to produce it from the Program, in the form of
source code under the terms of section 4, provided that you also meet all of these conditions: a) The work must carry
prominent notices stating that you modified it, and giving a relevant date. b) The work must carry prominent notices
stating that it is released under this License and any conditions added under section 7. This requirement modifies the
requirement in section 4 to "keep intact all notices". c) You must license the entire work, as a whole, under this License
to anyone who comes into possession of a copy. This License will therefore apply, along with any applicable section 7
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additional terms, to the whole of the work, and all its parts, regardless of how they are packaged. This License gives
no permission to license the work in any other way, but it does not invalidate such permission if you have separately
received it. d) If the work has interactive user interfaces, each must display Appropriate Legal Notices; however, if the
Program has interactive interfaces that do not display Appropriate Legal Notices, your work need not make them
do so. A compilation of a covered work with other separate and independent works, which are not by their nature
extensions of the covered work, and which are not combined with it such as to form a larger program, in or on a
volume of a storage or distribution medium, is called an "aggregate" if the compilation and its resulting copyright
are not used to limit the access or legal rights of the compilation's users beyond what the individual works permit.
Inclusion of a covered work in an aggregate does not cause this License to apply to the other parts of the aggregate.

6. Conveying Non-Source Forms.

You may convey a covered work in object code form under the terms of sections 4 and 5, provided that you also
convey the machine-readable Corresponding Source under the terms of this License, in one of these ways: a) Convey
the object code in, or embodied in, a physical product (including a physical distribution medium), accompanied by the
Corresponding Source fixed on a durable physical medium customarily used for software interchange. b) Convey
the object code in, or embodied in, a physical product (including a physical distribution medium), accompanied by
a written offer, valid for at least three years and valid for as long as you offer spare parts or customer support for
that product model, to give anyone who possesses the object code either (1) a copy of the Corresponding Source for
all the software in the product that is covered by this License, on a durable physical medium customarily used for
software interchange, for a price no more than your reasonable cost of physically performing this conveying of source,
or (2) access to copy the Corresponding Source from a network server at no charge. c) Convey individual copies of
the object code with a copy of the written offer to provide the Corresponding Source. This alternative is allowed
only occasionally and noncommercially, and only if you received the object code with such an offer, in accord with
subsection 6b. d) Convey the object code by offering access from a designated place (gratis or for a charge), and offer
equivalent access to the Corresponding Source in the same way through the same place at no further charge. You
need not require recipients to copy the Corresponding Source along with the object code. If the place to copy the
object code is a network server, the Corresponding Source may be on a different server (operated by you or a third
party) that supports equivalent copying facilities, provided you maintain clear directions next to the object code saying
where to find the Corresponding Source. Regardless of what server hosts the Corresponding Source, you remain
obligated to ensure that it is available for as long as needed to satisfy these requirements. e) Convey the object code
using peer-to-peer transmission, provided you inform other peers where the object code and Corresponding Source of
the work are being offered to the general public at no charge under subsection 6d. A separable portion of the object
code, whose source code is excluded from the Corresponding Source as a System Library, need not be included in
conveying the object code work. A "User Product" is either (1) a "consumer product", which means any tangible
personal property which is normally used for personal, family, or household purposes, or (2) anything designed or
sold for incorporation into a dwelling. In determining whether a product is a consumer product, doubtful cases shall
be resolved in favor of coverage. For a particular product received by a particular user, "normally used" refers to a
typical or common use of that class of product, regardless of the status of the particular user or of the way in which the
particular user actually uses, or expects or is expected to use, the product. A product is a consumer product regardless
of whether the product has substantial commercial, industrial or non-consumer uses, unless such uses represent the
only significant mode of use of the product. "Installation Information" for a User Product means any methods,
procedures, authorization keys, or other information required to install and execute modified versions of a covered
work in that User Product from a modified version of its Corresponding Source. The information must suffice to
ensure that the continued functioning of the modified object code is in no case prevented or interfered with solely
because modification has been made. If you convey an object code work under this section in, or with, or specifically
for use in, a User Product, and the conveying occurs as part of a transaction in which the right of possession and use of
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the User Product is transferred to the recipient in perpetuity or for a fixed term (regardless of how the transaction
is characterized), the Corresponding Source conveyed under this section must be accompanied by the Installation
Information. But this requirement does not apply if neither you nor any third party retains the ability to install
modified object code on the User Product (for example, the work has been installed in ROM). The requirement to
provide Installation Information does not include a requirement to continue to provide support service, warranty, or
updates for a work that has been modified or installed by the recipient, or for the User Product in which it has been
modified or installed. Access to a network may be denied when the modification itself materially and adversely affects
the operation of the network or violates the rules and protocols for communication across the network. Corresponding
Source conveyed, and Installation Information provided, in accord with this section must be in a format that is publicly
documented (and with an implementation available to the public in source code form), and must require no special
password or key for unpacking, reading or copying.

7. Additional Terms.

"Additional permissions" are terms that supplement the terms of this License by making exceptions from one or
more of its conditions. Additional permissions that are applicable to the entire Program shall be treated as though
they were included in this License, to the extent that they are valid under applicable law. If additional permissions
apply only to part of the Program, that part may be used separately under those permissions, but the entire Program
remains governed by this License without regard to the additional permissions. When you convey a copy of a covered
work, you may at your option remove any additional permissions from that copy, or from any part of it. (Additional
permissions may be written to require their own removal in certain cases when you modify the work.) You may place
additional permissions on material, added by you to a covered work, for which you have or can give appropriate
copyright permission. Notwithstanding any other provision of this License, for material you add to a covered work,
you may (if authorized by the copyright holders of that material) supplement the terms of this License with terms:
a) Disclaiming warranty or limiting liability differently from the terms of sections 15 and 16 of this License; or b)
Requiring preservation of specified reasonable legal notices or author attributions in that material or in the Appropriate
Legal Notices displayed by works containing it; or c) Prohibiting misrepresentation of the origin of that material,
or requiring that modified versions of such material be marked in reasonable ways as different from the original
version; or d) Limiting the use for publicity purposes of names of licensors or authors of the material; or e) Declining
to grant rights under trademark law for use of some trade names, trademarks, or service marks; or f) Requiring
indemnification of licensors and authors of that material by anyone who conveys the material (or modified versions of
it) with contractual assumptions of liability to the recipient, for any liability that these contractual assumptions directly
impose on those licensors and authors. All other non-permissive additional terms are considered "further restrictions"
within the meaning of section 10. If the Program as you received it, or any part of it, contains a notice stating that
it is governed by this License along with a term that is a further restriction, you may remove that term. If a license
document contains a further restriction but permits relicensing or conveying under this License, you may add to a
covered work material governed by the terms of that license document, provided that the further restriction does not
survive such relicensing or conveying. If you add terms to a covered work in accord with this section, you must place,
in the relevant source files, a statement of the additional terms that apply to those files, or a notice indicating where to
find the applicable terms. Additional terms, permissive or non-permissive, may be stated in the form of a separately
written license, or stated as exceptions; the above requirements apply either way.

8. Termination.

You may not propagate or modify a covered work except as expressly provided under this License. Any attempt
otherwise to propagate or modify it is void, and will automatically terminate your rights under this License (including
any patent licenses granted under the third paragraph of section 11). However, if you cease all violation of this
License, then your license from a particular copyright holder is reinstated (a) provisionally, unless and until the
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copyright holder explicitly and finally terminates your license, and (b) permanently, if the copyright holder fails to
notify you of the violation by some reasonable means prior to 60 days after the cessation. Moreover, your license from
a particular copyright holder is reinstated permanently if the copyright holder notifies you of the violation by some
reasonable means, this is the first time you have received notice of violation of this License (for any work) from that
copyright holder, and you cure the violation prior to 30 days after your receipt of the notice. Termination of your
rights under this section does not terminate the licenses of parties who have received copies or rights from you under
this License. If your rights have been terminated and not permanently reinstated, you do not qualify to receive
new licenses for the same material under section 10.

9. Acceptance Not Required for Having Copies.

You are not required to accept this License in order to receive or run a copy of the Program. Ancillary propagation
of a covered work occurring solely as a consequence of using peer-to-peer transmission to receive a copy likewise
does not require acceptance. However, nothing other than this License grants you permission to propagate or modify
any covered work. These actions infringe copyright if you do not accept this License. Therefore, by modifying or
propagating a covered work, you indicate your acceptance of this License to do so.

10. Automatic Licensing of Downstream Recipients.

Each time you convey a covered work, the recipient automatically receives a license from the original licensors, to
run, modify and propagate that work, subject to this License. You are not responsible for enforcing compliance by
third parties with this License. An "entity transaction" is a transaction transferring control of an organization, or
substantially all assets of one, or subdividing an organization, or merging organizations. If propagation of a covered
work results from an entity transaction, each party to that transaction who receives a copy of the work also receives
whatever licenses to the work the party's predecessor in interest had or could give under the previous paragraph, plus
a right to possession of the Corresponding Source of the work from the predecessor in interest, if the predecessor
has it or can get it with reasonable efforts. You may not impose any further restrictions on the exercise of the rights
granted or affirmed under this License. For example, you may not impose a license fee, royalty, or other charge
for exercise of rights granted under this License, and you may not initiate litigation (including a cross-claim or
counterclaim in a lawsuit) alleging that any patent claim is infringed by making, using, selling, offering for sale, or
importing the Program or any portion of it.

11. Patents.

A "contributor" is a copyright holder who authorizes use under this License of the Program or a work on which the
Program is based. The work thus licensed is called the contributor's "contributor version". A contributor's "essential
patent claims" are all patent claims owned or controlled by the contributor, whether already acquired or hereafter
acquired, that would be infringed by some manner, permitted by this License, of making, using, or selling its
contributor version, but do not include claims that would be infringed only as a consequence of further modification of
the contributor version. For purposes of this definition, "control" includes the right to grant patent sublicenses in a
manner consistent with the requirements of this License. Each contributor grants you a non-exclusive, worldwide,
royalty-free patent license under the contributor's essential patent claims, to make, use, sell, offer for sale, import
and otherwise run, modify and propagate the contents of its contributor version. In the following three paragraphs, a
"patent license" is any express agreement or commitment, however denominated, not to enforce a patent (such as an
express permission to practice a patent or covenant not to sue for patent infringement). To "grant" such a patent license
to a party means to make such an agreement or commitment not to enforce a patent against the party. If you convey a
covered work, knowingly relying on a patent license, and the Corresponding Source of the work is not available for
anyone to copy, free of charge and under the terms of this License, through a publicly available network server or other
readily accessible means, then you must either (1) cause the Corresponding Source to be so available, or (2) arrange to
deprive yourself of the benefit of the patent license for this particular work, or (3) arrange, in a manner consistent with
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the requirements of this License, to extend the patent license to downstream recipients. "Knowingly relying" means
you have actual knowledge that, but for the patent license, your conveying the covered work in a country, or your
recipient's use of the covered work in a country, would infringe one or more identifiable patents in that country that
you have reason to believe are valid. If, pursuant to or in connection with a single transaction or arrangement, you
convey, or propagate by procuring conveyance of, a covered work, and grant a patent license to some of the parties
receiving the covered work authorizing them to use, propagate, modify or convey a specific copy of the covered work,
then the patent license you grant is automatically extended to all recipients of the covered work and works based on it.
A patent license is "discriminatory" if it does not include within the scope of its coverage, prohibits the exercise of,
or is conditioned on the non-exercise of one or more of the rights that are specifically granted under this License.
You may not convey a covered work if you are a party to an arrangement with a third party that is in the business
of distributing software, under which you make payment to the third party based on the extent of your activity of
conveying the work, and under which the third party grants, to any of the parties who would receive the covered work
from you, a discriminatory patent license (a) in connection with copies of the covered work conveyed by you (or
copies made from those copies), or (b) primarily for and in connection with specific products or compilations that
contain the covered work, unless you entered into that arrangement, or that patent license was granted, prior to 28
March 2007. Nothing in this License shall be construed as excluding or limiting any implied license or other defenses
to infringement that may otherwise be available to you under applicable patent law.

12. No Surrender of Others' Freedom.

If conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of
this License, they do not excuse you from the conditions of this License. If you cannot convey a covered work so as to
satisfy simultaneously your obligations under this License and any other pertinent obligations, then as a consequence
you may not convey it at all. For example, if you agree to terms that obligate you to collect a royalty for further
conveying from those to whom you convey the Program, the only way you could satisfy both those terms and this
License would be to refrain entirely from conveying the Program.

13. Use with the GNU Affero General Public License.

Notwithstanding any other provision of this License, you have permission to link or combine any covered work
with a work licensed under version 3 of the GNU Affero General Public License into a single combined work, and
to convey the resulting work. The terms of this License will continue to apply to the part which is the covered
work, but the special requirements of the GNU Affero General Public License, section 13, concerning interaction
through a network will apply to the combination as such.

14. Revised Versions of this License.

The Free Software Foundation may publish revised and/or new versions of the GNU General Public License from
time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address
new problems or concerns. Each version is given a distinguishing version number. If the Program specifies that a
certain numbered version of the GNU General Public License "or any later version" applies to it, you have the option
of following the terms and conditions either of that numbered version or of any later version published by the Free
Software Foundation. If the Program does not specify a version number of the GNU General Public License, you may
choose any version ever published by the Free Software Foundation. If the Program specifies that a proxy can decide
which future versions of the GNU General Public License can be used, that proxy's public statement of acceptance of
a version permanently authorizes you to choose that version for the Program. Later license versions may give you
additional or different permissions. However, no additional obligations are imposed on any author or copyright holder
as a result of your choosing to follow a later version.

15. Disclaimer of Warranty.
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THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW.
EXCEPTWHEN OTHERWISE STATED INWRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES
PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND
PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU
ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

16. Limitation of Liability.

IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY
COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MODIFIES AND/OR CONVEYS THE PROGRAM
AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL,
INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE
THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED
INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM
TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

17. Interpretation of Sections 15 and 16.

If the disclaimer of warranty and limitation of liability provided above cannot be given local legal effect according
to their terms, reviewing courts shall apply local law that most closely approximates an absolute waiver of all
civil liability in connection with the Program, unless a warranty or assumption of liability accompanies a copy of
the Program in return for a fee.

END OF TERMS AND CONDITIONS

How to Apply These Terms to Your New Programs

If you develop a new program, and you want it to be of the greatest possible use to the public, the best way to achieve
this is to make it free software which everyone can redistribute and change under these terms. To do so, attach the
following notices to the program. It is safest to attach them to the start of each source file to most effectively state the
exclusion of warranty; and each file should have at least the "copyright" line and a pointer to where the full notice
is found. <one line to give the program's name and a brief idea of what it does.> Copyright (C) <year> <name of
author> This program is free software: you can redistribute it and/or modify it under the terms of the GNU General
Public License as published by the Free Software Foundation, either version 3 of the License, or (at your option)
any later version. This program is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY;
without even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the
GNU General Public License for more details. You should have received a copy of the GNU General Public License
along with this program. If not, see <http://www.gnu.org/licenses/>. Also add information on how to contact you by
electronic and paper mail. If the program does terminal interaction, make it output a short notice like this when it starts
in an interactive mode: <program> Copyright (C) <year> <name of author> This program comes with ABSOLUTELY
NOWARRANTY; for details type `show w'. This is free software, and you are welcome to redistribute it under certain
conditions; type `show c' for details. The hypothetical commands `show w' and `show c' should show the appropriate
parts of the General Public License. Of course, your program's commands might be different; for a GUI interface, you
would use an "about box". You should also get your employer (if you work as a programmer) or school, if any, to sign
a "copyright disclaimer" for the program, if necessary. For more information on this, and how to apply and follow the
GNU GPL, see <http://www.gnu.org/licenses/>. The GNU General Public License does not permit incorporating your
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program into proprietary programs. If your program is a subroutine library, you may consider it more useful to permit
linking proprietary applications with the library. If this is what you want to do, use the GNU Lesser General Public
License instead of this License. But first, please read <http://www.gnu.org/philosophy/why-not-lgpl.html>.

E.7 GNU lesser general public license,
version 2.1
GNU LESSER GENERAL PUBLIC LICENSE

Version 2.1, February 1999

Copyright (C) 1991, 1999 Free Software Foundation, Inc.

51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

[This is the first released version of the Lesser GPL. It also counts as the successor of the GNU Library Public License,
version 2, hence the version number 2.1.]

Preamble

The licenses for most software are designed to take away your freedom to share and change it. By contrast, the
GNU General Public Licenses are intended to guarantee your freedom to share and change free software–to make
sure the software is free for all its users.

This license, the Lesser General Public License, applies to some specially designated software packages–typically
libraries–of the Free Software Foundation and other authors who decide to use it. You can use it too, but we suggest
you first think carefully about whether this license or the ordinary General Public License is the better strategy to use
in any particular case, based on the explanations below.

When we speak of free software, we are referring to freedom of use, not price. Our General Public Licenses are
designed to make sure that you have the freedom to distribute copies of free software (and charge for this service if
you wish); that you receive source code or can get it if you want it; that you can change the software and use pieces of
it in new free programs; and that you are informed that you can do these things.

To protect your rights, we need to make restrictions that forbid distributors to deny you these rights or to ask you to
surrender these rights. These restrictions translate to certain responsibilities for you if you distribute copies of the
library or if you modify it. For example, if you distribute copies of the library, whether gratis or for a fee, you
must give the recipients all the rights that we gave you. You must make sure that they, too, receive or can get the
source code. If you link other code with the library, you must provide complete object files to the recipients, so that
they can relink them with the library after making changes to the library and recompiling it. And you must show
them these terms so they know their rights.

We protect your rights with a two-step method: (1) we copyright the library, and (2) we offer you this license, which
gives you legal permission to copy, distribute and/or modify the library.

To protect each distributor, we want to make it very clear that there is no warranty for the free library. Also, if the
library is modified by someone else and passed on, the recipients should know that what they have is not the original
version, so that the original author's reputation will not be affected by problems that might be introduced by others.
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Finally, software patents pose a constant threat to the existence of any free program. We wish to make sure that a
company cannot effectively restrict the users of a free program by obtaining a restrictive license from a patent
holder. Therefore, we insist that any patent license obtained for a version of the library must be consistent with the
full freedom of use specified in this license.

Most GNU software, including some libraries, is covered by the ordinary GNU General Public License. This license,
the GNU Lesser General Public License, applies to certain designated libraries, and is quite different from the
ordinary General Public License. We use this license for certain libraries in order to permit linking those libraries
into non-free programs.

When a program is linked with a library, whether statically or using a shared library, the combination of the two is
legally speaking a combined work, a derivative of the original library. The ordinary General Public License therefore
permits such linking only if the entire combination fits its criteria of freedom. The Lesser General Public License
permits more lax criteria for linking other code with the library.

We call this license the "Lesser" General Public License because it does Less to protect the user's freedom than the
ordinary General Public License. It also provides other free software developers Less of an advantage over competing
non-free programs. These disadvantages are the reason we use the ordinary General Public License for many libraries.
However, the Lesser license provides advantages in certain special circumstances.

For example, on rare occasions, there may be a special need to encourage the widest possible use of a certain library,
so that it becomes a de-facto standard. To achieve this, non-free programs must be allowed to use the library. A more
frequent case is that a free library does the same job as widely used non-free libraries. In this case, there is little to gain
by limiting the free library to free software only, so we use the Lesser General Public License.

In other cases, permission to use a particular library in non-free programs enables a greater number of people to use a
large body of free software. For example, permission to use the GNU C Library in non-free programs enables many
more people to use the whole GNU operating system, as well as its variant, the GNU/Linux operating system.

Although the Lesser General Public License is Less protective of the users' freedom, it does ensure that the user of a
program that is linked with the Library has the freedom and the wherewithal to run that program using a modified
version of the Library.

The precise terms and conditions for copying, distribution and modification follow. Pay close attention to the
difference between a "work based on the library" and a "work that uses the library". The former contains code derived
from the library, whereas the latter must be combined with the library in order to run.

GNU LESSER GENERAL PUBLIC LICENSE TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION
AND MODIFICATION

0. This License Agreement applies to any software library or other program which contains a notice placed by the
copyright holder or other authorized party saying it may be distributed under the terms of this Lesser General Public
License (also called "this License"). Each licensee is addressed as "you".

A "library" means a collection of software functions and/or data prepared so as to be conveniently linked with
application programs (which use some of those functions and data) to form executables.

The "Library", below, refers to any such software library or work which has been distributed under these terms. A
"work based on the Library" means either the Library or any derivative work under copyright law: that is to say, a
work containing the Library or a portion of it, either verbatim or with modifications and/or translated straightforwardly
into another language. (Hereinafter, translation is included without limitation in the term "modification".) "Source
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code" for a work means the preferred form of the work for making modifications to it. For a library, complete source
code means all the source code for all modules it contains, plus any associated interface definition files, plus the scripts
used to control compilation and installation of the library.

Activities other than copying, distribution and modification are not covered by this License; they are outside its scope.
The act of running a program using the Library is not restricted, and output from such a program is covered only if its
contents constitute a work based on the Library (independent of the use of the Library in a tool for writing it). Whether
that is true depends on what the Library does and what the program that uses the Library does.

1. You may copy and distribute verbatim copies of the Library's complete source code as you receive it, in any
medium, provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice and
disclaimer of warranty; keep intact all the notices that refer to this License and to the absence of any warranty; and
distribute a copy of this License along with the Library.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty protection
in exchange for a fee.

2. You may modify your copy or copies of the Library or any portion of it, thus forming a work based on the
Library, and copy and distribute such modifications or work under the terms of Section 1 above, provided that you
also meet all of these conditions:

The modified work must itself be a software library.

You must cause the files modified to carry prominent notices stating that you changed the files and the date of any
change.

You must cause the whole of the work to be licensed at no charge to all third parties under the terms of this License.

If a facility in the modified Library refers to a function or a table of data to be supplied by an application program
that uses the facility, other than as an argument passed when the facility is invoked, then you must make a good faith
effort to ensure that, in the event an application does not supply such function or table, the facility still operates, and
performs whatever part of its purpose remains meaningful. (For example, a function in a library to compute square
roots has a purpose that is entirely well-defined independent of the application. Therefore, Subsection 2d requires that
any application-supplied function or table used by this function must be optional: if the application does not supply it,
the square root function must still compute square roots.)

These requirements apply to the modified work as a whole. If identifiable sections of that work are not derived from
the Library, and can be reasonably considered independent and separate works in themselves, then this License, and
its terms, do not apply to those sections when you distribute them as separate works. But when you distribute the
same sections as part of a whole which is a work based on the Library, the distribution of the whole must be on the
terms of this License, whose permissions for other licensees extend to the entire whole, and thus to each and every
part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you; rather, the
intent is to exercise the right to control the distribution of derivative or collective works based on the Library.

In addition, mere aggregation of another work not based on the Library with the Library (or with a work based on the
Library) on a volume of a storage or distribution medium does not bring the other work under the scope of this License.

3. You may opt to apply the terms of the ordinary GNU General Public License instead of this License to a given
copy of the Library. To do this, you must alter all the notices that refer to this License, so that they refer to the
ordinary GNU General Public License, version 2, instead of to this License. (If a newer version than version 2 of
the ordinary GNU General Public License has appeared, then you can specify that version instead if you wish.) Do
not make any other change in these notices.
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Once this change is made in a given copy, it is irreversible for that copy, so the ordinary GNU General Public License
applies to all subsequent copies and derivative works made from that copy.

This option is useful when you wish to copy part of the code of the Library into a program that is not a library.

4. You may copy and distribute the Library (or a portion or derivative of it, under Section 2) in object code or
executable form under the terms of Sections 1 and 2 above provided that you accompany it with the complete
corresponding machine-readable source code, which must be distributed under the terms of Sections 1 and 2 above on
a medium customarily used for software interchange.

If distribution of object code is made by offering access to copy from a designated place, then offering equivalent
access to copy the source code from the same place satisfies the requirement to distribute the source code, even though
third parties are not compelled to copy the source along with the object code.

5. A program that contains no derivative of any portion of the Library, but is designed to work with the Library by
being compiled or linked with it, is called a "work that uses the Library". Such a work, in isolation, is not a derivative
work of the Library, and therefore falls outside the scope of this License.

However, linking a "work that uses the Library" with the Library creates an executable that is a derivative of the
Library (because it contains portions of the Library), rather than a "work that uses the library". The executable is
therefore covered by this License. Section 6 states terms for distribution of such executables.

When a "work that uses the Library" uses material from a header file that is part of the Library, the object code for the
work may be a derivative work of the Library even though the source code is not. Whether this is true is especially
significant if the work can be linked without the Library, or if the work is itself a library. The threshold for this
to be true is not precisely defined by law.

If such an object file uses only numerical parameters, data structure layouts and accessors, and small macros and small
inline functions (ten lines or less in length), then the use of the object file is unrestricted, regardless of whether it
is legally a derivative work. (Executables containing this object code plus portions of the Library will still fall
under Section 6.)

Otherwise, if the work is a derivative of the Library, you may distribute the object code for the work under the
terms of Section 6. Any executables containing that work also fall under Section 6, whether or not they are linked
directly with the Library itself.

6. As an exception to the Sections above, you may also combine or link a "work that uses the Library" with the
Library to produce a work containing portions of the Library, and distribute that work under terms of your choice,
provided that the terms permit modification of the work for the customer's own use and reverse engineering for
debugging such modifications.

You must give prominent notice with each copy of the work that the Library is used in it and that the Library and
its use are covered by this License. You must supply a copy of this License. If the work during execution displays
copyright notices, you must include the copyright notice for the Library among them, as well as a reference directing
the user to the copy of this License. Also, you must do one of these things:

Accompany the work with the complete corresponding machine-readable source code for the Library including
whatever changes were used in the work (which must be distributed under Sections 1 and 2 above); and, if the work is
an executable linked with the Library, with the complete machine-readable "work that uses the Library", as object
code and/or source code, so that the user can modify the Library and then relink to produce a modified executable
containing the modified Library. (It is understood that the user who changes the contents of definitions files in the
Library will not necessarily be able to recompile the application to use the modified definitions.)
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Use a suitable shared library mechanism for linking with the Library. A suitable mechanism is one that (1) uses at run
time a copy of the library already present on the user's computer system, rather than copying library functions into the
executable, and (2) will operate properly with a modified version of the library, if the user installs one, as long as the
modified version is interface-compatible with the version that the work was made with.

Accompany the work with a written offer, valid for at least three years, to give the same user the materials specified in
Subsection 6a, above, for a charge no more than the cost of performing this distribution.

If distribution of the work is made by offering access to copy from a designated place, offer equivalent access to
copy the above specified materials from the same place.

Verify that the user has already received a copy of these materials or that you have already sent this user a copy.

For an executable, the required form of the "work that uses the Library" must include any data and utility programs
needed for reproducing the executable from it. However, as a special exception, the materials to be distributed need not
include anything that is normally distributed (in either source or binary form) with the major components (compiler,
kernel, and so on) of the operating system on which the executable runs, unless that component itself accompanies the
executable. It may happen that this requirement contradicts the license restrictions of other proprietary libraries that
do not normally accompany the operating system. Such a contradiction means you cannot use both them and the
Library together in an executable that you distribute.

7. You may place library facilities that are a work based on the Library side-by-side in a single library together
with other library facilities not covered by this License, and distribute such a combined library, provided that the
separate distribution of the work based on the Library and of the other library facilities is otherwise permitted,
and provided that you do these two things:

a) Accompany the combined library with a copy of the same work based on the Library, uncombined with any other
library facilities. This must be distributed under the terms of the Sections above.

b) Give prominent notice with the combined library of the fact that part of it is a work based on the Library, and
explaining where to find the accompanying uncombined form of the same work.

8. You may not copy, modify, sublicense, link with, or distribute the Library except as expressly provided under this
License. Any attempt otherwise to copy, modify, sublicense, link with, or distribute the Library is void, and will
automatically terminate your rights under this License. However, parties who have received copies, or rights, from
you under this License will not have their licenses terminated so long as such parties remain in full compliance.

9. You are not required to accept this License, since you have not signed it. However, nothing else grants you
permission to modify or distribute the Library or its derivative works. These actions are prohibited by law if you
do not accept this License. Therefore, by modifying or distributing the Library (or any work based on the Library),
you indicate your acceptance of this License to do so, and all its terms and conditions for copying, distributing or
modifying the Library or works based on it.

10. Each time you redistribute the Library (or any work based on the Library), the recipient automatically receives a
license from the original licensor to copy, distribute, link with or modify the Library subject to these terms and
conditions. You may not impose any further restrictions on the recipients' exercise of the rights granted herein. You
are not responsible for enforcing compliance by third parties with this License.

11. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not limited to
patent issues), conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the
conditions of this License, they do not excuse you from the conditions of this License. If you cannot distribute so as to
satisfy simultaneously your obligations under this License and any other pertinent obligations, then as a consequence
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you may not distribute the Library at all. For example, if a patent license would not permit royalty-free redistribution
of the Library by all those who receive copies directly or indirectly through you, then the only way you could satisfy
both it and this License would be to refrain entirely from distribution of the Library.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance of the
section is intended to apply, and the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right claims or to contest
validity of any such claims; this section has the sole purpose of protecting the integrity of the free software distribution
system which is implemented by public license practices. Many people have made generous contributions to the
wide range of software distributed through that system in reliance on consistent application of that system; it is up
to the author/donor to decide if he or she is willing to distribute software through any other system and a licensee
cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this License.

12. If the distribution and/or use of the Library is restricted in certain countries either by patents or by copyrighted
interfaces, the original copyright holder who places the Library under this License may add an explicit geographical
distribution limitation excluding those countries, so that distribution is permitted only in or among countries not thus
excluded. In such case, this License incorporates the limitation as if written in the body of this License.

13. The Free Software Foundation may publish revised and/or new versions of the Lesser General Public License
from time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to
address new problems or concerns.

Each version is given a distinguishing version number. If the Library specifies a version number of this License which
applies to it and "any later version", you have the option of following the terms and conditions either of that version
or of any later version published by the Free Software Foundation. If the Library does not specify a license version
number, you may choose any version ever published by the Free Software Foundation.

14. If you wish to incorporate parts of the Library into other free programs whose distribution conditions are
incompatible with these, write to the author to ask for permission. For software which is copyrighted by the Free
Software Foundation, write to the Free Software Foundation; we sometimes make exceptions for this. Our decision
will be guided by the two goals of preserving the free status of all derivatives of our free software and of promoting
the sharing and reuse of software generally.

NO WARRANTY

15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE
LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW.

EXCEPTWHEN OTHERWISE STATED INWRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES
PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND
PERFORMANCE OF THE LIBRARY IS WITH YOU. SHOULD THE LIBRARY PROVE DEFECTIVE, YOU
ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY
COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE
LIBRARY AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL,
SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO
USE THE LIBRARY (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED
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INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE LIBRARY
TO OPERATE WITH ANY OTHER SOFTWARE), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS

How to Apply These Terms to Your New Libraries

If you develop a new library, and you want it to be of the greatest possible use to the public, we recommend making it
free software that everyone can redistribute and change. You can do so by permitting redistribution under these terms
(or, alternatively, under the terms of the ordinary General Public License).

To apply these terms, attach the following notices to the library. It is safest to attach them to the start of each source
file to most effectively convey the exclusion of warranty; and each file should have at least the "copyright" line and a
pointer to where the full notice is found.

<one line to give the program's name and an idea of what it does>

Copyright ©<year> <name of author>

This library is free software; you can redistribute it and/or modify it under the terms of the GNU Lesser General
Public License as published by the Free Software Foundation; either version 2.1 of the License, or (at your option)
any later version.

This library is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even the
implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU Lesser
General Public License for more details.

You should have received a copy of the GNU Lesser General Public License along with this library; if not, write to the
Free Software Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA.

Also add information on how to contact you by electronic and paper mail. You should also get your employer (if
you work as a programmer) or your school, if any, to sign a "copyright disclaimer" for the library, if necessary.
Here is a sample; alter the names:

Yoyodyne, Inc., hereby disclaims all copyright interest in the library. `Frob' (a library for tweaking knobs) written by
James Random Hacker..

<signature orf TyCoon> 1 April 1990 Ty Coon, President of Vice

That's all there is to it!

E.8 GNU lesser general public license,
version 3
GNU LESSER GENERAL PUBLIC LICENSE

Version 3, 29 June 2007

Copyright (C) 2007 Free Software Foundation, Inc. <http://fsf.org/>

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

This version of the GNU Lesser General Public License incorporates the terms and conditions of version 3 of the GNU
General Public License, supplemented by the additional permissions listed below.
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0. Additional Definitions.

As used herein, "this License" refers to version 3 of the GNU Lesser General Public License, and the "GNU GPL"
refers to version 3 of the GNU General Public License. "The Library" refers to a covered work governed by this
License, other than an Application or a Combined Work as defined below. An "Application" is any work that makes
use of an interface provided by the Library, but which is not otherwise based on the Library. Defining a subclass of a
class defined by the Library is deemed a mode of using an interface provided by the Library. A "Combined Work"
is a work produced by combining or linking an Application with the Library. The particular version of the Library
with which the Combined Work was made is also called the "Linked Version". The "Minimal Corresponding Source"
for a Combined Work means the Corresponding Source for the Combined Work, excluding any source code for
portions of the Combined Work that, considered in isolation, are based on the Application, and not on the Linked
Version. The "Corresponding Application Code" for a Combined Work means the object code and/or source code
for the Application, including any data and utility programs needed for reproducing the Combined Work from the
Application, but excluding the System Libraries of the Combined Work.

1. Exception to Section 3 of the GNU GPL. You may convey a covered work under sections 3 and 4 of this License
without being bound by section 3 of the GNU GPL.

2. Conveying Modified Versions.

If you modify a copy of the Library, and, in your modifications, a facility refers to a function or data to be supplied by
an Application that uses the facility (other than as an argument passed when the facility is invoked), then you may
convey a copy of the modified version: a) under this License, provided that you make a good faith effort to ensure that,
in the event an Application does not supply the function or data, the facility still operates, and performs whatever
part of its purpose remains meaningful, or b) under the GNU GPL, with none of the additional permissions of this
License applicable to that copy.

3. Object Code Incorporating Material from Library Header Files.

The object code form of an Application may incorporate material from a header file that is part of the Library. You
may convey such object code under terms of your choice, provided that, if the incorporated material is not limited to
numerical parameters, data structure layouts and accessors, or small macros, inline functions and templates (ten or
fewer lines in length), you do both of the following: a) Give prominent notice with each copy of the object code that
the Library is used in it and that the Library and its use are covered by this License. b) Accompany the object code
with a copy of the GNU GPL and this license document.

4. Combined Works.

You may convey a Combined Work under terms of your choice that, taken together, effectively do not restrict
modification of the portions of the Library contained in the Combined Work and reverse engineering for debugging
such modifications, if you also do each of the following: a) Give prominent notice with each copy of the Combined
Work that the Library is used in it and that the Library and its use are covered by this License. b) Accompany the
Combined Work with a copy of the GNU GPL and this license document. c) For a Combined Work that displays
copyright notices during execution, include the copyright notice for the Library among these notices, as well as a
reference directing the user to the copies of the GNU GPL and this license document. d) Do one of the following: 0)
Convey the Minimal Corresponding Source under the terms of this License, and the Corresponding Application Code
in a form suitable for, and under terms that permit, the user to recombine or relink the Application with a modified
version of the Linked Version to produce a modified Combined Work, in the manner specified by section 6 of the
GNU GPL for conveying Corresponding Source. 1) Use a suitable shared library mechanism for linking with the
Library. A suitable mechanism is one that (a) uses at run time a copy of the Library already present on the user's
computer system, and (b) will operate properly with a modified version of the Library that is interface-compatible
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with the Linked Version. e) Provide Installation Information, but only if you would otherwise be required to provide
such information under section 6 of the GNU GPL, and only to the extent that such information is necessary to install
and execute a modified version of the Combined Work produced by recombining or relinking the Application with a
modified version of the Linked Version. (If you use option 4d0, the Installation Information must accompany the
Minimal Corresponding Source and Corresponding Application Code. If you use option 4d1, you must provide the
Installation Information in the manner specified by section 6 of the GNU GPL for conveying Corresponding Source.)

5. Combined Libraries.

You may place library facilities that are a work based on the Library side by side in a single library together with
other library facilities that are not Applications and are not covered by this License, and convey such a combined
library under terms of your choice, if you do both of the following: a) Accompany the combined library with a copy
of the same work based on the Library, uncombined with any other library facilities, conveyed under the terms of
this License. b) Give prominent notice with the combined library that part of it is a work based on the Library, and
explaining where to find the accompanying uncombined form of the same work.

6. Revised Versions of the GNU Lesser General Public License.

The Free Software Foundation may publish revised and/or new versions of the GNU Lesser General Public License
from time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address
new problems or concerns. Each version is given a distinguishing version number. If the Library as you received it
specifies that a certain numbered version of the GNU Lesser General Public License "or any later version" applies to
it, you have the option of following the terms and conditions either of that published version or of any later version
published by the Free Software Foundation. If the Library as you received it does not specify a version number of the
GNU Lesser General Public License, you may choose any version of the GNU Lesser General Public License ever
published by the Free Software Foundation. If the Library as you received it specifies that a proxy can decide whether
future versions of the GNU Lesser General Public License shall apply, that proxy's public statement of acceptance of
any version is permanent authorization for you to choose that version for the Library.

E.9 PHP license
The PHP License, version 3.01

Copyright (c) 1999 - 2010 The PHP Group.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, is permitted provided that the
following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.

Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials provided with the distribution.

The name "PHP" must not be used to endorse or promote products derived from this software without prior written
permission. For written permission, please contact group@php.ne.
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Products derived from this software may not be called "PHP", nor may "PHP" appear in their name, without prior
written permission from group@php.net. You may indicate that your software works in conjunction with PHP by
saying "Foo for PHP" instead of calling it "PHP Foo" or "phpfoo".

The PHP Group may publish revised and/or new versions of the license from time to time. Each version will be given
a distinguishing version number. Once covered code has been published under a particular version of the license, you
may always continue to use it under the terms of that version. You may also choose to use such covered code under the
terms of any subsequent version of the license published by the PHP Group. No one other than the PHP Group has the
right to modify the terms applicable to covered code created under this License.

Redistributions of any form whatsoever must retain the following acknowledgment: "This product includes PHP
software, freely available from <http://www.php.net/software/>".

THIS SOFTWARE IS PROVIDED BY THE PHP DEVELOPMENT TEAM ``AS IS'' AND ANY EXPRESSED
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE PHP DEVELOPMENT TEAM OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE.

This software consists of voluntary contributions made by many individuals on behalf of the PHP Group.

The PHP Group can be contacted via Email at group@php.net.

For more information on the PHP Group and the PHP project, please see <http://www.php.net>.

PHP includes the Zend Engine, freely available at <http://www.zend.com>.
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